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i.1 About this Manual
This manual provides detailed operating procedures for the SigmaWin+ Application Editor engineering tool for
AC servo drives.
Read and understand this manual to ensure correct usage of the SigmaWin+ Application Editor.
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i.2 Target Readers
This manual is intended for the following readers who are assumed to possess knowledge about the fundamentals
of servo drives and electric/electronic circuits.
• Readers who wish to deepen their knowledge of SERVOPACK products
• Personnel in charge of selecting products for equipment
• Designers of applications for SERVOPACKs and servomotors in various types of equipment
• Personnel who maintain equipment
• Designers of FA systems
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i.3 Outline of Manual
The contents of the chapters of this manual are described in the following table. Refer to these chapters as
required.

Cha-
pter Title Contents

1 Basic Information on the SigmaWin+ AE Describes an outline of the SigmaWin+ AE, the tasks that must be performed
to use the SigmaWin+ AE, and the window configuration.

2 Project Management Describes basic operations and management methods for project files.

3 Designing the System Describes the operations required to design the system in the SigmaWin+
AE.

4 Programming Provides an overview of programming and describes basic operations related
to programming.

5 Debugging Describes the functions for debugging ladder programs.

6 Monitor Describes the methods to monitor the status of the connected SERVOPACK
and the status of registers.

7 Security Describes the security functions available in the SigmaWin+ Application
Editor for users, SERVOPACK, projects, and programs.

8 Convenient Functions Describes convenient functions in the SigmaWin+ Application Editor, such
as the environment settings, printing, and importing and exporting data.

9 Appendices Describes error messages and the corrective action to perform when an error
is displayed.
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i.4 Related Documents
The relationships between the documents that are related to the Servo Drives are shown in the following figure.
The numbers in the figure correspond to the numbers in the table on the following pages. Refer to these docu-
ments as required.
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i.4.1 Related Documents

(1) Machine Controllers Catalogs
You can check for products related to YASKAWA machine controllers. Refer to these documents as required.

(2) Servo Drives Catalogs
Document Name Document No. Description

AC Servo Drive Σ-X Series KAEP C710812 03 Provides detailed information on Σ-X-series AC servo
drives, including features and specifications.

AC Servo Drive Large-Capacity Σ-X Series KAEP C710812 35
Provides detailed information on large-capacity Σ-X-ser-
ies AC servo drives, including features and
specifications.

(3) Machine Controllers Manuals
The machine controller to use depends on the SERVOPACK that is used. Refer to the manual for the machine
controller as required.

(4) Enclosed Documents
Document Name Document No. Description

Σ-X-Series AC Servo Drive
Σ-XS/Σ-XW SERVOPACK
Safety Precautions

TOMP C710812 00

Provides detailed information for the safe usage of Σ-X-
series SERVOPACKs.Σ-X-Series AC Servo Drive

Σ-XT SERVOPACK
Safety Precautions

TOMP C710812 16

Σ-X-Series AC Servo Drive
Large-Capacity Σ-XS SERVOPACK
Safety Precautions

TOMP C710812 35 Provides detailed information for the safe usage of Σ-X-
series large-capacity Σ-XS SERVOPACKs.

Σ-X-Series AC Servo Drive
Advanced Safety Module
Safety Precautions

TOMP C710812 25 Provides detailed information for the safe usage of the
advanced safety module.

Σ-X-Series AC Servo Drive
Advanced Safety Module
Installation Guide

TOMP C710812 26 Provides detailed procedures for installing the advanced
safety module in a SERVOPACK.

Σ-X-Series AC Servo Drive
Σ-LINK II Sensor Hub
INSTRUCTIONS

TOMP C710812 06
Provides detailed information for the safe usage of the Σ-
LINK II sensor hub, as well as specifications, installa-
tion, and connection information.

Σ-X-Series AC Servo Drive
Σ-LINK II Booster Unit
Instructions

TOMP C710812 08
Provides detailed information for the safe usage of the Σ-
LINK II booster unit, as well as specifications, installa-
tion, and connection information.

Σ-V-Series/Σ-V-Series for Large-Capacity
Models/Σ-7-Series/Σ-X-Series
Installation Guide
Fully-closed Module

TOBP C720829 03 Provides detailed procedures for installing the fully-
closed module in a SERVOPACK.

Continued on next page.
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Continued from previous page.

Document Name Document No. Description

AC Servo Drive
Rotary Servomotor
Safety Precautions

TOBP C230260 00 Provides detailed information for the safe usage of rotary
servomotors and direct drive servomotors.

Σ-X-Series
Rotary Feedback Unit
Safety Precautions

TOBP C770100 00 Provides detailed information for the safe usage of the
rotary feedback unit.

(5) SERVOPACK Product Manuals
Document Name Document No. Description

Σ-X-Series AC Servo Drive
Σ-XS SERVOPACK
with MECHATROLINK-4/III Communica-
tions References
Product Manual

SIEP C710812 01

Provide detailed information on selecting Σ-X-series Σ-
XS or Σ-XW SERVOPACKs; installing, connecting, set-
ting, testing in trial operation, tuning, monitoring, and
maintaining servo drives; and other information.

Σ-X-Series AC Servo Drive
Σ-XS SERVOPACK
with EtherCAT Communications References
Product Manual

SIEP C710812 02

Σ-X-Series AC Servo Drive
Σ-XS SERVOPACK
Analog Voltage/Pulse Train References
Product Manual

SIEP C710812 03

Σ-X-Series AC Servo Drive
Σ-XW SERVOPACK
with MECHATROLINK-4/III Communica-
tions References
Product Manual

SIEP C710812 04

Σ-X-Series AC Servo Drive
Σ-XW SERVOPACK
with EtherCAT Communications References
Product Manual

SIEP C710812 05

Σ-X-Series AC Servo Drive
Σ-XT SERVOPACK
with MECHATROLINK-4/III Communica-
tions References
Product Manual

SIEP C710812 16
Provide detailed information on selecting Σ-X-series Σ-
XT SERVOPACKs; installing, connecting, setting, test-
ing in trial operation, tuning, monitoring, and maintain-
ing servo drives; and other information.Σ-X-Series AC Servo Drive

Σ-XT SERVOPACK
with EtherCAT Communications References
Product Manual

SIEP C710812 17

Continued on next page.
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Continued from previous page.

Document Name Document No. Description

Σ-X-Series AC Servo Drive
Large-Capacity Σ-XS SERVOPACK
with MECHATROLINK-4/III Communica-
tions References
Product Manual

SIEP C710812 35

Provide detailed information on selecting Σ-X-series
large-capacity Σ-XS SERVOPACKs; installing, connect-
ing, setting, testing in trial operation, tuning, monitoring,
and maintaining servo drives; and other information.

Σ-X-Series AC Servo Drive
Large-Capacity Σ-XS SERVOPACK
with EtherCAT Communications References
Product Manual

SIEP C710812 36

Σ-X-Series AC Servo Drive
Large-Capacity Σ-XS SERVOPACK
with Analog Voltage/Pulse Train References
Product Manual

SIEP C710812 37

Σ-X-Series AC Servo Drive
Advanced Safety Module
with Safety over EtherCAT (FSoE) Commu-
nications References
Product Manual

SIEP C710812 25
Provide detailed information on selecting the advanced
safety module; installing, connecting, setting, testing in
trial operation, tuning, monitoring, and maintaining servo
drives; and other information.Σ-X-Series AC Servo Drive

Advanced Safety Module
Digital I/O
Product Manual

SIEP C710812 26

Σ-X-Series AC Servo Drive
Σ-XW/Σ-XT SERVOPACK
Hardware Option Specifications
HWBB Function
Product Manual

SIEP C710812 13

Provides information on servo drives equipped with the
HWBB safety function (SGDXW-□□□□40□1000,
SGDXW-□□□□A0□1000, SGDXT-□□□□40□1000, and
SGDXT-□□□□A0□1000)). The differences in specifica-
tions from SERVOPACKs not equipped with the HWBB
are given in this manual.

Σ-X-Series AC Servo Drive
Σ-XS/Σ-XW/Σ-XT SERVOPACK
Hardware Option Specifications
Dynamic Brake
Product Manual

SIEP C710812 14

Provides information on Σ-X-series AC servo drives
(SGDX□-□□□□□□□0020) with the dynamic brake
option. The differences in specifications from SERVO-
PACKs without the dynamic brake option are given in
this manual.

Σ-X-Series AC Servo Drive
Σ-XS/Σ-XW SERVOPACK
with MECHATROLINK-4/III Communica-
tions References
FT Specification
for Gantry Applications
Product Manual

SIEP C710812 19

Provide information on the gantry application function
and torque/force assistance in the Σ-X-series Σ-XS/Σ-
XW SERVOPACK.Σ-X-Series AC Servo Drive

Σ-XS/Σ-XW SERVOPACK
with EtherCAT Communications References
FT Specification
for Gantry Applications
Product Manual

SIEP C710812 20

Continued on next page.
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Continued from previous page.

Document Name Document No. Description

Σ-X-Series AC Servo Drive
Σ-XS SERVOPACK
with MECHATROLINK-4/III Communica-
tions References
FT Specification
for Press and Injection Molding Application
Product Manual

SIEP C710812 22

Provide information on the press and injection molding
function in the Σ-X-series Σ-XS SERVOPACK.

Σ-X-Series AC Servo Drive
Σ-XS SERVOPACK
with EtherCAT Communications References
FT Specification
for Press and Injection Molding Application
Product Manual

SIEP C710812 23

Σ-X-Series AC Servo Drive
Σ-XS SERVOPACK
with FT Specification
Customized Sensing Data Function Option
Product Manual

SIEP C710812 18 Provides information on the customized sensing data
function in the Σ-X-series Σ-XS SERVOPACK.

Σ-X-Series AC Servo Drive
Σ-XS SERVOPACK
with FT Specification
Customized Sensing Data Function Option
(with Custom Motion Function)
Product Manual

SIEP C710812 21
Provides information on the customized sensing data
function (with custom motion function) in the Σ-X-series
Σ-XS SERVOPACK.

Σ-X-Series AC Servo Drive
Σ-XS SERVOPACK
with FT Specification
Customized Sensing Data Function Option
(with Standalone Custom Motion Function)
Product Manual

SIEP C710812 32
Provides information on the customized sensing data
function (with standalone custom motion function) in the
Σ-X-series Σ-XS SERVOPACK.

Σ-X-Series AC Servo Drive
Σ-XS SERVOPACK
with FT/EX Specification
for Indexing Application
Product Manual

SIEP C710812 34 Provides information on the indexing application func-
tion in the Σ-X-series Σ-XS SERVOPACK.

Σ-X-Series AC Servo Drive
Σ-XS SERVOPACK
with MECHATROLINK-4/III Communica-
tions References
FT Specification
for Semi-/Fully-Closed Loop Control Online
Switching Function Option
Product Manual

SIEP C710812 31
Provides information on the semi-/fully-closed loop con-
trol online switching function in the Σ‑X-series Σ‑XS
SERVOPACK.

(6) Servomotor Product Manuals
Document Name Document No. Description

Σ-X-Series AC Servo Drive
Rotary Servomotor Product Manual

SIEP C230210 00 Provides detailed information on selecting, installing,
and connecting the Σ-X-series servomotors.

Σ-X-Series AC Servo Drive
Large-Capacity Rotary Servomotor Product
Manual

SIEP C230301 00
Provides detailed information on selecting, installing,
and connecting the Σ-X-series large-capacity
servomotors.
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(7) Peripheral Device Selection Manual
Document Name Document No. Description

Σ-X-Series AC Servo Drive
Peripheral Device
Selection Manual

SIEP C710812 12

Provides the following information in detail for Σ-X-ser-
ies servo systems.
• Cables: Models, dimensions, wiring materials, con-
nector models, and connection specifications

• Peripheral devices: Models, specifications, diagrams,
and selection (calculation) methods

(8) MECHATROLINK Communications Command Manuals
Document Name Document No. Description

Σ-7/Σ-X-Series AC Servo Drive
MECHATROLINK-III Communications
Standard Servo Profile
Command Manual

SIEP S800001 31
Provides detailed information on the MECHATRO-
LINK-III communications standard servo profile com-
mands that are used for a Σ-7/Σ-X-series servo system.

Σ-7/Σ-X-Series AC Servo Drive
MECHATROLINK-4 Communications
Standard Servo Profile
Command Manual

SIEP S800002 32
Provides detailed information on the MECHATRO-
LINK-4 communications standard servo profile com-
mands that are used for a Σ-7/Σ-X-series servo system.

(9) Operation Interface Operating Manuals
Document Name Document No. Description

System Integrated Engineering Tool MPE720
Ver.7
User’s Manual

SIEP C880761 03 Describes in detail how to operate MPE720 version 7.

Σ-7/Σ-X-Series AC Servo Drive
Digital Operator
Operating Manual

SIEP S800001 33 Describes the operating procedures for a digital operator
for a Σ-7/Σ-X-series servo system.

AC Servo Drive
Engineering Tool
SigmaWin+
Operation Manual

SIET S800001 34 Provides detailed operating procedures for the SigmaWin
+ engineering tool for a Σ-7/Σ-X series servo system.

AC Servo Drive
Engineering Tool
SigmaWin+ Application Editor
Operation Manual

SIEP C710812 33 Describes in detail how to operate SigmaWin+ Applica-
tion Editor.
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i.5 Using this Manual

i.5.1 Basic Terms Used in this Manual
The following basic terms are used in this manual.

Basic Terms Meaning

SigmaWin+ AE The SigmaWin+ Application Editor add-on engineering tool or a personal computer running the engi-
neering tool.

SigmaWin+ Ver.7 The engineering tool for setting up and tuning servo drives or a computer in which the engineering
tool is installed.

SERVOPACK A Σ-X-series Σ-XS servo amplifier with standalone custom motion references.

controller A general term for a YRM controller, MPX controller, or machine controller

engineering Setting up, adjusting, and programming devices to create a system and maintaining and managing
that system

i.5.2 Screenshots Used in This Manual
A portion of the screenshots used in this manual may vary from the windows in the actual software because the
screenshots show previous versions of the software or versions of the software currently in development.

i.5.3 Trademarks
• Ethernet is a registered trademark of the Xerox Corporation.
• Microsoft, Windows, Windows NT, and Internet Explorer are trademarks and/or registered trademarks of
Microsoft Corporation in the United States.

• Adobe Reader is a trademark or registered trademark of Adobe Systems Incorporated.
• Other product names and company names are the trademarks or registered trademarks of their respective com-
panies. “TM” and the ® mark do not appear with product or company names in this manual.

• This product includes file archive software UNLHA(32).dll. The copyright of UNLHA(32).dll is owned by
Micco.

i.5.4 Visual Aids
The following aids are used to indicate certain types of information for easier reference.

Important

Indicates precautions or restrictions that must be observed.
Also indicates alarm displays and other precautions that will not result in machine damage.

Term

Indicates definitions of difficult terms or terms that have not been previously explained in this manual.

Information Indicates supplemental information to deepen understanding or useful information.
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i.6 Operating Precautions
• It is strictly prohibited to copy or use SigmaWin+ AE for any purpose other than to design and maintain appli-
cations for SERVOPACK.

• It is strictly prohibited to decompile, disassemble, or reverse engineer SigmaWin+ AE.
• You may not give, exchange, lend, or otherwise provide the SigmaWin+ AE , in part or whole, to any third
party without the prior permission of the Yaskawa Electric Corporation.
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i.7 Safety Precautions

i.7.1 Safety Information
To prevent personal injury and equipment damage in advance, the following signal words are used to indicate
safety precautions in this document. The signal words are used to classify the hazards and the degree of damage
or injury that may occur if a product is used incorrectly. Information marked as shown below is important for
safety. Always read this information and heed the precautions that are provided.

DANGER
This signal word identifies a hazard that will cause serious injury or death if you do not pre-
vent it.

WARNING
This signal word identifies a hazard that can cause death or serious injuries if you do not
prevent it.

CAUTION
This signal word identifies a hazard that can cause moderate injuries if you do not prevent
it.

NOTICE
This signal word identifies a property damage message that is not related to personal injury.

i.7.2 Safety Precautions That Must Always Be Observed

(1) General Precautions

DANGER
Make sure to observe all information related to safety contained in this manual.
If you fail to observe these warnings, there is a risk of equipment damage or product failure. There is also a
risk of injury, fire, or electric shock that causes death or serious injury.
Yaskawa bears no responsibility to you or your customers for injuries and equipment damage that occur
from failing to observe the warnings and precautions listed in this manual.

Keep this manual in a safe, convenient place so that it can be referred to whenever neces-
sary. Make sure that it is delivered to the final user of the product.

Install and remove covers, cables, connectors, and optional devices when the power is
turned OFF.
There is a risk of equipment damage or product failure. There is also a risk of fire or electric shock that
causes death or serious injury. Additionally, there is a risk of death or serious injury due to unexpected
machine operation.
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WARNING
Use a power supply with specifications (number of phases, voltage, frequency, and AC/DC
type) that are appropriate for the product. Always check the power supply specifications in
the product manual for your SERVOPACK.
If you do not use the product with the correct power supply specifications, there is a risk of thermal damage,
fire, or electric shock because of product overheating due to the application of high voltage or leakage cur-
rent, and these may cause death or serious injury.

Make sure to connect the ground terminals on the SERVOPACK and servomotor to ground
poles in the state shown below.
• SERVOPACK with 200-VAC power supply input: 100 Ωmax.
• SERVOPACK with 400-VAC power supply input: 10 Ωmax.

There is a risk of product failure. A fire or electric shock may also occur resulting in death or serious injury.

A SERVOPACK with 400-VAC power supply input can be used only in a power system with
grounded neutral. Make sure to connect the SERVOPACK to a power supply with grounded
neutral.
If the SERVOPACK is connected to a power supply without a grounded neutral, there is a risk of electric
shock and product failure. A fire or electric shock may also occur resulting in death or serious injury.

Do not modify or alter the product in any manner that is not described in this manual.
If you modify or alter the product, there is a risk of fire or electric shock that causes death or serious injury.
Repairs for product damage caused by modifying or altering the product in a manner not described in this
manual are outside the scope of the Yaskawa warranty. Yaskawa bears no responsibility for product altera-
tions performed by you or your customers.

For a 24-VDC power supply, use a power supply device with double insulation or reinforced
insulation.
There is a risk of injury, fire, or electric shock that causes death or serious injury when a short circuit or
ground fault occurs due to insulation deterioration in the device.

Do not damage, pull on, apply excessive force to, place heavy objects on, or pinch cables.
There is a risk of fire or electric shock due to cable failure or damage that causes death or serious injury.

The person who designs the system that uses the safety function must have a complete
knowledge of the related safety standards and a complete understanding of the instructions
in the product manual for your SERVOPACK.
If the safety design of the system is insufficient, there is a risk of equipment damage. There is also a risk of
death or serious injury due to unexpected machine operation.

Do not place the product in locations where it is subject to water, corrosive gases, flamma-
ble gases, potentially explosive atmospheres, or near flammable materials.
There is a risk of product failure. A fire or electric shock may also occur resulting in death or serious injury.

Install external emergency stop circuits that can turn OFF the power and stop operation
immediately in case an error occurs.
There is a risk of equipment damage and death or serious injury due to unexpected machine operation.

Always use a servomotor and SERVOPACK in one of the specified combinations.
There is a risk of product failure. There is also a risk of fire that causes death or serious injury. Additionally,
there is a risk of death or serious injury due to unexpected machine operation.

Do not touch a SERVOPACK or servomotor with wet hands.
There is a risk of product failure if the SERVOPACK and servomotor get wet. A fire or electric shock may
also occur resulting in death or serious injury.
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CAUTION
The SERVOPACK heat sinks, regenerative resistors, external dynamic brake resistors, ser-
vomotors, and other components can be very hot while power is ON or soon after the power
is turned OFF. Implement safety measures, such as installing covers, so that hands and
parts such as cables do not come into contact with hot components.
There is a risk of burns from touching hot components.

NOTICE
Do not attempt to use a SERVOPACK or servomotor that is damaged or that has missing
parts.
There is a risk that the product may not function correctly.

In environments with unstable power supply, install the necessary protective devices (such
as AC reactors) to ensure that the input power is supplied within the specified voltage
range.
There is a risk of product failure.

Minimize the effects of electromagnetic interference by connecting a device, such as a
noise filter.
There is a risk of equipment or product malfunction.

(2) Storage Precautions

WARNING
Do not place an excessive load on the product. Follow the labels on the shipping box
regarding product loading.
There is a risk of the product falling and causing product damage or failure. There is also a risk of death or
serious injury.

Do not install or store the product in any of the following locations.
• Locations that are subject to direct sunlight
• Locations that are subject to surrounding air temperatures that exceed product
specifications

• Locations that are subject to relative humidities that exceed product specifications
• Locations that are subject to condensation as the result of extreme changes in
temperature

• Locations that are subject to corrosive or flammable gases
• Locations that are near flammable materials
• Locations that are subject to dust, salts, or iron powder
• Locations that are subject to water, oil, or chemicals
• Locations that are subject to vibration or shock that exceeds product specifications
• Locations that are subject to radiation

If you store or install the product in any of the above locations, there is a risk of product failure. A fire or
electric shock may also occur resulting in death or serious injury.



i.7 Safety Precautions

26

(3) Transportation Precautions

WARNING
Transport the product in a way that is suitable to the mass of the product.
There is a risk of the product falling and causing product damage or failure. There is also a risk of death or
serious injury.

Do not use the lifting hardware on a SERVOPACK or servomotor to move the entire
machine.
There is a risk of the product falling due to improper use of lifting hardware and causing product and equip-
ment damage or failure. There is also a risk of death or serious injury.

Do not place an excessive load on the product. Follow the labels on the shipping box
regarding product loading.
There is a risk of the product falling and causing product damage or failure. There is also a risk of death or
serious injury.

Do not overtighten the lifting hardware on the SERVOPACK and servomotor.
If you use a tool to overtighten the lifting hardware, the product may be damaged. The product may also be
damaged and fall causing death or serious injury.

CAUTION
When you handle a SERVOPACK or servomotor, be careful of sharp edges, such as the
corners.
There is a risk of injury.

When you move the SERVOPACK, hold the main body directly and not the front cover or
connectors.
If you move the SERVOPACK by holding the front cover or connectors, those parts may break off and
cause product damage, product failure, or injury.

NOTICE
A SERVOPACK or servomotor is a precision device. Do not drop it or subject it to impact or
excessive force.
There is a risk of product damage or failure.

Avoid applying mechanical shock or impact to connectors.
There is a risk of product damage or failure.

If disinfectants or insecticides must be used to treat packing materials such as wooden
frames, plywood, or pallets, use a method other than fumigation.
For example, use heat sterilization (core temperature of 56°C or higher for 30 minutes or
longer).
Treat the packing materials before the product is packaged instead of using a method that
treats the entire packaged product.
If the electronic products, which include stand-alone products and products installed in machines, are packed
with fumigated wooden materials, the electrical components may be greatly damaged by the gases or fumes
resulting from the fumigation process. In particular, disinfectants containing halogen, which includes chlor-
ine, fluorine, bromine, or iodine, can contribute to product failure by corroding the insides of capacitors.
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(4) Installation Precautions

WARNING
Install the SERVOPACK and the servomotor using mounting that can support their mass.
Check the masses of the SERVOPACK and the servomotor in the respective instruction
manuals, and install the SERVOPACK and the servomotor by following the chapters related
to installation in the respective product manuals.
In case of improper installation, there is a risk of the SERVOPACK and servomotor falling and causing dam-
age or failure to equipment and the product. There is also a risk of death or serious injury.

Install SERVOPACKs, servomotors, regenerative resistors, and external dynamic brake
resistors on nonflammable materials.
Installation directly onto or near flammable materials may result in fire that causes death or serious injury.

Provide the specified clearances between the SERVOPACK and the control panel and other
devices. Refer to "Mounting Interval" in the product manual for your SERVOPACK for the
specified clearances.
There is a risk of product failure if the SERVOPACK temperature and the temperature around the SERVO-
PACK locally exceed the surrounding air temperature range. There is also a risk of fire that causes death or
serious injury.

Install the SERVOPACK in the specified orientation.
There is a risk of product failure if the SERVOPACK temperature and the temperature around the SERVO-
PACK locally exceed the surrounding air temperature range. There is also a risk of fire that causes death or
serious injury.

Do not allow any foreign matter to enter the SERVOPACK or servomotor.
There is a risk of product failure. There is also a risk of fire that causes death or serious injury.

Do not install or store the product in any of the following locations.
• Locations that are subject to direct sunlight
• Locations that are subject to surrounding air temperatures that exceed product
specifications

• Locations that are subject to relative humidities that exceed product specifications
• Locations that are subject to condensation as the result of extreme changes in
temperature

• Locations that are subject to corrosive or flammable gases
• Locations that are near flammable materials
• Locations that are subject to dust, salts, or iron powder
• Locations that are subject to water, oil, or chemicals
• Locations that are subject to vibration or shock that exceeds product specifications
• Locations that are subject to radiation

If you store or install the product in any of the above locations, there is a risk of product failure. A fire or
electric shock may also occur resulting in death or serious injury.

CAUTION
Do not step on or place a heavy object on the product.
There is a risk of product damage or failure because the product cannot withstand the load.
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NOTICE
Use the product in an environment that is appropriate for the product specifications.
There is a risk of product damage or failure if you use the product in an environment that exceeds the prod-
uct specifications.

A SERVOPACK or servomotor is a precision device. Do not drop it or subject it to impact or
excessive force.
There is a risk of product damage or failure.

Always install a SERVOPACK in a control panel.

Do not allow any foreign matter to enter a SERVOPACK or a servomotor with a cooling fan
and do not cover the outlet from the servomotor’s cooling fan.
There is a risk of product failure.

(5) Wiring Precautions

DANGER
Do not change any wiring while power is being supplied.
There is a risk of equipment damage or product failure. There is also a risk of fire or electric shock that
causes death or serious injury. Additionally, there is a risk of death or serious injury due to unexpected
machine operation.

Wait for at least 20 minutes (or 100 minutes when using DC power supply input) after turning
OFF the power and then make sure that the CHARGE indicator is not lit before starting wir-
ing or inspection work. Do not touch the main circuit terminals while the CHARGE indicator
is lit because high voltage may still remain in the SERVOPACK even after turning OFF the
power.
There is a risk of electric shock that causes death or serious injury.

WARNING
Wiring and inspections must be performed only by qualified engineers.
If work is performed by a worker who is not a qualified engineer, there is a risk of fire or electric shock that
causes death or serious injury.

Check all wiring and power supplies carefully.
Incorrect wiring or incorrect voltage application to the output circuits may cause short-circuit failures. If this
failure occurs, there is a risk of fire that causes death or serious injury. There is also a risk of equipment and
product damage because the holding brake may fail to operate properly.

Always use the specified terminals to connect the SERVOPACK and peripheral devices. For
the power supply in particular, confirm that the connections are made to the terminals
shown below.
200-V power supply input SERVOPACK:
• AC power supply: L1, L2, L3, L1C, L2C terminals on the SERVOPACK
• DC power supply: B1/ , 2, L1C, L2C terminals on the SERVOPACK

400-V power supply input SERVOPACK:
• AC power supply: L1, L2, L3 terminals on the SERVOPACK
• DC power supply: B1/ , 2 terminals on the SERVOPACK
• 24-VDC control power supply: 24-V and 0-V terminals (same whether the main circuit
power supply wiring is an AC power supply or a DC power supply)

Refer to "Terminal Symbols and Terminal Names" in the product manual for your SERVO-
PACK for details on terminals.
If you ignore these precautions, there is a risk of equipment failure or product failure due to fire. There is
also a risk of fire that causes death or serious injury.
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WARNING
If you use a SERVOPACK with the dynamic brake hardware option, connect an external
dynamic brake resistor that is suitable for the machine and equipment specifications to the
specified terminals.
There is a risk of equipment damage due to unintended machine operation during an emergency stop. There
is also a risk of injury or fire that causes death or serious injury.

Observe the precautions and instructions for wiring and trial operation precisely as
described in "Wiring" and "Holding Brake" in the product manual for your SERVOPACK.
If a mistake is made in wiring or trial operation, there is a risk of product failure due to incorrect wiring or
incorrect voltage application in the brake circuit. A fire or electric shock may also occur resulting in death or
serious injury. Additionally, there is a risk of death or serious injury due to unexpected machine operation.

Check the wiring to be sure it has been performed correctly. Connectors and pin layouts
may vary depending on the model. Always confirm the pin layout examples in the chapter
related to pin layouts in the product manual for your model.
If the wiring is not performed correctly, there is a risk of product failure. There is also a risk of fire or electric
shock that causes death or serious injury. Additionally, there is a risk of death or serious injury due to unex-
pected machine operation.

Connect wires to main circuit terminals and motor connection terminals securely with the
specified methods and tightening torque. Refer to "Wiring Servomotors" in the product
manual for your SERVOPACK for the specified methods and tightening torque.
Insufficient tightening may cause wires and terminal blocks to generate heat due to poor contact, possibly
resulting in product failure. There is also a risk of fire that causes death or serious injury.

Make sure the cables do not exceed the following lengths:
• I/O signal cable: 3 m max.
• Servomotor main circuit cable: 50 m max.
• Encoder cable: 50 m max.
• Control power supply cable for 400-V power supply input SERVOPACK (+24 V and 0 V):
10 m max.

If a cable is longer than the specified length, there is a risk of equipment damage due to product malfunction
that causes death or serious injury. There is also a risk of electric shock due to a short circuit or ground fault
that causes death or serious injury.

Observe the following precautions when wiring the SERVOPACK’s main circuit terminals.
• Turn ON the power to the SERVOPACK only after all wiring, including the main circuit
terminals, has been completed.

• If a connector is used for the main circuit terminals, remove the main circuit connector
from the SERVOPACK before you wire it.

• Insert only one wire per insertion hole in the main circuit terminals.
• When you insert a wire, make sure that the conductor wire (e.g., whiskers) does not
come into contact with adjacent wires and cause a short-circuit.

If the SERVOPACK power is turned ON with incorrect wiring, there is a risk of fire due to electric shock or
product failure that causes death or serious injury.

Install molded-case circuit breakers and other safety measures to provide protection
against short circuits in external wiring.
There is a risk of fire or electric shock due to product failure that causes death or serious injury.

Install a battery at either the host controller or on the encoder cable.
If you install batteries both at the host controller and on the encoder cable at the same time, you will create a
loop circuit between the batteries, and this may result in a fire from product failure or damage that causes
death or serious injury.

When connecting a battery, connect the polarity correctly.
There is a risk of encoder failure if the battery ruptures and a risk of fire that causes death or serious injury.
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CAUTION
Use shielded twisted-pair cables or shielded multi-core twisted-pair cables for I/O signal
cables and encoder cables.
There is a risk of injury from product malfunction.

NOTICE
Use the cables specified by Yaskawa. If you use any other cables, confirm the rated current
and application environment of your model and use the wiring materials specified by Yas-
kawa or equivalent materials. Refer to the peripheral selection manual for your SERVOPACK
for Yaskawa-specified cables and wiring materials.

Securely tighten connector screws and lock mechanisms.
Insufficient tightening may result in connectors falling off during operation.

Do not bundle power lines (e.g., the main circuit cable) and low-current lines (e.g., the I/O
signal cables or encoder cables) together or run them through the same duct. If you do not
place power lines and low-current lines in separate ducts, separate them by at least 30 cm.
There is a risk that the product may not function correctly due to the effects of noise on low-current lines.

Do not change the communications cable connections while the SigmaWin+ is running.
There is a risk of product failure or malfunction.

(6) Operation Precautions

WARNING
Before starting operation with a machine connected, configure the settings of the switches
and parameters to match the machine. Always check the settings of the switches and
parameters in this manual.
If operation is performed without configuring the settings, there is a risk of equipment damage and death or
serious injury due to unexpected machine operation.

Do not significantly change the settings of the parameters.
There is a risk of equipment damage and death or serious injury due to unexpected machine operation.

Install safety equipment (e.g., limit switches or stoppers) in an appropriate manner at the
ends of the moving parts of the machine to prevent unexpected accidents.
If safety equipment is not installed in an appropriate manner, there is a risk of equipment damage and death
or serious injury due to unexpected machine operation.

For trial operation, securely mount the servomotor and disconnect it from the machine.
There is a risk of equipment damage and death or serious injury due to unexpected machine operation.

Forced stops for overtravel is disabled when the Jog, Origin Search, or Easy FFTutility func-
tion is executed. Ensure that appropriate safety measures are in place around moving parts.
There is a risk of equipment damage and death or serious injury due to unexpected machine operation.

When an alarm occurs, the servomotor will coast to a stop or stop with the dynamic brake
according to the SERVOPACK option and settings. The coasting distance will change with
the moment of inertia of the load and the external dynamic brake resistance. Check the
coasting distance during trial operation and implement suitable safety measures on the
machine.
Refer to this manual for the specifications of SERVOPACK options.
There is a risk of equipment damage and death or serious injury due to unexpected machine operation.
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WARNING
Do not enter the machine’s range of motion during operation.
There is a risk of death or serious injury from entrapment or the machine making contact with your body
due to unexpected equipment or system operation.

Do not touch the moving parts of the servomotor or machine during operation.
There is a risk of death or serious injury from entrapment or the machine making contact with your body
due to unexpected equipment or system operation.

Perform the correct operation with the servomotor connected to the machine.
There is a risk of equipment damage or product damage. There is also a risk of fire that causes death or seri-
ous injury.

Design the system to ensure safety even when problems, such as broken signal lines,
occur. For example, the P-OT (Forward Drive Prohibit Input) and N-OT (Reverse Drive Pro-
hibit Input) signals are set in the default settings to operate on the safe side if a signal line
breaks. Do not change the polarity of this type of signal. Refer to "Overtravel Function and
Settings" in this manual for the P-OT and N-OTsignals.
If there is poor contact or a cable break occurs when safety is neglected or the signal polarities are changed,
there is a risk of equipment damage because the SERVOPACK will not stop when the P-OT and N-OT sig-
nals are input. There is also a risk of death or serious injury due to unexpected machine operation.

When overtravel occurs, the power to the motor is turned OFF and the brake is released. If
you use the servomotor to drive a vertical load, set the servomotor to enter a zero-clamped
state after the servomotor stops. Also, install safety devices (such as an external brake or
counterweight) to prevent the moving parts of the machine from falling.
There is a risk of equipment damage and death or serious injury due to the moving parts of the machine
falling.

Use the dynamic brake only for emergency stop applications.
If used for any other applications, there is a risk of rapid deterioration of internal components in the SERVO-
PACK as well as equipment or product damage. There is also a risk of fire that causes death or serious
injury.

In the following situations, use the SigmaWin+ to back up the settings of the SERVOPACK
parameters, and then apply the backed up parameter settings after the SERVOPACK is
replaced.
• Before replacement or shipment when shipping a SERVOPACK to Yaskawa for SERVO-
PACK or part replacement

• After you complete tuning and trial operation of the machine and facilities
Refer to the SigmaWin+ Operation Manual for saving parameter settings to a file and apply-
ing saved parameter settings.
If you fail to perform these operations, the SERVOPACK may not operate normally after replacement or
after trial operation, and there is a risk of equipment damage. There is also a risk of death or serious injury
due to unexpected machine operation.
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NOTICE
Always turn OFF the servo before you turn OFF the power. If you turn OFF the main circuit
power or control power during operation before you turn OFF the servo, the servomotor
stopping method will be executed as follows regardless of the stopping method set in the
parameter.
• If you turn OFF the main circuit power during operation without turning OFF the servo,
the servomotor will stop abruptly with the dynamic brake.

• If you turn OFF the control power without turning OFF the servo, the stopping method
that is used by the servomotor depends on the model of the SERVOPACK. For details,
refer to the manual for your SERVOPACK.

• If you use a SERVOPACK with the dynamic brake hardware option, the servomotor stop-
ping methods will be different from the stopping methods used without the option or
with other hardware options. For details, refer to the manual for your SERVOPACK.

Depending on the usage conditions of the servomotor, there is a risk of equipment damage.

When you adjust the gain during system commissioning, use a measuring instrument to
monitor the torque waveform and speed waveform and confirm that there is no vibration.
If a high gain causes vibration, the servomotor will be damaged quickly.

Do not frequently turn the power ON and OFF. After you have started actual operation, allow
at least one hour between turning the power ON and OFF (for reference only). Do not use the
product in applications that require the power to be turned ON and OFF frequently.
Frequently turning the power ON and OFF may rapidly deteriorate internal components in the SERVOPACK
or cause the product to fail.

An alarm or warning may occur if communications are performed with the host controller
while the SigmaWin+ or digital operator is operating.
If an alarm or warning occurs, it may interrupt the current process and stop the system.

Exit the SigmaWin+ before you turn the power to the SERVOPACK and controller ON or OFF.
There is a risk of product failure or malfunction.

(7) Maintenance and Inspection Precautions

DANGER
Do not change any wiring while power is being supplied.
There is a risk of equipment damage or product failure. There is also a risk of fire or electric shock that
causes death or serious injury. Additionally, there is a risk of death or serious injury due to unexpected
machine operation.

Wait for at least 20 minutes (or 100 minutes when using DC power supply input) after turning
OFF the power and then make sure that the CHARGE indicator is not lit before starting wir-
ing or inspection work. Do not touch the main circuit terminals while the CHARGE indicator
is lit because high voltage may still remain in the SERVOPACK even after turning OFF the
power.
There is a risk of electric shock that causes death or serious injury.
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WARNING
Wiring and inspections must be performed only by qualified engineers.
If work is performed by a worker who is not a qualified engineer, there is a risk of fire or electric shock that
causes death or serious injury.

When shipping a SERVOPACK to Yaskawa for SERVOPACK or part replacement, use the
SigmaWin+ to back up the settings of the SERVOPACK parameters. Apply the backed up
parameter settings before using the replaced SERVOPACK. Refer to the SigmaWin+ Opera-
tion Manual for saving parameter settings to a file and applying saved parameter settings.
The parameters of any SERVOPACKs that are sent to Yaskawa for part replacement are reset to the factory
settings before they are returned to you. If you fail to perform these operations, there is a risk of equipment
damage and death or serious injury due to unexpected machine operation.

NOTICE
Discharge all static electricity from your body before you operate any of the buttons or
switches inside the front cover of the SERVOPACK.
There is a risk of equipment damage or product failure.

(8) Troubleshooting Precautions

DANGER
If the safety device (molded-case circuit breaker or fuse) installed in the power line operates,
repair or replace the SERVOPACK, check the wiring, and remove the factor that caused the
safety device to operate. After you confirm that the factor was removed, supply power to the
SERVOPACK.
There is a risk of equipment damage or product failure. There is also a risk of fire or electric shock that
causes death or serious injury. Additionally, there is a risk of death or serious injury due to unexpected
machine operation.

WARNING
The product may suddenly start to operate when the power supply is recovered after a
momentary power interruption. Design the machine to ensure human safety when operation
restarts.
There is a risk of equipment damage and death or serious injury due to unexpected machine operation.

When an alarm occurs, remove the cause of the alarm and ensure safety. Then reset the
alarm or turn the power OFF and ON again to restart operation.
There is a risk of equipment damage or product failure. There is also a risk of injury, fire, or electric shock
that causes death or serious injury.

If the Servo ON signal is input to the SERVOPACK and an alarm is reset, the servomotor
may suddenly restart operation. Make sure to confirm that the servo is OFF and ensure
safety before you reset an alarm.
There is a risk of equipment damage and death or serious injury due to unexpected machine operation.

Always insert a magnetic contactor in the line between the main circuit power supply and
the main circuit terminals on the SERVOPACK so that the power can be turned OFF at the
main circuit power supply.
There is a risk of fire due to internal component failure in the SERVOPACK that causes death or serious
injury.
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WARNING
If an alarm occurs, turn OFF the main circuit power supply.
There is a risk of fire and death or serious injury due to a regenerative resistor overheating as the result of
regenerative transistor failure.

Install a ground fault detector against overloads and short-circuiting or install a molded-
case circuit breaker combined with a ground fault detector.
If a ground fault occurs, there is a risk of injury, fire, or electric shock due to SERVOPACK failure that
causes death or serious injury.

The holding brake alone on a servomotor will not ensure safety if there is the possibility that
an external force (including gravity) may move the current position and create a hazardous
situation when power is interrupted or an error occurs. To ensure safety, make sure to install
an external braking mechanism.
There is a risk of equipment damage and death or serious injury due to unexpected machine operation.

(9) Disposal Precautions
• Correctly discard the product as stipulated by regional, local, and municipal laws and regulations. Be sure to include these contents in all
labelling and warning notifications on the final product as necessary.

(10) General Precautions
• Figures provided in this manual are typical examples or conceptual representations. There may be differences between them and actual
wiring, circuits, and products.

• The products shown in illustrations in this manual are sometimes shown with their covers or protective guards removed to illustrate
detail. Always replace all covers and protective guards before you use the product.

• If you need a new copy of this manual because it has been lost or damaged, contact your nearest Yaskawa representative or one of the
offices listed on the back of this manual.

• This manual is subject to change without notice for product improvements, specifications changes, and improvements to the manual
itself. We will update the manual number of the manual and issue revisions when changes are made.

• Any and all quality guarantees provided by Yaskawa are null and void if the customer modifies the product in any way. Yaskawa dis-
avows any responsibility for damages or losses that are caused by modified products.
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i.8 Warranty

i.8.1 Details of Warranty

(1) Warranty Period
The warranty period for a product that was purchased (hereinafter called the “delivered product”) is one year
from the time of delivery to the location specified by the customer or 18 months from the time of shipment from
the Yaskawa factory, whichever is sooner.

(2) Warranty Scope
Yaskawa shall replace or repair a defective product free of charge if a defect attributable to Yaskawa occurs dur-
ing the above warranty period. This warranty does not cover defects caused by the delivered product reaching
the end of its service life and replacement of parts that require replacement or that have a limited service life.
This warranty does not cover failures that result from any of the following causes.
• Improper handling, abuse, or use in unsuitable conditions or in environments not described in product catalogs
or manuals, or in any separately agreed-upon specifications

• Causes not attributable to the delivered product itself
• Modifications or repairs not performed by Yaskawa
• Use of the delivered product in a manner in which it was not originally intended
• Causes that were not foreseeable with the scientific and technological understanding at the time of shipment
from Yaskawa

• Events for which Yaskawa is not responsible, such as natural or human-made disasters

i.8.2 Limitations of Liability
• Yaskawa shall in no event be responsible for any damage or loss of opportunity to the customer that arises due
to failure of the delivered product.

• Yaskawa shall not be responsible for any programs (including parameter settings) or the results of program
execution of the programs provided by the user or by a third party for use with programmable Yaskawa
products.

• The information described in product catalogs or manuals is provided for the purpose of the customer purchas-
ing the appropriate product for the intended application. The use thereof does not guarantee that there are no
infringements of intellectual property rights or other proprietary rights of Yaskawa or third parties, nor does it
construe a license.

• Yaskawa shall not be responsible for any damage arising from infringements of intellectual property rights or
other proprietary rights of third parties as a result of using the information described in catalogs or manuals.

i.8.3 Suitability for Use
• It is the customer’s responsibility to confirm conformity with any standards, codes, or regulations that apply if
the Yaskawa product is used in combination with any other products.

• The customer must confirm that the Yaskawa product is suitable for the systems, machines, and equipment
used by the customer.

• Consult with Yaskawa to determine whether use in the following applications is acceptable. If use in the appli-
cation is acceptable, use the product with extra allowance in ratings and specifications, and provide safety
measures to minimize hazards in the event of failure.

– Outdoor use, use involving potential chemical contamination or electrical interference, or use in conditions
or environments not described in product catalogs or manuals
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– Nuclear energy control systems, combustion systems, railroad systems, aviation systems, vehicle systems,
medical equipment, amusement machines, and installations subject to separate industry or government
regulations

– Systems, machines, and equipment that may present a risk to life or property
– Systems that require a high degree of reliability, such as systems that supply gas, water, or electricity, or sys-
tems that operate continuously 24 hours a day

– Other systems that require a similar high degree of safety
• Never use the product for an application involving serious risk to life or property without first ensuring that the
system is designed to secure the required level of safety with risk warnings and redundancy, and that the Yas-
kawa product is properly rated and installed.

• The circuit examples and other application examples described in product catalogs and manuals are for refer-
ence. Check the functionality and safety of the actual devices and equipment to be used before using the
product.

• Read and understand all use prohibitions and precautions, and operate the Yaskawa product correctly to pre-
vent accidental harm to third parties.

i.8.4 Specifications Change
The names, specifications, appearance, and accessories of products in product catalogs and manuals may be
changed at any time based on improvements and other reasons. The next editions of the revised catalogs or man-
uals will be published with updated code numbers. Consult with your Yaskawa representative to confirm the
actual specifications before purchasing a product.
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1.1 Before Using the SigmaWin+ AE
This section describes an outline of the SigmaWin+ AE and the tasks that must be performed to use the Sigma-
Win+ AE.

1.1.1 What Is the SigmaWin+ AE?
The SigmaWin+ AE engineering tool for configuring user applications and editing ladder programs.
The SigmaWin+ AE is an add-on engineering tool for the SigmaWin+ version 7. This means you first need to
install version 7.52 or later of the SigmaWin+ Ver.7 and then add the special model information file.
The SigmaWin+ AE is installed in a PC and the PC can be connected to a SERVOPACK to operate the SERVO-
PACK from the PC interface.

1.1.2 System Configuration Example
The following figure shows a system configuration example where the SigmaWin+ AE is connected to the
SERVOPACK.

1.1.3 Applicable SERVOPACK Models
The SigmaWin+ AE supports the following SERVOPACKs:
• Σ-X-Series Σ-XS SERVOPACK with FT specification customized sensing data function option (with stand-
alone custom motion function)
Information You can also check this information in the [Environment Setting] window in the SigmaWin+ AE. Refer to the following

section for details.
8.1.3 [System] - [Controller Type] on page 326
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1.1.4 Operating Environment
The operating environment of the SigmaWin+ AE is given below.

CPU Clock 1 GHz or more (recommended) *1

Memory Capacity 1 GB or more (recommended) *2

Available Hard Disk Space 1.2 GB or more *3

Monitor 1280 × 800 resolution or higher (recommended)

CD Drive One (Used only for software installation)

Communications Port Ethernet, USB

Supported Languages English, Japanese, Simplified Chinese

Supported Operating Systems
Supports 32-bit OS and 64-bit OS.
Windows11, Windows10

Software Environment Microsoft .NET Framework 4.6.2

Browser (to Display Help) Internet Explorer 9 or later

Other Adobe Reader Ver. 6.00 or later

*1 This software can also run on compatible CPUs manufactured by companies other than Intel.
*2 Installing more memory than the minimum requirements is recommend because the memory will be insufficient and performance will

decrease when multiple applications are run at the same time.
*3 This value includes the standard workspace after installation.

1.1.5 Installing the SigmaWin+ AE on a PC
Use the following procedure to install the SigmaWin+ AE on a PC.

1. Ready the model information data set.

2. Extract the contents of the ZIP file with the model information data set.

3. Add the model information file (DB) inside the extracted folder to the SigmaWin+ Ver.7.
Refer to the following manual for how to add the model information file.

AC Servo Drive Engineering Tool SigmaWin+ Operation Manual (Manual No.: SIET S800001 34)

4. Execute the [Setup.exe] file in the extracted folder.

Important

If you did not install the SigmaWin+ version 7.52 or later on the personal computer in advance, the following
message dialog box will be displayed. In this case, install the SigmaWin+ Ver.7 for the following conditions,
and then perform step 4 again.
•When the SigmaWin+ Ver.7 is not installed on the personal computer:
Use the installer for the SigmaWin version 7.52 or later and install it on the personal computer.
•When an older version of the SigmaWin+ Ver.7 is installed on the personal computer:
Uninstall the currently installed SigmaWin+ Ver.7 from the personal computer, and then use the installer for
the SigmaWin version 7.52 or later and reinstall it.
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5. Click the [Next] button.

The License Agreement will be displayed.

6. Read the agreement, and then click [I accept the terms of the license agreement].
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7. Click the [Next] button.

8. Select the destination folder.
• To install to the folder shown under [Destination Folder]: Proceed to step 9.
• To change the destination folder: Click the [Browse] button and select the desired destination by fol-
lowing the guidance displayed in the window.



1.1 Before Using the SigmaWin+ AE

42

9. Click the [Next] button.

10. Click the [Install] button.

The installation will begin.
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11. Click the [Finish] button.

This concludes the installation of SigmaWin+ AE on the PC.

1.1.6 Connecting the SigmaWin+ AE to a SERVOPACK
This section describes how to connect the PC on which the SigmaWin+ AE is installed to a SERVOPACK.

(1) Connecting Cables
A conceptual illustration of a connection and the cable specifications are shown below.

Information Refer to the manual for the SERVOPACK for the connections between the SERVOPACK and power supply.
Σ-X-Series AC Servo Drive Σ-XS SERVOPACK with FT Specification Customized Sensing Data Function Option (with Standalone
Custom Motion Function) Product Manual (Manual No.: SIEP C710812 32)

Conceptual Illustration of Connection Cable Specifications

Ethernet
Use a commercially available cable that meets the following
conditions:
• Ethernet specification: 100Base-TX
• Category 5 or higher
• Twisted-pair cable with RJ-45 connectors
USB
Use the Yaskawa-specified USB cable.

(2) Connection Status
The connection status between the SigmaWin+ AE and SERVOPACK can be classified as shown below.

Information Refer to the following section for details on the project file.
2.1 What Is a Project File? on page 80
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Connection Status Description

Online

Direct Connection

The status where a connection is made to the SERVOPACK in the SigmaWin+ AE without
opening a project file.
You can monitor and edit information in the SERVOPACK using the SigmaWin+ AE.
However, you cannot copy a drawing when using a direct connection. To copy a drawing,
establish a project link connection.

Project Link
Connection

The status where a project file is opened in the SigmaWin+ AE and then a connection is
made to the SERVOPACK.
A project link connection is made to the SERVOPACK in the following cases:
• To set up the actual machine using a project file that was previously created because the
previous and current machine configurations are the same.

• To connect to the actual machine and continue setup using a project that was previously
created when the setup process was not completed.

Offline

The status where the SigmaWin+ AE is not connected to the SERVOPACK.
You can open a project file and configure the settings for that data. You can manipulate the
data in the project file without the actual machine (e.g., SERVOPACK), but the functions
available to you are limited.

The data that is displayed in the SigmaWin+ AE window and the storage location for edited data depend on the
connection status and the project file status. The following table provides illustrations of this. This table describes
saving only, but deletion is the same.
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Connection
Status

Project File
Status

Data Dis-
played in
the Sigma-
Win+ AE
Window

Storage
Location of
Edited Data

Illustration

Online:
Direct
Connection

Not open SERVO-
PACK RAM

SERVO-
PACK RAM

Online: Proj-
ect Link
Connection

Open SERVO-
PACK RAM

In the open
project file
and the SER-
VOPACK
RAM

Note:
Only changes are stored in the project file. When using a project link connec-
tion, make sure the contents of the project file and the SERVOPACK RAM
are the same before you start.
Refer to the following section for details.

2.4.1 Compare with Controller on page 95

Offline Open Open project
file

Open project
file

Information Differences between the SERVOPACK RAM and Flash Memory
•RAM: Data is lost when the power to the SERVOPACK is turned OFF.
• Flash memory: Data is retained even when the power to the SERVOPACK is turned OFF.
We recommend saving the data to the flash memory.

(3) Engineering Range
This product can be used to engineer a single-axis system as shown below.
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1.1.7 Setting Up Communications
This section describes the communications settings for the PC on which the SigmaWin+ AE is installed and the
SERVOPACK.
The following table gives visual examples of the communications settings and page references.

Illustration Reference

(a) Ethernet Communications
(Assigning IPAddresses Manually) on
page 46
(c) USB Communications on page 51

Use the following procedure.

(1) Communications Methods
The following two communications methods are available for the connection between the personal computer on
which the SigmaWin+ AE is installed and the SERVOPACK.
• Ethernet communications
• USB communications
IP addresses can also be assigned automatically or manually for Ethernet communications.

(a) Ethernet Communications (Assigning IPAddresses Manually)
Use the following procedure to establish a normal connection from the PC on which the SigmaWin+ AE is
installed to a SERVOPACK by Ethernet communications (assigning IP addresses manually).

1. Open Control Panel from the Windows Start Menu.
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2. Click [Network Connections].

The [Network Connections] window will be displayed.

3. Right-click [Local Area Connection] or [Ethernet] and select [Properties].

Information The text displayed for the options will depend on your personal computer.

The [Ethernet Properties] window will be displayed.

4. Double-click [Internet Protocol Version 4 (TCP/IPv4)].

The [Internet Protocol Version 4 (TCP/IPv4) Properties] window will be displayed.

5. In the [Use the following IP address] area, set the following items, and then click the
[OK] button.
• IP address = 192.168.1.□□□
• Subnet mask = 255.255.255.0
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Information •Do not use the same IP address as the IP address of any other device.
• It is not necessary to change or specify the default gateway.

This completes the IP address settings and closes the [Internet Protocol Version 4 (TCP/IPv4) Proper-
ties] window.

6. Start up SigmaWin+ AE.

7. Click [Communications Setting].

The [Communications Setting] window will be displayed.

8. Select the IP address that was set in step 5 from the [Communication port] box, and
then click the [Search] button.

Information This section describes the typical procedure. You can also make the connection with other operations. Refer
to the following section for details.

(b) Details on the [Communications Setting] Dialog Box on page 50
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The search results will be displayed in the [Search Controller] area.

9. Select the SERVOPACK that is directly connected to the the SigmaWin+ AE from the
[Search Controller] area, and click the [Connection] button.
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10. Confirm that [Online] appears to the upper left of the launcher.

This concludes the settings.

(b) Details on the [Communications Setting] Dialog Box
This section describes the details on the [Communications Setting] dialog box that is displayed when the personal
computer on which the SigmaWin+ AE was installed (referred to here as "the SigmaWin+ AE") is connected to
the SERVOPACK over Ethernet communications.
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No. Item Description

(1)
[Communications port] Set or select the IP address of the Ethernet connector for the SigmaWin+ AE.

Click [Communication port] and you can select an option from the displayed list.
You cannot use the [IP Setting] button.[IP Setting] Button

(2)

[Manual settings] Set the information on the destination SERVOPACK in either [Manual settings] or [Search and
set].

[Connect from the Sub CPU
or IoT port to the other CPU.] This item is not used in this product.

[Target IP address]

Set the IP address of the SERVOPACK connected to the SigmaWin+ AE (or the Ethernet connec-
tor of the SERVOPACK.
Refer to the manual for SERVOPACK for the default setting of the IP address.

Σ-X-Series AC Servo Drive Σ-XS SERVOPACK with FT Specification Customized Sensing Data Function
Option (with Standalone Custom Motion Function) Product Manual (Manual No.: SIEP C710812 32)

[Sub CPU] This item is not used in this product.

[Option CPU] This item is not used in this product.

[Transit Module]

This item is not used in this product.[Circuit Number]

[Station Address]

(3)

[Search and set] Set the information on the destination SERVOPACK in either [Manual settings] or [Search and
set].

[Search] Button
Click this button to display the SERVOPACK connected to the connector with the IP address set
in (1) [Communication port] on this window.
When there are multiple SERVOPACKs that can be connected, select the model to connect to.

[Use the router] This item is not normally used.

(4) [Connection] Button
Click this button to start the connection between the SigmaWin+ AE and the SERVOPACK
according to the settings in (1) [Communication port] and (2) [Manual settings] or (7) [Search and
set] on this window.

(5) [Setting] Button Click this button to save the set values.

(6) [Cancel] Button Click this button to discard the set values and close the [Communications Setting] dialog box.

(7) [Delete] Button Click this button to discard the set values.

(c) USB Communications
Use the following procedure to establish a normal connection from the PC on which the SigmaWin+ AE is
installed to a SERVOPACK by USB communications.

Important

Use this procedure only when the PC and SERVOPACK are connected using the USB connector on the SERVOPACK.
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1. Start up SigmaWin+ AE, and click [Communications Setting].

The [Communications Setting] window will be displayed.

2. On the [Communications Setting] window, set the communications port to [USB], set
[Local address] to the SERVOPACK's station address, and then click [Connection].

3. Confirm that [Online] appears to the upper left of the launcher.

This concludes the settings.

(2) Setting an Upper Limit to the Communications Size
You can set an upper limit to the communications size when you use a USB or Ethernet communications port.
Use the following procedure.
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1. Double-click the number of the communications port for which to set an upper limit to
the communications size.

The [Port Setting] window will be displayed.

2. Select the [Set a max. communication size] and enter the upper limit.
• Communications Port Type: USB

• Communications Port Type: Ethernet

3. Click the [OK] button.
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The maximum communications size setting will be enabled.

This concludes the procedure.



Ba
si
c
In
fo
rm

at
io
n
on

Si
gm

aW
in
+
AE

1

1.2 Main Window Configuration

55

1.2 Main Window Configuration
This section describes the names, functions, and view settings for the parts of the Main window in the SigmaWin
+ AE.

No. Name Reference

(1) Menu bar 1.2.1 Menu Bar on page 55

(2) Toolbar 1.2.2 Toolbar on page 59

(3) Launcher 1.2.3 Launcher on page 64

(4) Caption bar 1.2.4 Caption Bar on page 65

(5) Window 1.2.5 Window on page 66

(6) Status bar 1.2.6 Status Bar on page 77

1.2.1 Menu Bar
The menu bar displays the functions necessary for controlling the SigmaWin+ AE as a menu.
This section gives details on the menu bar.

(1) [File] Menu
Item Description

New Project Creates a project file.

Open Project Selects and opens a project file.

Close Project Closes the currently open project file.

Save Project Saves by overwriting the currently open project file.

Save as a New Project Saves the currently open project file as a separate file.

Continued on next page.
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Continued from previous page.

Item Description

Convert Project Cannot be used.

Update Project Updates module configuration definition information and ladder instruction information in the
project file.

New Solution Cannot be used.

Open Solution Cannot be used.

Open Solution and Add Current Project Cannot be used.

Close Closes the currently open program.

Environment Setting Displays the [Environment Setting] window.

Import Imports files.

Export Exports files.

Print Preview Displays a printing preview.

Print Displays the [Print] window.

Page Setup Displays the [Page Setup] window.

□□.YSAE Displays the names of the last five project files that were opened. Click a file name to open that
project file.

Exit Exits the SigmaWin+ AE

(2) [Edit] Menu
Item Description

Undo Reverses the effect of the last operation.

Redo Performs the last operation that was reversed using [Undo].

Cut Cuts the contents in the selected range.

Copy Copies the contents in the selected range.

Paste Inserts the contents that has been cut or copied.

Delete Deletes the contents in the selected range.

Automatic Switch to IME When this menu is selected, the input from the keyboard is automatically switched between Japa-
nese and English according to the input box.

Display the Autocomplete list for varia-
bles and registers Toggles between enabling and disabling the Autocomplete.

Select All Selects the entire range in the currently displayed view.

Search Displays the [Search] window, which allows you to search for registers and other items.

Replace Displays the [Replace] window, which allows you to replace registers and other items.

Search in Project Displays the [Search in project] window, which allows you to search for registers and other items
in a specified project.

Replace in Project Displays the [Replace in the project] window, which allows you to replace registers and other
items in a specified project.
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(3) [View] Menu
Item Description

Navigation Cannot be used.

System

Toggle between displaying and hiding the selected windows.

Ladder

Ladder Instruction

Variable

Cross Reference

Check for Multiple Coils

Register List

Watch

Other Windows

AutoWatch

Search for Programs Used in Each Axis

Toolbars Toggles between displaying and hiding the selected toolbars.

Launcher Toggles between displaying and hiding the launcher.

Status Bar Toggles between displaying and hiding the status bar.

Zoom Changes the display magnification.

Refresh Updates the [Ladder] window and [Variable] window with the latest information.

(4) [Online] Menu
Item Description

Connection Establishes a logical connection between the PC on which the SigmaWin+ AE is installed and a
SERVOPACK. This is displayed only in offline mode.

Disconnection Disconnects the PC on which the SigmaWin+ AE is installed and a SERVOPACK. This is dis-
played only in online mode.

1 □□ Displays up to five connection names (logical port number + port type) that have been used for
connections. Click this item to establish the connection with those settings.

Communications Setting Sets up communications between the PC on which the SigmaWin+ AE is installed and a
SERVOPACK.

CPU Switching Fixed to "CPU0".

CPU RUN Starts the CPU of the connected SERVOPACK.

CPU STOP Stops the CPU of the connected SERVOPACK.

Reset CPU Memory Clears CPU memory.

Write to Controller Writes the contents of the project file into the SERVOPACK.

Read from Controller Writes the data from the SERVOPACK into the project file.

Save to Flash Saves the SERVOPACK RAM contents to the flash memory of the SERVOPACK.

Transfer Transfers data, such as programs and registers.

Test Run Cannot be used.

Online Security Setting Sets the online security settings.

Controller Information Displays information about the connected SERVOPACK.
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(5) [Compile] Menu
Item Description

Compile Compiles the currently displayed program.

Compiles All Programs Compiles all programs.

Compile Program Being Edited Compiles the program being edited or that has not been compiled.

(6) [Monitor] Menu
Item Description

System Monitor Displays the System Monitor.

Tuning Panel Used to monitor, edit, and adjust the current value of variables from the panel.

Trace Analyzes tracing data in the form of a trend graph or XY graph.

(7) [Debug] Menu
Item Description

Cross Reference Performs a search on variables or registers currently used in the program.

Check for Multiple Coils Searches all ladder programs for different coils that use the same register.

Force Coil List Searches ladder programs for coils that are forced ON or OFF.

Display Register Map Displays the values of registers (register map) at consecutive addresses.

Add to Watch Adds the selected register to the [Watch] window.

Add to Scope Adds the selected register to the trace window.

(8) [Tool] Menu
Item Description

Engineering builder Displays the engineering builder.

Electronic cam tool Starts the Electronic Cam Tool to create cam tool data.

Print builder Displays the print builder.

(9) [Window] Menu
Item Description

Close All Closes all tab pages except the [Start] tab page when more than one tab page is open in the center
window.

Window layout Saves and restores the window layout.

Horizontal view Splits the tab page displayed in the center window vertically.

Vertical view Splits the tab page displayed in the center window horizontally.

Move to the previous tab Moves the selected tab page to the other window when the center window is split vertically or
horizontally.Move to the next tab

1 Start
Displays the name of the tab page that is currently displayed in the center window.

2 □□

Window Brings the specified tab page to the front or closes it when more than one tab page is open.
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(10) [Help] Menu
Item Description

Contents Displays the table of contents for the help file.

About App Displays the version of the SigmaWin+ AE.

1.2.2 Toolbar
The toolbar displays functions related to project files and programming as buttons.
This section gives details on the tool and tells how to toggle whether the toolbar is displayed or hidden.

(1) [Standard] Toolbar

Button Description

Creates a project file.

Selects and opens a project file.

Closes the currently open project file.

Saves by overwriting the currently open project file.

Displays the [Environment Setting] window.

Cuts the contents in the selected range.

Copies the contents in the selected range.

Inserts the contents that has been cut or copied.

When this menu is selected, the input from the keyboard is automatically switched between Japanese and English accord-
ing to the input box.

Toggles between enabling and disabling the Autocomplete.

Reverses the effect of the last operation.

Performs the last operation that was reversed using [Undo].

Displays the [Search] window, which allows you to search for registers and other items.

Displays the [Replace] window, which allows you to replace registers and other items.

Displays the [Search in project] window, which allows you to search for registers and other items in a specified project.

Changes the display magnification.

Continued on next page.
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Continued from previous page.

Button Description

Compiles the currently displayed program.

Compiles all programs.

Displays the [Print] window.

Displays a printing preview.

Splits the tab page displayed in the center window vertically.

Splits the tab page displayed in the center window horizontally.

Restores the window layout to the layout that was saved as layout 1.

Displays the version of the SigmaWin+ AE.

(2) [Online] Toolbar

Button Description

Establishes and disconnects a logical connection between the PC on which the SigmaWin+ AE is installed and a
SERVOPACK.

Sets up communications between the PC on which the SigmaWin+ AE is installed and a SERVOPACK.

Starts the CPU of the connected SERVOPACK.

Stops the CPU of the connected SERVOPACK.

Writes the contents of the project file into the SERVOPACK.

Writes the data from the SERVOPACK into the project file.

Saves the SERVOPACK RAM contents to the flash memory of the SERVOPACK.

Transfers data, such as programs and registers.

Cannot be used.

Sets the online security settings.

Displays information about the SERVOPACK.

(3) [Ladder Editor] Toolbar
This tool bar is used when working in the Edit Ladder Program Window.
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Button Description

Normal Edit Mode

Branch Creation Mode

Branch Edition Mode

Toggles between displaying and hiding register addresses.

Toggles between displaying and hiding register variables.

Toggles between displaying and hiding register comments.

Turns ON batch scoping.

Turns OFF batch scoping.

Forces ON the coils in the selected register.

Forces OFF the coils in the selected register.

Clears a selected register that has been forced ON or forced OFF.

Lists program locations that have called the current position.

(4) [Ladder Instruction] Toolbar
This tool bar is used when working in the Edit Ladder Program Window.

Button Description

Inputs an NO contact.

Inputs an NC contact.

Inputs a rising-edge pulse.

Inputs a falling-edge pulse.

Inputs a coil.

Inputs a Store (=>) instruction.

Inputs an Expression instruction.

Inputs a Less Than (<) instruction.

Continued on next page.
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Continued from previous page.

Button Description

Inputs a Less Than or Equal (<=) instruction.

Inputs an Equal (==) instruction.

Inputs a Not Equal (!=) instruction.

Inputs a Greater Than or Equal (>=) instruction.

Inputs a Greater Than (>) instruction.

Checks that the input data is within the upper and lower limits.

(5) [Monitor] Toolbar

Button Description

Displays the values of registers (register map) at consecutive addresses.

Adds the selected register to the [Watch] window.

Cannot be used.

Cannot be used.

Displays the System Monitor.

Cannot be used.

Used to monitor, edit, and adjust the current value of variables from the panel.

Cannot be used.

Analyzes the data obtained by Trace 1 to 4 in the form of a trend graph or XY graph.

Cannot be used.

(6) [Debug] Toolbar

Button Description

Performs a search on variables or registers currently used in the program.

Searches all ladder programs for different coils that use the same register.
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(7) [Tool] Toolbar

Button Description

Cannot be used.

The [Engineering Builder] window will be displayed

Displays the [Electronic Cam Tool] window.

Cannot be used.

Cannot be used.

Displays the Print Manager.

(8) Toggling between Display and Hide
You can display or hide in the following two ways for toolbars:
• Displaying and Hiding Entire Toolbars
• Displaying and hiding individual buttons on each toolbar
The procedures are given below.

(a) Displaying and Hiding Entire Toolbars
Toggle between displaying and hiding the toolbars with [Toolbars] on the [View] menu.

(b) Displaying and Hiding Individual Buttons on Each Toolbar

Toggle between displaying and hiding the buttons on the toolbar with [ ] - [Add or Remove Buttons] - [(Name
of the button)].
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1.2.3 Launcher
The launcher displays frequently used functions in the SigmaWin+ AE.
This section gives details on the launcher and tells how to toggle whether the launcher is displayed or hidden.

Item Description

Setup

System Displays the [System] window.

Scantime setting Displays the [Environment Setting] window and navigates to [Setup] - [Scan
Time Setting].

Module configuration Displays the [Module Configuration] window.

Programming
Ladder program Displays the [Ladder] window.

Variable Displays the [Variable] window.

Monitor

Scope Displays the [Trace Type] window.

Register list Displays the [Register List] window.

Watch Displays the [Watch] window.

System monitor Displays the [System Monitor] window.

Transfer

Write into controller Displays the [Transfer Program - Write to Controller] window.

Read from controller Displays the [Transfer Program - Read from Controller] window.

Save to flash Displays the [Transfer Program - Save to Flash] window.

Transfer Displays the [Transfer] window.

Continued on next page.
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Continued from previous page.

Item Description

Utility

Engineering builder Displays the [Engineering Builder] window.

Print builder Displays the print builder.

Electronic cam tool Displays the [Electronic Cam Tool] window.

Start page Displays the [Start] tab page.

(1) Toggling between Display and Hide
Toggle between displaying and hiding the launcher with [Launcher] on the [View] menu.

1.2.4 Caption Bar
The caption bar displays information that includes the status of the SERVOPACK, its type, and the name of the
project file.
This section gives details on the caption bar.

No. Display Description

(1) Online The SigmaWin+ AE is correctly connected to the SERVOPACK.

Offline The SigmaWin+ AE is not connected to the SERVOPACK.

(2) SERVOPACK model When offline: Displays the model of the SERVOPACK that was set when the current project
file was created.
When online: Displays the model of the connected SERVOPACK.

(3) Storage location and name of proj-
ect file

Displays the storage location and file name of the currently open project file.
This information is displayed only when a project file is open (i.e., only when offline or when a
project link connection is active).

(4) Ethernet Displays the communications methods between the SigmaWin+ AE and the SERVOPACK.
This is displayed only in online mode.USB

Continued on next page.
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Continued from previous page.

No. Display Description

(5) IP address of SERVOPACK Displays the IP address of the SERVOPACK that is connected to the SigmaWin+ AE.
This is displayed only in online mode.

(6) CPU Status The operating status of the CPU is displayed.
This is displayed only in online mode.

1.2.5 Window
SigmaWin+ AE has the types of windows described below.
This section describes the details of the [History] window and [My Tool] window, as well as how to display or
hide each window.
Check the references in the following table for details on the other windows.

Window Reference

History (1) [History] Window on page 66

My Tool (2) [My Tool] Window on page 68

Ladder Program (2) Edit Ladder Program Window on page 127

Trace 6.2.3 [Real-Time Trace] Tab Page on page 246
6.2.5 [Trace Manager] Tab Page on page 258
6.2.7 [XY Trace] Tab Page on page 275

Comment List (2) [Comment List] Tab Page on page 184

System –

Ladder (1) [Ladder] Window on page 125

Ladder Instruction (4) [Ladder Instruction] Window on page 127

Variable (3) [Variable] Window on page 127

Cross Reference 5.8 Cross Reference on page 230

Check for Multiple Coils 5.9 Check for Multiple Coils on page 233

Register List 5.1.1 [Register List] Window on page 207

Watch 5.2 Watch on page 210

Outputs –

Search –

Transfer –

Force Coil List 5.5.1 Operations on the [Force Coil List] Window on page 221

AutoWatch (2) Displaying Data with the [AutoWatch] Window on page 211

(1) [History] Window
Start the SigmaWin+ AE or click [History] on the [Start] tab to display the [History] window.
The appearance of the [History] window depends on whether a project file is open.
• When a Project File Is Not Opened
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• When a Project File Is Open

No. Item Description

(1) New *1

Displays the [Create New Project] window, which allows you to create a project file.
Refer to the following section for details.

2.2.1 Creating a Project File on page 81

(2) Open *1 Displays the [Open Project] window, which allows you to select and open a created project file.

(3) Close *1

Automatically saves and closes the project file.
[Close] is displayed only when there is an active project link connection. Refer to the following
section for details on using a project link connection.

(2) Connection Status on page 43

Continued on next page.
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Continued from previous page.

No. Item Description

(4) History (file name) *1

Displays the names of the five project files that were most recently created or edited using the Sig-
maWin+ AE in order beginning with the most recent. If you click a file name, the project file will
be opened. Move the cursor over a file name to display a balloon that allows you to confirm the
location of the file, the date the file was created, and the date it was changed.

(5) Communications Setting

Displays the [Communications Setting] window, which allows you to set the communications port
and connect with the SERVOPACK.
Refer to the following section for details.

1.1.7 Setting Up Communications on page 46

(6) Connection Enables a connection to the SERVOPACK using the communications port that is currently set.

(7) Disconnection Closes the connection with the SERVOPACK.

(8) History (connection name)
Displays up to five connection names (logical port number + port type) that have been used for con-
nections. Click a connection name to change the SERVOPACK to which the connection is to be
made.

(9) Help Starts Acrobat Reader and displays the [Help Selection] window. Select a PDF file and click the
[OK] button to display help for the SigmaWin+ AE.

(10) Close button
Moves the [History] window to the back.
This button does not exit the SigmaWin+ AE. To exit the SigmaWin+ AE, either click the close
button in the Main Window, or select [Exit] from the [File] menu.

*1 This command closes the current connection, if one exists, with the SERVOPACK.

(2) [My Tool] Window
Open a project file or click [My tool] on the [Start] tab to display the [My Tool] window.
The [My Tool] window is also displayed automatically when a connection is made to a SERVOPACK.

This section describes the names and functions of the buttons that are displayed on the [My tool] window.

Button Name Function

System Monitor Displays the System Monitor.

System Setting Displays the system settings.

Scantime Setting Sets the high-speed and low-speed scan time.

Continued on next page.
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Continued from previous page.

Button Name Function

Scope 1 Analyzes the data obtained by Scope 1 in the form of a trend graph or XY graph.

Scope 2 Analyzes the data obtained by Scope 2 in the form of a trend graph or XY graph.

Module Configuration Opens the Module Configuration window.

Create New Ladder Program Creates a ladder program. Allows you to create H, L, and A drawings and functions.

Open Ladder Program Displays a ladder program that was selected from a list.

Connection/Disconnection Connects or disconnects the SERVOPACK.

Tuning Panel Used to monitor, edit, and adjust the current value of variables from the panel.

Transfer Displays the [Transfer] window and executes transfer operations such as writing, reading,
and comparing.

Electronic Cam Tool Starts the Electronic Cam Tool to create cam tool data.

(3) Changing the Window Layout
This section describes how to change the window layout.

(a) Toggling between Display and Hide
Toggle between displaying and hiding the selected windows on the [View] menu.

(b) Changing the Window Display Type
There are three display types for windows, as described below.

No. Display Type Description

(1) Docked Window This is the default display type. Multiple windows are displayed on top of each other as tab pages.
The top tab page can be changed by clicking a tab.

(2) Floating Window Floating windows are displayed separate from the Main window. A floating window can be freely
moved by dragging the title bar.

Information Normally, the Main window cannot be changed to a floating window. Only the
[Comment List] tab page displayed in the Main window can be changed to a
floating window. Drag the tab part to move the floating window.

(3) Auto Hide Window The window slides out from the side when the relevant tab is clicked, and closes when any location
outside of the window is clicked.
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This section provides the names and descriptions of the components of a window.

No. Name Description

(1) Title bar Displays the title of the currently selected (activated) window.

(2) Close button Hides the currently selected window. To display the window again, select the window name from
the [View] menu.

(3)
[ ] button

Toggles the display type of the window between Auto Hide and Docked.

(4) [▼] button Displays a menu for selecting the display type of the window.

(5) [+] button Appears when the window contains a tree hierarchy or categorized list. Expands the display to
show the lower levels of the hierarchy or a list of items included in the category. Click the collapse
button ([-]) to return the expanded list to its original state.

(6) Tab Changes the window that is displayed.
The order of the tabs can be changed by dragging one tab over another tab.
The window display type can be changed from docked to floating by dragging the tab for that win-
dow to a position outside of the currently displayed window.

Use the following methods to change the window display type.
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Before Change After Change Operating Procedure

Floating Window Docked Window Double-click the title bar.

Drag the tab or title bar to the desired docking position in the Main Window.

Auto Hide
Window

Change the window to a docked window first.
A floating window cannot be directly changed to an auto hide window.

Hide Click the close button.

Continued on next page.



1.2 Main Window Configuration

72

Continued from previous page.

Before Change After Change Operating Procedure

Docked Window Floating Window Click the menu button [▼] on the title bar and select [Floating].

Double-click the title bar.

Drag the tab or title bar to the desired position.

Continued on next page.
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Continued from previous page.

Before Change After Change Operating Procedure

Docked Window Auto Hide
Window

Click the menu button [▼] on the title bar and select [Auto Hide].

If multiple windows are displayed on top of each other, all of the windows become auto hide
windows.

Click [ ].

If multiple windows are displayed on top of each other, all of the windows become auto hide
windows.

Hide Click the menu button [▼] on the title bar and select [Hide].

Click the close button.

Continued on next page.
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Continued from previous page.

Before Change After Change Operating Procedure

Auto Hide Window Before performing the following procedure, display the window by clicking on its tab.

Floating Window Change the window to a docked window first.
An auto hide window cannot be directly changed to floating window.

Docked Window Click the menu button [▼] on the title bar and select [Docking].

If multiple windows are displayed on top of each other, all of the windows become docked
windows.

Click [ ].

If multiple windows are displayed on top of each other, all of the windows become docked
windows.

Hide Click the close button.

(c) Splitting the Window
When two or more tab pages are open in the center window, select [Horizontal view] or [Vertical view] on the
[Window] menu to display the tab pages in the corresponding manner.
This is convenient for displaying and editing more than one program.

Information Or, click the corresponding button on the toolbar.
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• When [Horizontal view] Is Selected

• When [Vertical view] Is Selected
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(d) Registering Window Layouts
You can register up to five of the following window layouts.

• Display position and size of each window
• Customized toolbars and menus
• Customized shortcut keys
You can select from the previously registered layouts when programming, debugging, or performing maintenance
to switch to the easiest window layout to use.

�� Registering Window Layouts in Advance
1. Arrange the windows into layout to register.

<Example>
Window Layout for Programming with All Other Windows Hidden

2. Select [Window layout] - [Save Layout] from the [Window] menu and select the desired
layout number.

Information To register other window layouts, select a different layout number.
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A message dialog box will be displayed, and the window layout will be registered.

This concludes the procedure.

�� Changing to a Registered Window Layout
Use one of the following methods to change to one of the registered window layouts.
• Select [Window layout] - [Restore Layout] from the [Window] menu and select the desired layout number.

• Hold down the Ctrl key and press the number key (1 to 5 keys) for the layout number to use.

1.2.6 Status Bar
The status bar displays the status of the SERVOPACK.
This section gives details on the status bar.

No. Display Description Remarks

(1) Balloon help When an alarm occurs, an alarm balloon will be displayed. –

(2) RUN Lits while the CPU of the SERVOPACK is running. The
button is grayed out while the CPU is stopped.

Clicking the [RUN] button starts the
System Monitor.

(3) ALM Lits while there is an alarm in the SERVOPACK. The but-
ton is grayed out when there is no alarm.

Clicking the [ALM] button starts the
System Monitor.

(4)

Online Displayed while the SigmaWin+ AE is correctly connected
to the SERVOPACK.

–
Offline Displayed while the SigmaWin+ AE is not connected to the

SERVOPACK.

(5) FLASH Lits when the SERVOPACK RAM and flash memory do
not match. The button is grayed out when they match.

Clicking the [FLASH] button displays
the [Save to Flash] window.
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This chapter describes basic operations and management methods for project files.
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2.1 What Is a Project File?
With the SigmaWin+ AE, you can save and manage the application data necessary for the SERVOPACK as a sin-
gle file. This file is called the project file.
The project file includes the following application data.

System Configuration

• System definitions
• Scan time definitions
• Module configuration definitions
• Register Map
• Data tracing information

Programming

• Ladder programs (high-speed, low-speed, start, and function programs)
• Table data
• Variables (axis, I/O, global, constant, and user-defined structure variables)
• Comments (I/O, global, and constant comments)

Register

• M (data registers)
• D (internal registers)
• C (constant registers)
• S (system registers)
• I (input registers)
• O (output registers)
• G (data registers)

Use the project file in the follow types of applications.
• To configure the system configuration settings and write programs in a project file on the PC, and then write
that data to a SERVOPACK.

• To write SERVOPACK data to a project file.
Refer to the following section for details on reading and writing data.

2.3 Transfer on page 84

Important

To prevent data loss in case of a equipment failure, always store a backup copy of the project file. We recommend that you
save a copy of the project file before you make any modifications to it (changing the module configuration definitions, the
ladder programs, etc.).
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2.2 Project File Operations
This section describes basic operations for project files.

2.2.1 Creating a Project File
Select [New Project] form the [File] menu to create the project file.

Information You can create a project file only when the SigmaWin+ AE is offline. If the SigmaWin+ AE is online, click the [Connec-
tion/Disconnection] button on the [My Tool] window to set the SigmaWin+ AE to offline.

No. Item Description

(1) Save in Select the folder in which to save the project file.

(2) File name
Enter the name of the project file.
Note:
The file name cannot contain any of the following characters: / \ : * ? " < > |

(3) Save as type
Select the file extension for the project file. The extension that can be selected for the project file is
YSAE.
• YSAE: This extension is supported by FT54.

(4) Create a project with
enhanced security. This check box is selected by default. Clear this check box as required.

(5) Series Fixed value: Sigma-FT

(6) Controller Fixed value: FT54

2.2.2 Opening an Existing Project File
Select [Open Project] form the [File] menu to open a project file.
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Information Only one project file can be opened in a single window with SigmaWin+ AE. The same project file cannot be opened in
more than one window with SigmaWin+ AE. If you try to open a project file that is already open, the window that con-
tains the open project file will move to the front.

2.2.3 Overwriting Project Files
Select [Save Project] form the [File] menu to overwrite a project file.

2.2.4 Saving a New Project File
Select [Save as a New Project] form the [File] menu to save a project with a new name.

2.2.5 Closing a Project File
Select [Close Project] form the [File] menu to close the project file.

2.2.6 Opening a Backed Up Project File

Important

This function provides no guarantees that the content you were editing can be successfully restored.

If you open and edit a project file while offline and the SigmaWin+ AE shuts down abnormally, a backup file
will be created on the desktop of the PC. You can restore the contents of the project file you were editing by
opening this backup file.
When the SigmaWin+ AE shuts down abnormally, use the following procedure to open the backed up project
file.

1. After the SigmaWin+ AE shuts down abnormally, restart the SigmaWin+ AE and open
the project file you were editing.
A backup file will have been saved to the desktop, and a message dialog box will be displayed.

Information The name of the backup file that is created on the desktop begins with "backup0_".
If you open the backup file and the SigmaWin+ AE shuts down abnormally again, the number in the backup
file name will be incremented.

2. Quit Configuratior/EngineeringManager if it is running.
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3. Select "Open the backed up project file", and then click the [OK] button.

The backup file that was saved to the desktop will be opened.
We recommend you save the opened backup file again as the real project file.

This concludes the procedure.
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2.3 Transfer
A transfer refers to reading and writing data between project files, SERVOPACK, and external media, and it also
refers to saving the SERVOPACK RAM data to flash memory.
Click the [Transfer] button in the [My Tool] window to display the [Transfer] window.
The following table lists the types of transfers.

Type of Transfer Transfer Source and Transfer Destination Project File
Status

Connection Status of
SigmaWin+ AE

Write to Controller Project File → SERVOPACK
– Online

Read from Controller SERVOPACK→ Project File

Write to Project Open project file → Other project file
Open Offline

Read from Project Other project file → Open project file

Save to Flash SERVOPACK RAM→ Flash memory – Online

Write to External Media
Project file → External media Open –

SERVOPACK RAM→ External media Closed Online

Read from External Media
External media → Project file Open –

External media → SERVOPACK RAM Closed Online

2.3.1 [Transfer Program] Window
Click a button related to reading or writing in the [Transfer] window to display the [Transfer Program] window.
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You can select the files to transfer and set the options. The settings that are displayed will depend on the type of
transfer.

No. Item Description

(1) [Individual] Button Displays the details on the data selected in [Transfer file type] in the area to the right. The data selected in
this area will be transfered. The [Individual] button has been selected in the above screenshot.

(2) [Batch] Button Transfers all data selected in [Transfer file type].

(3) Transfer file type Select the data to transfer.

<When Transferring a Program>
Select one of the following radio buttons:
• Update local register comments: The program and local register comments will be transferred.
• Do not leave local register comments in project/Do not leave local register comments in controller: Only
the program will be transferred. As local register comments will not be transferred, local register com-
ments will not be displayed in the program at the transfer destination.

<When Transferring Global Register Comments>
Select the target comments from [All], [Standard Comment], [Extended Comment 1], [Extended Comment
2], or [Extended Comment 3].

(4) Transfer option The following options can be selected.
• Save to flash after transferring to the controller: Saves the transferred data to the flash memory in the
SERVOPACK.

(5) [Option] Button Displays the [Environment Setting] window. You can change the settings related to transfers on this window.

2.3.2 Write to Controller
Use the following procedure to write the project file data to the SERVOPACK.

1. Click the [Write to Controller] button in the [Transfer] window.
The [Open] window will be displayed.

2. Select the project file at the transfer source, then click the [Open] button.

Information This window will not be displayed if the project file is already open. The project file that is open serves as
the transfer source.
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The [Transfer Program] window will be displayed.

3. Specify the transfer settings, and click the [Start] button.
Refer to the following section for details on the settings.

2.3.1 [Transfer Program] Window on page 84

A message dialog box will be displayed.

4. Read the message, and then click the [Yes] button.

The transfer will start. When data transfer is completed, a message dialog box will be displayed.

5. Click the [OK] button.
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6. Click the [Yes] button.

This concludes the procedure.

2.3.3 Read from Controller
Use the following procedure to read the data from the SERVOPACK to a project file.

1. Click the [Read from Controller] button in the [Transfer] window.
The [Save As] window will be displayed.

2. Select the project file at the transfer destination (or create a new project file), then click
the [Save] button.

Information This window will not be displayed if the project file is already open. The project file that is open serves as
the transfer destination.

The [Transfer Program] window will be displayed.

3. Specify the transfer settings, and click the [Start] button.
Refer to the following section for details on the settings.

2.3.1 [Transfer Program] Window on page 84
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The transfer will start. When data transfer is completed, a message dialog box will be displayed.

4. Click the [OK] button.

This concludes the procedure.

2.3.4 Write to Project
Use the following procedure to write the data in the open project file to another project file.

1. Open the project file.

2. Click the [Write to Project] button in the [Transfer] window.
The [Save As] window will be displayed.

3. Select the project file at the transfer destination (or create a new project file), then click
the [Save] button.

The [Transfer Program] window will be displayed.

4. Specify the transfer settings, and click the [Start] button.
Refer to the following section for details on the settings.

2.3.1 [Transfer Program] Window on page 84
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A message dialog box will be displayed.

5. Click the [OK] button.

This concludes the procedure.

2.3.5 Read from Project
Use the following procedure to read the data in another project file to the open project file.

1. Open the project file.

2. Click the [Read from Project] button in the [Transfer] window.
The [Open] window will be displayed.

3. Select the project file at the transfer source, then click the [Open] button.

The [Transfer Program] window will be displayed.

4. Specify the transfer settings, and click the [Start] button.
Refer to the following section for details on the settings.

2.3.1 [Transfer Program] Window on page 84
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A message dialog box will be displayed.

5. Click the [OK] button.

This concludes the procedure.

2.3.6 Save to Flash
Save to flash refers to saving the data in the SERVOPACK's RAM to the SERVOPACK's flash memory.
Use the following procedure to save data to flash memory.

Important

• If you turn the power OFF and ON again without saving data to the flash memory, any changes to the program or defini-
tion data will be lost.
• In the [Environment Setting] window, you can also set to automatically save data to flash memory when the connection to
the SERVOPACK is disconnected. Refer to the following section for details.

8.1.24 [Transfer] - [Transfer] on page 338

1. Click the [Save to Flash] button in the [Transfer] window.
The [Transfer Program - Save to Flash] window will be displayed.

2. Click the [Start] button.

3. Read the message, and click the [Yes] button or the [No] button.

Save to flash will start, and the following window will be displayed.
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Information If the SERVOPACK is in RUN mode, the following message will be displayed. The data transfer to the SER-
VOPACK starts when you click the [Yes] button or the [No] button.

When save to flash is completed, a message dialog box will be displayed.

4. Click the [OK] button.

A message dialog box will close.

Information If you clicked the [No] button in step 3, the following message will be displayed.
Click the [Yes] button to put the SERVOPACK in the RUN status.

This concludes the procedure.

Important

Do not turn OFF the power to the SERVOPACK until saving data to flash memory has been completed.
If you turn OFF the power to the SERVOPACK while data is being saved to flash memory, the data will be lost.
If you then restore power to the SERVOPACK, the SERVOPACK will start in the factory default condition.

2.3.7 Write to External Media
You can transfer data to external media (e.g., CF cards and SD cards).
<Example>
When data is transferred to a SERVOPACK via a display or other device that supports CF cards, use of a CF
card frees the operator from the trouble of connecting the SigmaWin+ AE to the SERVOPACK.

When a CF Card Is Used When a CF Card Is Not Used

1. Write the data in SERVOPACK to CF card.
2. Insert the CF card into the display or other device connected to

the SERVOPACK and transfer the data.

1. Write the data in the SERVOPACK to a project file.
2. Switch the PC connection to the SERVOPACK which you

want to transfer the project file to.
3. Write the project file to the SERVOPACK.
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Important

When the [Apply File Reading Restriction] check box is selected in the security settings on the SigmaWin+ AE, data trans-
fer from RAM in SERVOPACK to external media is not possible. To transfer data, change the security settings in [Online
Security Setting] under the [Online] menu.

Use the following procedure to write the data in the SERVOPACK or a project file to external media.

1. Click the [Write to External Media] button in the [Transfer] window.
The [Select Drive] window will be displayed.

2. Set the following items, and then click the [OK] button.

Important

When [User memory (folder specification)] is selected at [Target], and [Compressed □□] is selected at [Format],
the transfer file type can be set individually in the [Transfer Program] window that is displayed next.

The [Transfer Program] window will be displayed.

3. Specify the transfer settings, and click the [Start] button.
Refer to the following section for details on the transfer file type settings.

2.3.1 [Transfer Program] Window on page 84

The transfer will start. When data transfer is completed, a message dialog box will be displayed.
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4. Click the [OK] button.

This concludes the procedure.

2.3.8 Read from External Media
Data is read from external media, for example, to check content written to a CF card or SD card or to write data
to the SERVOPACK during maintenance.
Use the following procedure to read the data on external media to the SERVOPACK or a project file.

1. Click the [Read from External Media] button in the [Transfer] window.
The [Select Drive] window will be displayed.

2. Specify the transfer settings, and click the [OK] button.

The [Transfer Program] window will be displayed.

3. Click the [Start] button.

The transfer will start. When data transfer is completed, a message dialog box will be displayed.
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4. Click the [OK] button.

This concludes the procedure.



Pr
oj
ec
tM

an
ag

em
en

t

2

2.4 Compare

95

2.4 Compare
You can compare data between project files, SERVOPACK, and external media.
Click the [Transfer] button in the [My Tool] window to display the [Transfer] window.
The following table lists the types of comparisons.

Type of Comparison Data to Compare Project File
Status

SigmaWin+ AE Connec-
tion Status

Compare with Controller SERVOPACK⇔ Project file Open
Online

Compare Flash to RAM SERVOPACK RAM⇔ SERVOPACK flash memory –

Compare with Project File Open project file⇔ Other project file Open Offline

Compare with External Media External media⇔ SERVOPACK or project file – –

2.4.1 Compare with Controller
Use the following procedure to compare the data in the SERVOPACK and in a project file.

1. Click the [Compare with Controller] button in the [Transfer] window.
The [Open] window will be displayed.

2. Select the project file at the comparison source, then click the [Open] button.

Information This window will not be displayed if the project file is already open. The project file that is open serves as
the comparison source.
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The [Compare Program] window will be displayed.

3. Select the data to compare, and then click the [Start] button.
Refer to the following section for details on the settings.

2.3.1 [Transfer Program] Window on page 84

The comparison will start.
When the comparison has been completed, a message dialog box will be displayed, and a log of the
comparison operation will be displayed in the [Transfer] window.

This concludes the procedure.

2.4.2 Compare Flash to RAM
Use the following procedure to compare the data in the SERVOPACK's RAM and flash memory.
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1. Click the [Compare Flash to RAM] button in the [Transfer] window.
The [Compare Program] window will be displayed.

2. Click the [Start] button.

The comparison will start.
When the comparison has been completed, a message dialog box will be displayed, and a log of the
comparison operation will be displayed in the [Transfer] window.

This concludes the procedure.

2.4.3 Compare with Project File
Use the following procedure to compare the data in the open project file and in another project file.

1. Open the project file.

2. Click the [Compare with Project File] button in the [Transfer] window.
The [Open] window will be displayed.

3. Select the project file at the comparison source, then click the [Open] button.

The [Transfer Program] window will be displayed.

4. Specify the transfer settings, and click the [Start] button.
Refer to the following section for details on the settings.

2.3.1 [Transfer Program] Window on page 84
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The comparison will start.
When the comparison has been completed, a message dialog box will be displayed, and a log of the
comparison operation will be displayed in the [Transfer] window.

This concludes the procedure.

2.4.4 Compare with External Media
Use the following procedure to compare the data on external media and in the SERVOPACK or a project file.

1. Click the [Compare with External Media] button in the [Transfer] window.
The [Select Drive] window will be displayed.

2. Set the following items, and then click the [OK] button.

The [Compare Program] window will be displayed.
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3. Click the [Start] button.

The comparison will start.
When the comparison has been completed, a message dialog box will be displayed, and a log of the
comparison operation will be displayed in the [Transfer] window.

This concludes the procedure.

2.4.5 Program Comparison Results
If you double-click the comparison results for a ladder program in the output log of the [Transfer] window, you
can display the comparison source and destination programs side by side.

• Light blue: Added or changed locations
• Red: Deleted locations
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Important

If there are multiple differences even though the program was changed in only one location:
The ladder programs are compared based on the executable code (the data that can be executed after the program is com-
piled). Since a specific instruction can be replaced with multiple lines of executable code (instruction numbers), this may be
judged as differences in the comparison. This is not a problem in operation.

Information •You can toggle between whether or not to simultaneously scroll the comparison source and destination programs by the
F9 key.
•You can toggle between the maximized and original size of the comparison results display by the F5 key.
•You can align the corresponding lines on the comparison source and destination by the F11 key. Move the cursor to the
desired line in the program at either the comparison source or destination, and press the F11 key. The corresponding
line of the program on the other side will be displayed.
•The comparison source program can be corrected in this pane. The comparison destination program cannot be
corrected.
•The display color of differences in the comparison window can be changed by [Transfer] – [Compare] in the [Environ-
ment Setting] window.
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3
Designing the System

This chapter describes the operations required to design the system in the SigmaWin+ AE.
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3.3.1 Using Automatic Reception with the SERVOPACK as a Slave ...............113

3.4 Checking, Editing, and Saving Parameters..................................................... 119

3.5 Using an Absolute Encoder.................................................................................120
3.5.1 Initialize the Absolute Encoder.................................................................. 120
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3.1 [MC-Configurator] Window
Click the [Module Configuration] button in the [My Tool] window to display the [MC-Configurator] window.
You can configure device detailed settings on the [MC-Configurator] window.

No. Name Reference

(1) Edit Area 3.1.1 Edit Area on page 102

3.1.1 Edit Area
This section describes the items displayed in the edit area.

(1) Module Configuration
When you open the [MC-Configurator] window, the Module Configuration Window will be displayed. If the
window is not displayed, double-click [Module Configuration] in the [Work Space] window.

No. Item Description

(1) Page Selection Buttons Switches between the [Edit] page, [Status] page, and [Version] page.
The [Edit] page is displayed in the example given above.
The [Status] page shows the operating status of device.
The [Version] page shows the hardware version and software version of device, as well
as the model numbers of SERVOPACKs and servomotors (online mode only).

(2) Save to project Saves the edited content to a project file.

Continued on next page.
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Continued from previous page.

No. Item Description

(3) Setting Configures the selected function module.

(4) Online Read Reads data from the SERVOPACK.

Write Writes data to the SERVOPACK.

(5) Self Configuration
All modules

Cannot be used.
Specified module

(6) Snap Save in Excel File Cannot be used.

(7) Module Fixed value: Sigma-X

(8) Function Module/Slave The functions that are built into SERVOPACK are displayed.

Click the [ ] button on the Ethernet to display the Detail Definition Window.
Refer to the following section for details.

(a) Detail Definition Window on page 103

(9) Status The SERVOPACK status is displayed.

(10) Circuit No./Axis
Address

Start The circuit number of SERVOPACK is displayed.

Occupied circuits The number of circuits that can be used by the SERVOPACK is displayed.

(11) Motion Register Cannot be used.

(12) Register (Input/
Output)

Disabled Cannot be used.

Start - End The fixed range of allocated I/O registers.

Size The fixed size of the allocated I/O area is displayed in words.

Scan Cannot be used.

(13) Comment You can set comments.
<Setting Conditions>
• 16 characters maximum.

(a) Detail Definition Window

�� Displaying the Detail Definition Window
Click the Ethernet [ ] button to display the Detail Definition Window.
Refer to the following section for details on the Ethernet Detail Definition Window.

3.2 Details of Ethernet Detail Definition Window on page 106

�� Saving the Detail Definition Data
Use the following procedure to save the detail definition data that was configured or changed.

1. Click [File] - [Save&Write] or [Save] from the main menu on the Detail Definition
window.

Information [Save&Write] is displayed in online mode and [Save] is displayed in offline mode.
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A confirmation message window will be displayed.

2. Read the message, and then click the [Yes] button.

The settings on the Detail Definition window will be saved.

3. Click the [×] button at the top-right of the Detail Definition window.

4. Click [Save to project] in offline mode only.

5. Save the data to flash memory only in online mode.
Refer to the following section for details on the procedure.

2.3.6 Save to Flash on page 90

6. Turn the SERVOPACK power OFF and ON again only in online mode.

This concludes the procedure.

�� Deleting the Detail Definition Data
Use the following procedure to delete all detail definition data.

1. Click [File] - [Delete] from the main menu on the Detail Definition window.

A confirmation message window will be displayed.
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2. Click the [Yes] button.

The settings on the Detail Definition window will be deleted.

3. Click the [OK] button.

4. Click the [×] button at the top-right of the Detail Definition window.

5. Click [Save to project] in offline mode only.

6. Save the data to flash memory only in online mode.
Refer to the following section for details on the procedure.

2.3.6 Save to Flash on page 90

7. Turn the SERVOPACK power OFF and ON again only in online mode.

This concludes the procedure.
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3.2 Details of Ethernet Detail Definition Window
The Ethernet Detail Definition Window has three tab pages, the [Transmission Parameter], the [Connection
Parameter] and the [Status] tab pages. Each tab page can be displayed by selecting the corresponding tab.
This section shows the items on each tab page. The following section gives a specific example of configuring
Ethernet communications for this product and a touch panel.

3.3 Communications with a Touch Panel on page 113

3.2.1 Transmission Parameter Tab Page
Details for item displayed on the Transmission Parameter Tab Page are shown below.
Ensure you save to flash memory after making any changes to the transmission parameter settings. After saving
to flash memory, the changed transmission parameters will be written to memory.

No. Name Meaning

(1) Equipment Name
Enter the equipment name.
Enter the name with a maximum length of 16 characters. Single-byte and double-byte characters
can be mixed.

(2) Circuit Number Gives the Ethernet port circuit number.
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3.2.2 Connection Parameter Tab Page

No. Name Description

(1) Easy setting Sets parameters for message communications.

(2) CNO Gives the connection number.

(3) Local Port Sets the local port number.

(4) Node Port IPAdress Sets the remote station IP address.

(5) Node Port Sets the remote station port number.

(6) Connection Type Sets the transport layer protocol.

(7) Protocol Type Sets the application layer protocol.

(8) Code Sets the code type.

(9) Detail Sets the local station for automatic reception.

(10) Node Name Enter a connection comment.

(1) Connection Parameter Tab Page Details
Details for each item displayed on the Connection Parameter Tab Page are explained.

(a) CNO
The connection number is 01 only.
Remote stations are differentiated by the connection number in Ethernet communications.
This connection number corresponds to the Param10 “Connection Number” of the MSG-SNDE functions and
MSG-RCVE functions.

(b) Local Port
Enter a local station port number (256 to 65535) for each connection.
Enter numbers that differ from those used for port numbers, engineering port numbers and diagnosis port num-
bers used on other connections.
If the SERVOPACK is the slave, do not use automatic assignment for the port number. Ethernet communications
will not know what port to use when communicating with the master station.
Additionally, “9998”, “10000”, and whichever port number was set for the engineering port cannot be used for
UDP.
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If using the EtherNet/IP port for Ethernet communications, 2222 and 44818 cannot be used for UDP and 44818
cannot be used for TCP.

(c) Node Port IPAdress
Enter a remote station IP address number for each connection.
The data entry range that is allowed for the remote station IP address depends on the field.
• Field No. 1: 0 to 255 (Excluding 127)
• Field No. 2: 0 to 255
• Field No. 3: 0 to 255
• Field No. 4: 1 to 254
However, if using unpassive open mode, enter “0” for fields No. 1 to No. 4.

(d) Node Port
Enter a remote station port number (0 or 256 to 65535) for the connection.
Do not use an IP address and remote port combination that is already in use for another connection.

(e) Connect Type
Select a transport layer protocol.
TCP: Communicates using TCP (Transmission Control Protocol).
UDP: Communicates using UDP (User Datagram Protocol).

Important

If an error occurs during message communications with the UDP (connectionless) protocol, the following may occur.
The Ethernet connector’s LINK/ACT LED indicator will light up or blink. Communication data will be lost and communi-
cations will be terminated.
In this case, implement the following measures.
•Use a twisted-pair cable with RJ-45 connectors, straight cable or a cross cable that is 100Base-TX and Category 5 or
higher.
• Separate the Ethernet cables from the power cables.
If you have implemented these measures but the problem still persists, implement the following measures.
•Change to the TCP (connection) protocol.
• If using the UDP protocol, create a program to timeout and re-execute the send command if processing has not been com-
pleted in a certain amount of time after sending a command.

(f) Protocol Type
Select the application layer protocol for each connection in line with the protocol supporting the remote station.
The following table lists the protocol types.

Protocol Outline

MEMOBUS The Yaskawa standard MEMOBUS protocol

Extended MEMOBUS A protocol to extend the functionality of the MEMOBUS protocol.

MODBUS / TCP The industrial Ethernet protocol suggested by Modicon

No-protocol communications General-purpose message communications

(g) Code
Select a transfer data code type that matches with the code type set in the remote station for each connection.
• RTU: Specifies RTU mode if MEMOBUS protocol is used
• ASCII: Specifies ASCII mode
• BIN: Specifies binary mode
However, there is restriction on selectable codes in the following way based on the data of the [Protocol Type]
box.
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Protocol Type
Code

RTU ASCII BIN

MEMOBUS Supported Supported -

Extended MEMOBUS - Supported Supported

MODBUS / TCP - - Supported

No-protocolcommunications - Supported Supported

(h) Detail
Set up automatic reception using the Detail Setting window.

No. Item Range Description Default Value

(1) Transmission Buffer Channel 1 Fixed value: 1 1

(2) Readout of Input Relay IW00000 to IW1FFFFF
Sets the first register of the
input relay used in automatic
reception.

IW00000

(3) Readout of Input Register IW00000 to IW1FFFFF
Sets the first register of the
input register used in automatic
reception.

IW00000

(4) Readout / Write-in of Coil MW00000 to MW1048576
Sets the first register of the
read/write coil used in auto-
matic reception.

MW00000000

(5) Readout / Write-in of Hold
Register MW00000 to MW1048576

Sets the first register of the
read/write holding register
used in automatic reception.

MW00000000

(6) Readout / Write-in of Data Relay GW00000 to GW67108863
Sets the first register of the
read/write data relay used in
automatic reception.

GW00000000

Continued on next page.
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Continued from previous page.

No. Item Range Description Default Value

(7) Readout / Write-in of Data
Register GW00000 to GW67108863

Sets the first register of the
read/write data register used in
automatic reception.

GW00000000

(8) Readout / Write-in of Output Coil OW00000 to OW1FFFFF
Sets the first register of the
read/write output register used
in automatic reception.

OW00000

(9) Readout / Write-in of Output
Register OW00000 to OW1FFFFF

Sets the first register of the
read/write output register used
in automatic reception.

OW00000

(10)

Write - in width of Coil/Hold
Register (LO) MW00000 to MW1048576

Sets the writing range (LO)
used in automatic reception for
holding register coil.

MW00000000

Write - in width of Coil/Hold
Rgister (HI) MW00000 to MW1048576

Sets the writing range (HI)
used in automatic reception for
holding register coil.

MW00524287

(11)

Write - in width of Data Relay/
Register (LO) GW00000 to GW67108863

Sets the writing range (LO)
used in automatic reception for
data register data relays.

GW00000000

Write - in width of Data Relay/
Register (HI) GW00000 to GW67108863

Sets the writing range (HI)
used in automatic reception for
data register data relays.

GW01048575

(12)

Write - in width of Output Coil/
Register (LO) OW00000 to OW1FFFFF

Sets the output register (output
coil) writing range (LO) used
in automatic reception.

OW00000

Write - in width of Output Coil/
Register (HI) OW00000 to OW1FFFFF

Sets the output register (output
coil) writing range (HI) used in
automatic reception.

OW003FF

(13) Data update timing -
Sets the data update method to
either Periodic, L scan or H
scan.

Periodic

(i) Remote Station Name
Enter a connection comment.
Enter the comment with a maximum length of 32 characters. Single-byte and double-byte characters can be
mixed.

3.2.3 Status Tab Page

No. Name Meaning

(1) CNO Gives the connection number (1 to 20).

(2) Trans Status Gives the status for each connection.

(3) Error status Gives the details of an error if there is a transmission status error.

Continued on next page.
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Continued from previous page.

No. Name Meaning

(4) Send Count Gives the number of packets transmitted to the remote station.

(5) Receive Count Gives the number of packets received from the remote station.

(6) Error Count Gives the number of errors that have occurred in each connection.

(7) Response Time(ms) Gives the time (ms) it took to receive a response after a command is sent with the MSG-
SNDE function.

(8) Connection Type Gives the connection parameter connection type (TCP/UDP) set on the Parameter Set-
ting Tab Page.

(9) Protocol Type Gives the connection parameter protocol type set on the Parameter Setting Tab Page.

(10) Code Gives the connection parameter code (ASCII/BIN/RTU) set on the Parameter Setting
Tab Page.

(11) Node Name Gives the connection parameter remote station name set on the Parameter Setting Tab
Page.

(1) CNO
The connection number is 01 only.

(2) Trans Status
This parameter gives the status for each connection.

Status Meaning

IDLE Waiting for execution of message function

WAIT Waiting for establishment of TCP connection with remote station (Only when using TCP
protocol)

CONNECT Ready for data transmission to and from remote station

- Unused connection

(3) Error Status
This parameter gives error details if a transmission status error occurs.

Status Display Meaning Remarks

No error Normal -

Socket creation error System error A socket could not be created.

Local station port number error
Setting error in local station port number
(Bound to same address during TCP
disconnection)

Binding error (Port number conflict)

A binding error occurred while disconnected
due to the Abort message function. An error
will occur if Execute is turned ON within one
minute of Complete after Abort.

The remote station received a command from
another function before connection was
completed.

Changing socket attribute error System error An error occurred while setting the socket
attribute.

Connection error (M-SND)
Connection error (Connection refused by the
remote station during active open in TCP
settings)

While trying to connect with MSG-SNDE
function, the remote station refused connec-
tion and the command was reset.

A connection attempt failed when retried one
minute (default) after cable disconnection.

Connection error (M-RCV) Connection error (If passive open with TCP
settings)

A connection request error occurred with the
MSG-RCVE function.

Continued on next page.
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Continued from previous page.

Status Display Meaning Remarks

System error System error A socket polling (using Select) error occurred
while receiving data.

TCP data sending error
Data sending error (There is no remote sta-
tion in the TCP settings or it hasn’t been
started)

A response sending error occurred with the
MSG-RCVE function. An error occurred
with the MSG-SNDE function too. Occurs
only with TCP when there is no transmission
target or the transmission target is rebooted.

UDP data sending error Data sending error (If UDP setting) The data send request command was sent to a
socket that does not exist.

TCP data reception error
Data reception error (Disconnection request
was received from the remote station with
TCP settings)

An error occurred while disconnected from
the remote station. An error also occurred
during normal close processing.

UDP data reception error Data reception error (If UDP setting) The data reception instruction was executed
for a socket that does not exist.

Changing socket option error System error Error during socket option change

Data conversion error Data conversion error Protocol conversion error

(4) Send Count
This parameter gives the number of packets transmitted to the remote station.

(5) Receive Count
This parameter gives the number of packets received from the remote station.

(6) Error Count
This parameter gives the number of errors that have occurred in each connection.

(7) Response Time(ms)
This parameter gives the time (ms) it took to receive a response after a command is sent with the MSG-SNDE
function.

(8) Connection Type
This parameter gives the connection parameter connection type (TCP/UDP) set on the Parameter Setting Tab
Page.

(9) Protocol Type
This parameter gives the connection parameter protocol type set on the Parameter Setting Tab Page.

(10) Code
This parameter gives the connection parameter code (ASCII/BIN/RTU) set on the Parameter Setting Tab Page.

(11) Node Name
This parameter gives the connection parameter remote station name set on the Parameter Setting Tab Page.



D
es
ig
ni
ng

th
e
Sy

st
em

3

3.3 Communications with a Touch Panel

113

3.3 Communications with a Touch Panel
When using Ethernet communications between the SERVOPACK and a touch panel from Schneider Electric, use
the extended MEMOBUS protocol as the communications protocol. The extended MEMOBUS protocol allows
the master to read and write the slave registers.
This section describes communications when the SERVOPACK acts as a slave.

3.3.1 Using Automatic Reception with the SERVOPACK as a Slave
This section describes how to communicate with a touch panel from Schneider Electric by using automatic
reception.

(1) Setting Example
The following figure illustrates how the contents of the MW00100 holding register in the SERVOPACK (slave)
is displayed on the touch panel, and written from the touch panel to the same register.

(2) Configuring the Module Configuration Definition
Use the following procedure to configure the module configuration definition.



3.3 Communications with a Touch Panel

114

1. Double-click [ ] for [Ethernet].

The Ethernet Detail Definition Window will be displayed.

2. Select the [Transmission Parameter] tab to specify the Equipment Name.

(1) Enter [Module name] displayed in the [Search Controller] on the [Communications Setting]
window.
Default value: Sigma-X

3. Select the [Connection Parameter] tab, and click the [Easy setting] button.

The Message Communication Easy Setting window will be displayed.
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4. Set the connection parameters.

(1) [Connect No.] is fixed to 1.
(2) Enter “10001” in the [Port No.] box for SERVOPACK.
(3) Select [Extended MEMOBUS] in the [Communication protocol Type] box, and then click the

[Default] button.
(4) Select [TCP] in the [Connect Type] box.
(5) Select [BIN] in the [Code] box.
(6) Enter the following address in the [Remote Station Port IPAddress] boxes for the other device:

“192.168.001.002”.
(7) Enter “10001” in the [Port No.] box for the other device.

5. Click the [OK] button.

6. Click the [Yes] button.

Note:
If parameters have already been set for the same connection number and you click the [Yes] button in the Transmission Parame-
ters Confirmation dialog box, the settings will be overwritten by the parameters that are set in the Message Communication Easy
Setting window.
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7. Check the settings and double-click the [Setting] button in the [Detail] column.

8. Check the content that was set. [Use Automatic Reception] is selected for the Message
Communications Method as a fixed value.
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9. Save the data to flash memory.
Note:
Changes made to the transmission or connection parameters will become effective only after the changes have been saved to
flash memory and the power has been cycled.

This concludes the settings for using the SERVOPACK as a slave.

(3) Setting Up the Touch Panel
Refer to the manual for your touch panel for how to set it up.

(a) Screen Creation Example
1. Create a base screen.

2. From the toolbar, select [Data Display] and place the object on the screen.

3. Double-click the [Data Display] placed on the screen.

4. Enter the following settings in the Data Display Dialog Box and click the [OK] button.

Display Data Numeric Display

Monitor Word Address GMW00100

• The following table shows the relationship between the address display in GP-Pro EX and registers
in the YRM1010.

Device Address Display in GP-Pro EX Registers in YRM1010

Coils as bits GMB□□□□□□ MB□□□□□□

Coils as words GMW□□□□□ MW□□□□□

Input relays as bits GIB□□□□□ IB□□□□□

Input relays as words GIW□□□□ IW□□□□

(4) Starting Communications
1. Turn ON the power to the SERVOPACK to start message reception.

The system will automatically start the message reception operation. No further operation is required.

2. Start the GP3000-series touch panel to display the main screen.
Communications with the SERVOPACK will start after the touch panel operating system starts.
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Note:
Contact Schneider Electric for further information.
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3.4 Checking, Editing, and Saving Parameters
You cannot use the SigmaWin+ AE to check, edit, or save servo parameters.
Use the SigmaWin+ Ver.7 to perform these operations.
Refer to the following section for operating details.

AC Servo Drive Engineering Tool SigmaWin+ Operation Manual (Manual No.: SIET S800001 34)
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3.5 Using an Absolute Encoder
To use an absolute encoder, you must first initialize it.

3.5.1 Initialize the Absolute Encoder
Use the SigmaWin+ Ver.7 to initialize the absolute encoder.

Function to Use Overview

Reset Absolute Encoder in the Sigma-
Win+ Ver.7

This function initializes the absolute encoder.
Refer to the following manual for details.
Refer to the following manual for how to use Reset Absolute Encoder.

AC Servo Drive Engineering Tool SigmaWin+ Operation Manual (Manual No.: SIET S800001 34)
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4
Programming

This chapter provides an overview of programming and describes operations related to programming.
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4.1 Ladder Program
This section provides an overview of ladder programming and describes operations that are required when creat-
ing a program.

4.1.1 What Is a Ladder Program?
A ladder program uses ladder language instructions and registers to symbolically represent electrical circuits con-
sisting of switches, timers, lamps, and other devices.

Ladder programming allows you to easily program large, complex circuits.
Each of the ladder programs that you create is executed in a single scan and then executed repeatedly at fixed
intervals.

(1) The Various Execution Timing of Ladder Drawings
Ladder programs are managed in units of drawings (DWG). These are called ladder drawings.
Ladder drawings are executed at various times, as illustrated in the following figure.
Processing can be executed at the appropriate time by programming it in the appropriate ladder drawing.
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The following table gives the execution timing for each drawing.

Ladder Drawings Priority Execution Timing (Processing Example)

DWG.A 1 (High) This drawing is executed only once when the power is turned ON (e.g., for
data initialization).

DWG.H 2（↑） This drawing is executed every high-speed scan cycle (e.g., for motion
control).

DWG.L 3 (Low) This drawing is executed every low-speed scan cycle (e.g., for touch panel dis-
play processing).

(2) Program Modules
The main program can be separated into modular units to suit different processing requirements, such as child
drawings, to make the program easier to read.

4.1.2 Window Configuration
This section describes the names and views for each window used in creating and editing ladder programs.
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(1) [Ladder] Window
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No. Name Contents

(1) Ladder Program Property

Click this button to display the [Ladder Display Property] window. Select the check boxes for the
items to display in the [Ladder] window and click [OK]. Columns for those selected items will be dis-
played in the [Ladder] window.

(2) Switch Hierarchy Display

Click this button to change the level of the ladder program drawing.

(3) Show/Hide Bookmarks

If bookmarks were added to the ladder program, you can click this button to display or hide the book-
marks in the [Ladder] window.
Refer to the following section for how to set bookmarks.

4.1.13 Setting Bookmarks on page 151
<When a Bookmark Is Displayed>

(4) Project File Name The name of the project file and model are displayed.

(5) Ladder Program

The created ladder programs are displayed.
The ladder programs are displayed by drawing. Refer to the following section for details on
drawings.

(1) The Various Execution Timing of Ladder Drawings on page 123

You can give the ladder programs a three level structure from level 1 to level 2.
The level 1 program is called the main program, and only one main program can be created for each
A, H, and L program.
The level 2 programs are referenced with the SEE instruction from the program on the level above.
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(2) Edit Ladder ProgramWindow

No. Name Contents

(1) Program Comment The program name that was set when the program was created is displayed. You can edit the program
comment.

(2) Rung Comment This comment is for the following rung. You can set multiple rung comments for a single rung.

(3) Rung A reference line on which objects, such as instructions and branches, are placed.

(4) Branch A branch line on which to place instructions in parallel. You can create other branches underneath the
branch.

(5) Input Guide Shows the input position of the object.

(6) Instruction Object The instruction name, registers, variable names, comment, and other information are displayed.

(7) END Instruction Shows the end of the program. You cannot edit the END instruction.

(8) Function Keys Functions to use when creating ladder programs are displayed as buttons. These buttons function the
same as the function keys on the keyboard.

(3) [Variable] Window
Refer to the following section for details on the [Variable] window.

4.2 Variable on page 165

(4) [Ladder Instruction] Window

The instructions to use in Edit Ladder Program Window are displayed on this window organized into categories.
Click the [+] button to expand the ladder instructions organized into that category.
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You can add an instruction to the ladder program by selecting the instruction in the [Ladder Instruction] window
and then dragging and dropping it on the Edit Ladder Program Window.

4.1.3 Creating a Drawing
You must create a drawing before creating a ladder program.
There are the following two methods that you can use to create a drawing.
• Creating from the [My Tool] window
• Creating from the [Ladder] Window

The procedures are given below.

(1) Creating from the [My Tool] Window
Use the following procedure to create a new drawing from the [My Tool] window.

1. Click the [Create New Ladder Program] button on the [My Tool] window.
The [Create New Program] window will be displayed.

2. Enter the program number and program name, and then click the [OK] button.

Information Refer to the following section for an example for the program number.
(3) Example for the Program Number on page 130

The new drawing will be displayed.
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This concludes the procedure.

(2) Creating from the [Ladder] Window
Use the following procedure to create a new drawing from the [Ladder] window.

1. Right-click the type of ladder program to create in the [Ladder] window, and select
[New].

Information Creating Child Drawings
Child drawings can be created only if a parent drawing exists.
Right-click the program (parent drawing) for which to create a child drawing.

The [Create New Program] window will be displayed.

2. Change the settings as required, and then click the [OK] button.

Information Refer to the following section for an example for the program number.
(3) Example for the Program Number on page 130
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The new drawing will be displayed.

This concludes the procedure.

(3) Example for the Program Number

No. Item Description

(1) Parent drawing type
• A: Startup drawing
• H: High-speed scan process drawing
• L: Low-speed scan process drawing

(2) Child drawing Setting range: 01 to 99
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4.1.4 Opening a Drawing
Use one of the following methods to open a created drawing.
• Click the [Open Ladder Program] button on the [My Tool] window.
The [Program Select] dialog box will be displayed. Click the drawing to open, and then click the [OK] button.

• Double-click the drawing to open on the [Ladder] window.

• Right-click the drawing to open on the [Ladder] window and select [Open].

4.1.5 Creating New Ladder Programs
This section describes the following five operations to create ladder programs.
• Inserting a rung
• Inserting an instruction
• Setting the variable, register, and comment
• Inserting a branch
• Editing a rung

(1) Inserting a Rung
Use one of the following methods to insert a rung.
• Right-click where rung is to be inserted, and select [Insert Rung].
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• Place the mouse cursor where the rung is to be inserted, and select [Insert Rung] from the [Program] menu.

• Place the mouse cursor where the rung is to be inserted, and press the Insert key.

(2) Inserting an Instruction
Use one of the following methods to insert an instruction.
• Enter a text string or double-click the location where the instruction is to be inserted, and select the instruction
you want to insert from the list of instructions that is displayed. (The autocomplete function is used.)

Refer to the following section for details on the autocomplete function.
4.1.16 Using the Autocomplete Function on page 155

• Right-click where the instruction is to be inserted, and select the desired instruction under [Insert Instruction].



Pr
og

ra
m
m
in
g

4

4.1 Ladder Program

133

• Drag the desired instruction from the [Ladder Instruction] window to where the instruction is to be inserted.

• Place the mouse cursor where the instruction is to be inserted, and select [Insert Instruction] followed by the
desired instruction from the [Program] menu.

Detailed procedures are given only for setting the Expression instruction. Refer to the following section for
details.

4.1.7 Easily Performing Numeric Operations in Ladder Programs on page 139

(3) Setting the Variable, Register, and Comment
After you insert the instruction, use one of the following methods to set the variable, register, and comment.
• If you drag a variable from the [Variable] window and drop it on an instruction, the variable will be set for that
instruction.



4.1 Ladder Program

134

• If you double-click or , the [Edit Parameter] window will be displayed, on
which you can set the variable or register and comment.

(4) Insert a branch
Use one of the following methods to insert a branch.
• Placing the same instruction parallel to the selected instruction
• Placing an arbitrary instruction in parallel

Information A branch can be inserted on the same rung only. You cannot create a branch that spans multiple rungs.

(a) Placing the Same Instruction Parallel to the Selected Instruction
1. Select the instruction object where the branch will be inserted.

2. Use one of the following methods to insert the object.
• Right-click the instruction object, and select [Insert Branch].
• Select [Insert Branch] from the [Program] menu.
• Press Ctrl + B.
A branch will be inserted parallel to the selected instruction object, and the same instruction will be
placed on that branch.

Information •Only one instruction can be placed on the branch with this operation.
•The data, such as variable names and addresses, is not copied to the instruction placed in parallel.
•Refer to the following section for how to set the comment and register of the inserted instruction.

(3) Setting the Variable, Register, and Comment on page 133
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(b) Placing an Arbitrary Instruction in Parallel
1. Select the instruction object where the branch will be inserted.

2. Use one of the following methods to insert the object.
• Right-click the instruction object, and select [Add Instruction and Branch] - [(Instruction Type)] -
[(Instruction)].

• Select [Add Instruction and Branch] - [(Instruction Type)] - [(Instruction)] from the [Program] menu.
• Drag and drop an instruction in the [Ladder Instruction] window to the instruction object in step 1.
A branch will be inserted parallel to the instruction object selected in step 1, and the instruction selected
in step 2 will be placed on that branch.

Information Refer to the following section for how to set the comment and register of the inserted instruction.
(3) Setting the Variable, Register, and Comment on page 133

(5) Editing a Branch
There are the following four methods that you can use to edit a branch.
• Pasting a branch
• Moving a branch by dragging
• Changing a branching point
• Deleting a branch

(a) Pasting a Branch
1. Click the branching point of the branch.

The branch edit mark ( ) will be displayed, and the branch to cut or copy will be displayed in blue.

2. Use one of the following methods to cut or copy the branch.
• Right-click the edit mark, and select [Cut] or [Copy].
• Select [Cut] or [Copy] from the [Edit] menu.
• Press Ctrl + X (Cut) or Ctrl + C (Copy).

3. Select the location to paste the branch.

4. Use one of the following methods to paste the branch.
• Right-click the edit mark, and select [Paste].
• Select [Paste] from the [Edit] menu.
• Press Ctrl + V.

This will insert the branch that was cut or copied at the location of the input guide.
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Information The branch can also be pasted on a rung on another ladder drawing.

(b) Moving a Branch by Dragging
1. Click the branching point of the branch.

The branch edit mark ( ) will be displayed, and the branch to move will be displayed in blue.

2. Drag the edit mark, and release the mouse point where the input guide is displayed at
the destination.

Information The branch can also be moved to a rung on another ladder drawing.

(c) Changing a Branching Point
1. Use one of the following methods to set Branch Edition Mode.

• Click the [Branch Edition Mode ] button on the toolbar.
• Select [Branch Edition Mode] from the [Program] menu.
The cursor will change to the branch edit cursor.

2. Drag the branching line and release the mouse at the new branching location.

3. Click the [Normal Edition Mode ] button on the toolbar. Branch Edition Mode will
end, and the cursor will return to normal.

(d) Deleting a Branch
1. Click the branching point of the branch.

The branch edit mark ( ) will be displayed, and the branch to delete will be displayed in blue.
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2. Use one of the following methods to delete the branch.
• Right-click the edit mark, and select [Delete].
• Select [Delete] from the [Edit] menu.
• Press the Delete key

4.1.6 Checking the Properties of a Ladder Program
You can check the properties (configuration, detail definition, and modification history) of a ladder program. Use
the following procedure.

1. In the [Ladder] window, right-click the ladder program file for which to view the
properties.

2. Select [Property].

The [Program Property] window will be displayed.

(1) Configuration Definition
You can set the file privileges and number of registers that are used here.
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Item Description

File privilege

The read privilege level and write privilege level for this program are displayed.
The program read privilege and write privilege levels are items created to maintain program security.
To open a program, that user must have a user privilege level that is greater than or equal to the read
privilege level of that program. In the same manner, to edit and save a program, that user must have a
user privilege level that is greater than or equal to the write privilege level of that program.
Refer to the following section for information on setting and checking the user privilege level.

7.1 User Management on page 300

Read

Select the read privilege level for this program from 0 to 7. A higher number is a higher privilege level.
You cannot enter a numeric value.
You cannot set a read privilege level that is higher than your own user privilege level. For example, if
your privilege level is 3, you cannot set the privilege level to 4 or higher.

Write
Select the write privilege level for this program from 0 to 7. A higher number is a higher privilege
level. You cannot enter a numeric value.
You cannot set a write privilege level that is higher than your own user privilege level.

Use register numbers The number of D registers, work registers, # registers, and first addresses for auto assign that are used
by this program are displayed.

D register Set the maximum number of D registers that are used by this program between 0 and 16384. You can
directly set a numeric value or use the spin buttons.

Work register The number of D registers used by the system as work registers is displayed. You cannot set this value.

# register Set the maximum number of # registers that are used by this program between 0 and 16384. You can
directly set a numeric value or use the spin buttons.

First Address for Auto Assign
Set the first address of the D registers that are automatically assigned to the Param operand when the
MLx instruction is inserted into the drawing.
The setting range is 0 to 16383.

(2) Detail Definition
You can check the number of program steps to execute and the date/time the program was last modified, set the
operation when performing real number casting, and display/set the subscript register limit check.

Item Description

No. of steps The number of steps that are being executed is displayed. This value cannot be changed.

Modified The date and time the program was last modified is displayed. If you compile the program, the date and
time will be updated. This value cannot be changed.

Continued on next page.
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Continued from previous page.

Item Description

Setting the operation when real
number You can set the operation when converting data from real numbers to integers.

Subscript register limit check
You can set the operation when using index registers.
Enable: Detects index errors.
Disable: Does not detect index errors.

(3) Modified History
You can check the modification history here.

Item Description

Modified history The modification history of the program is displayed up to a maximum of 10 entries.

4.1.7 Easily Performing Numeric Operations in Ladder Programs
When performing numerical operations in ladder programming, several extra rungs must be used to store interim
calculation results between numeric operations performed with instructions, such as ADD and SUB. With the
Expression instruction, you can easily perform complex operations by writing complex formulas inside a single
instruction. Use the following procedure.

1. Use one of the following methods to insert an Expression instruction.
• Right-click where the instruction is to be inserted, and select [Insert Instruction] - [CONTROL] -
[Expression:EXPRESSION].
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• Place the mouse cursor where the instruction is to be inserted, and enter “expr”.

• In the [Ladder Instruction] window, click the [+] button next to [CONTROL], and then drag the
[Expression] instruction to where the instruction is to be inserted.

2. Double-click the Expression instruction that was inserted.

The [Expression Editor] window will be displayed.
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3. Enter the arithmetic expression.

Refer to the following ladder programming manual for details on limitations on operators, instructions,
and functions that can be used inside an Expression instruction.

YRM1000/MPX1000 Series Ladder Program Programming Manual (Manual No.: SIEP C890101 10)

4. Hold down the Ctrl key and press the Enter key.
The [Expression Editor] window will close and the entered information will be displayed.

5. Use one of the following methods to compile the program.
• Press the F4 key.
• Select [Compile] from the [Compile] menu.

If the compilation is successful, the SERVOPACK will execute the Expression instruction and display
the current value below the formula.

If there is a comment for a register used in the formula, the register comment will be displayed above
the formula.

This concludes the procedure.



4.1 Ladder Program

142

4.1.8 Automatically Registering Address Registers as Variables
You can automatically register address registers as variables when you use instructions for which address regis-
ters are specified. If you register variables, detailed information on the parameters for the address registers will
be displayed in window, eliminating the need to look up information in manuals and other resource materials.
Use the following procedure. The COUNTER instruction is used as an example.

1. On the [Environment Setting] window, select [Ladder] - [General], and then set [Auto-
matically register address registers] to [Enable].
Refer to the following section for details on the [Environment Setting] window.

8.1 Environment Setting on page 325

2. On the Edit Ladder Program Window, insert the COUNTER instruction and enter the
address of the address register.

The [Variable Definition] window will be displayed.
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3. Set the following items, and then click the [OK] button.

Item Description

Variable

Enter a variable name.
The following name is displayed by default: Structure_□□□. The boxes are automatically replaced with a
number.
<Setting Conditions>
• 64 alphanumeric characters maximum.
• The first character is an alphabetic character.

Comment

Enter a comment. Carriage returns and line feeds cannot be used.
By default, the description of the ladder instruction that was inserted is entered.
<Setting Conditions>
255 characters maximum.

Structure Name
Select a structure.
Only structures that are related to the instruction that was inserted are displayed as candidates in the list.

The variable name and comment are displayed in the ladder program.

4. Right-click the address register for which you want to check detailed information, and
select [Add to Watch].

Detailed information on the selected address register will be displayed in the [Watch] window.
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This concludes the procedure.

4.1.9 Toggling the Display of Registers, Variables, and Comments
You can toggle whether to display or hide registers, variables, and comments in the Edit Ladder Program
Window.
<When a Register, Variable, and Comment Are Displayed>

<When a Register and Comment Are Displayed>

<When a Variable and Comment Are Displayed>

<When Only a Register Is Displayed>

<When Only a Variable Is Displayed>

Information Variables and registers cannot be hidden at the same time.

There are the following three methods that you can use to display or hide these elements.
• Using the buttons on the toolbar
• Using the shortcut keys
• Using the [Environment Setting] Window
The procedures are given below.
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(1) Using the Buttons on the Toolbar
• Toggle between displaying and hiding registers.

• Toggle between displaying and hiding variables.

• Toggle between displaying and hiding comments.

(2) Using the Shortcut Keys
• Displaying or hiding registers: Hold down the Ctrl key and press the F5 key.
• Displaying or hiding variables: Hold down the Ctrl key and press the F7 key.
• Displaying or hiding comments: Hold down the Ctrl key and press the F8 key.

(3) Using the [Environment Setting] Window
You can also toggle between displaying and hiding registers, variables, and comments on the [Environment Set-
ting] window.
Refer to the following section for details on the [Environment Setting] window.

8.1 Environment Setting on page 325
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4.1.10 Zooming the Display
Use the following procedure to zoom the Edit Ladder Program Tab Page.

1. Select [Zoom] from the [View] menu.

The [Ladder Magnification] window will be displayed.
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2. Set a value for [Magnification], and click the [OK] button.

The [Ladder Magnification] window will close, and the setting will be applied to the Edit Ladder Pro-
gram Window.

This concludes the procedure.

4.1.11 Creating a CP Ladder Drawing
There are the following two methods that you can use to create a CP ladder drawing that are compatible with
MPE720 Ver.5 or earlier versions of the engineering tool.
• Using the [Ladder] window
• Using the launcher
The procedures are given below.

(1) Using the [Ladder] window
Use the following procedure to create a new CP ladder drawing using the [Ladder] window.

1. On the [Environment Setting] window, set [Create new CP ladder] to [Use].
Refer to the following section for details on the [Environment Setting] window.

8.1 Environment Setting on page 325
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2. Right-click in the [Ladder] window, and select [New CP Ladder].

The [Create New Program] window will be displayed.

3. Click the [OK] button.

The Edit CP Ladder Window will be displayed inside the Engineering Manager Window.
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Refer to the following manual for details on the features and operating procedures of the Engineering
Manager.

Machine Controller MP900/MP2000 Series MPE720 Software for Programming Device User’s Manual (Manual No.: SIEP C880700 05)

This concludes the procedure.

(2) Using the launcher
Use the following procedure to create a new CP ladder drawing using the launcher.

1. Select [Utility] - [Engineering builder] from the launcher.

The [Engineering Builder] window will be displayed

2. Click the [New drawing] button.

The [Open DWG setting] window will be displayed.

3. Set [Name] and [Type], and then click the [OK] button.

The Edit CP Ladder Window will be displayed inside the Engineering Manager Window.



4.1 Ladder Program

150

Refer to the following manual for details on the features and operating procedures of the [Engineering
Manager].

Machine Controller MP900/MP2000 Series MPE720 Software for Programming Device User’s Manual (Manual No.: SIEP C880700 05)

This concludes the procedure.

4.1.12 Specifying the Data Type of the Operation Result of an Expression
Instruction
When you use the Expression instruction to perform a numeric operation in a ladder program, the result may not
be as intended because of differences in data types.
You can avoid producing unintended operation results by using the cast operator as follows:
• Convert the data type of the operand
• Convert the data type of the operation result
• Specify the data type of the entire arithmetic expression
Each method is described below.

(1) Converting the Data Type of the Operand
You can convert the data type of an operand by placing the cast operator in front of that operand.
<Example>
DL00010 = 14000 - ((WORD) DF00012 + 100))
In this example, floating point data in DF00012 is converted to integer data and then the calculation is
performed.

(2) Converting the Data Type of the Operation Result
You can convert the data type of an arithmetic expression by placing the cast operator in front of the arithmetic
expression.
<Example>
DL00010 = 14000 - LONG (DF00012 + 100))
In this example, the result of the operation (DF00012 + 100) is converted to a double-length integer.

(3) Specify the Data Type of the Entire Arithmetic Expression
You can specify the data type of the entire arithmetic expression by placing an arithmetic expression data type
operator in front of the arithmetic expression.
<Example>
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DW00010 = FTYPE (14000 - (DF00012 * 100 / 2))
In this example, the operation on the right side is calculated as if the values were all floating decimal data.

4.1.13 Setting Bookmarks
You can set bookmarks at the desired locations in ladder programs. Use the following procedure.

1. Right-click where the bookmark is to be inserted, and select [Insert Bookmark].

The [Bookmark Editor] window will be displayed.

2. Enter a name, and click the [OK] button.

The name of the inserted bookmark will be displayed in the program.
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Note:
The above screen capture shows the bookmark while it is being edited. For the bookmark to be recognized, the program must be
compiled.

3. Use one of the following methods to compile the program.
• Press the F4 key.
• Select [Compile] from the [Compile] menu.

The list of bookmarks will be displayed in the [Ladder] window.

This concludes the procedure.

4.1.14 Enabling and Disabling Ladder Programs by Drawings
You can enable or disable ladder programs by drawings when debugging or in other cases.
Use the following procedure.

1. Open the project file.

2. Right-click the program to enable or disable in the [Ladder] window, and select [Enable/
Disable].

Information You can select more than one drawing.
•To open a number of consecutive drawings: Select the first drawing in the group of drawings to open, hold
down the Shift key, and then select the last drawing in the group of drawings to open.
•To open a number of drawings that are not consecutive: Hold down the Ctrl key and click the drawings to
open.
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A message dialog box will be displayed.

3. Click the [Yes] button.

The drawing will be enabled or disabled.

4. Confirm that the icon for the drawing has changed in the [Ladder] window.

• Drawing is enabled:

• Drawing is disabled:
This concludes the procedure.

4.1.15 Shortcut Keys for Ladder Programming
The following tables list the shortcut keystrokes that are useful when creating ladder programs.

Information If your shortcut keys are assigned to "Ver.6 Compatible" in the [Environment Setting] window, they will not be the same
as the assignments that are described in this section.
Refer to the following manual for the shortcut key assignments for MPE720 Ver.6.

Engineering Tool for MP2000 Series Machine Controller MPE720 Version 6 User’s Manual (Manual No.: SIEP C880700 30)

(1) Function Keys
Function Key

Help F1

Edit F2

Compile F4

Input an NO Contact F5

Input an NC Contact F6

Input a Coil instruction F7

Input a Store instruction F8

Create a branch F9

Confirm branches F10

Cancel a branch F11

Input an NO Contact in parallel Shift + F5

Input an NC Contact in parallel Shift + F6

Input a Coil in parallel Shift + F7

Input an Expression instruction Shift + F8

Input a Rising Edge NO Contact Alt + F5

Input a Falling Edge NO Contact Alt + F7

Input a Rising Edge NC Contact Alt + F8

Input a Falling Edge NC Contact Alt + F9

Input a Rising Edge NO Contact in parallel Alt + Shift + F5

Continued on next page.
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Continued from previous page.

Function Key

Input a Falling Edge NO Contact in parallel Alt + Shift + F7

Input a Rising Edge NC Contact in parallel Alt + Shift + F8

Input a Falling Edge NC Contact in parallel Alt + Shift + F9

Exit Alt + F4

Switch windows Alt + F6

Switch tabs Ctrl + F6

(2) Edit
Function Key

Undo Ctrl + Z

Redo Ctrl + Y

Cut Ctrl + X

Copy Ctrl + C

Paste Ctrl + V

Delete Delete

Select all Ctrl + A

Search Ctrl + F

Replace Ctrl + H

(3) Programming
Function Key

Insert a rung Insert, Shift + Insert

Delete a rung Shift + Delete

Insert a rung comment Shift + Alt + Insert

Delete a rung comment Shift + Alt + Delete

Insert a branch Ctrl + B

Normal Edit Mode Ctrl + U

Branch Creation Mode Ctrl + I

Branch Edition Mode Ctrl + E

Edit an instruction comment Ctrl + Alt + Enter

Edit an instruction F2

Delete an instruction Ctrl + Delete

Edit parameters Ctrl + Enter

(4) Debugging
Function Key

Cross Reference Ctrl + R

Display register map Ctrl + W
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4.1.16 Using the Autocomplete Function
The autocomplete function displays candidates to aid entry when entering variables, registers and instructions.
The following shows how the autocomplete function is used.

(1) Enabling the Autocomplete Function
The autocomplete function is enabled by default. When the autocomplete function is disabled, enable the auto-
complete function by one of the following methods.
• Select [Display the Autocomplete list for variables and registers] from the [Edit] menu.

• Hold down the Ctrl key + Alt key + – key simultaneously.
• Click the [Turn Autocomplete for variables and registers ON/OFF] button on the toolbar.

• Click the [Turn Autocomplete for variables and registers ON/OFF] button in the [Expression Editor] window.

• Right-click on the [Expression Editor] window, and select [Display the Autocomplete list for variables and
registers].
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(2) Autocomplete Operating Procedure
If you enter a text string or double-click the location where the variable, register or instruction is to be inserted, a
list of entry candidates will be displayed. Select the desired entry item from the list of entry candidates either by
clicking the item or by pressing the Enter key with the item displayed in blue.
The following gives details on the autocomplete operating procedure.
• When a text string of two characters or longer is entered, candidates that match the start of the item or partially
match that text string will be displayed. When only one character is entered as the text string, all candidates
will be displayed.

• When a location is double-clicked, all candidates will be displayed.
• When a register address is entered, the 50 addresses preceding and following the entered register address will
be displayed as the list of candidates.
<Example>
When “SB000040” is entered, the 50 addresses preceding and following the entered register address (i.e,
SB00000E to SB000072) will be displayed as the list of candidates.

• In the case of a variable, if “.” is entered, a list of candidates at the lower level will be displayed.
<Example>
Variable name: Select CPU.

If “.” is entered, a list of candidates at the lower level of “Variable: CPU” will be displayed.

• The list can be made transparent by pressing the Ctrl key when the list of entry candidates is displayed. This
feature is convenient for checking parts that are hidden by the list.
<Example>
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4.1.17 Increasing the Number of Usable D Registers
D registers are local registers that are unique within each specific program. By default, there are 32 D registers.
The following procedure shows how to increase the number of D registers using motion programming as an
example.

1. In the [Ladder] window, right-click the program for which you want to increase the num-
ber of D registers, and select [Property].

The [Program Property] window will be displayed.

2. Set a value for [D register] under [Use register number], and then click the [OK] button.
The setting range is 0 to 16384.
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This concludes the procedure.

4.1.18 Copying or Moving Drawings

(1) Procedure
Use the following procedure to copy or move drawings.

Information •Drawings cannot be copied if you are using a direct connection. If the SigmaWin+ AE is online, set it offline.
• If you open two instances of the SigmaWin+ AE on the same PC, you can also copy or move drawings between differ-
ent project files.

1. Open the project file that contains the drawing to copy or move.

2. Right-click the drawing to copy or move in the [Ladder] window, and select [Copy] or
[Cut].

Information •You can also copy or move files by folder. Refer to the following section for details.
(2) Restrictions on Copying and Moving a Drawing on page 160

•This section shows the screenshots for the procedure to copy a drawing in the [Ladder] window and paste it
into the same project file.
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3. Right-click the destination program where the drawing will be pasted in the [Ladder]
window, and select [Paste].

The [Program Number Allocation] window will be displayed.

4. Select the [Object] check boxes for the drawings to copy or move, and click the [OK]
button.

Information •You can change [Target] and [Program Name] as necessary.
•The drawing may start being copied or moved without the [Program Number Allocation] window being dis-
played, depending on the selected drawing.
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If the program number is in use at the destination, a message dialog box will be displayed. Click the
appropriate button.

The selected drawings will be copied.

This concludes the procedure.

(2) Restrictions on Copying and Moving a Drawing
The restrictions on copying and moving a drawing are given below.
• You can copy and move a drawing only when offline.
• If [User Privilege] is set on the [User Registration] window, you can copy and move a drawing only when
logged in with a user that has those privileges or higher.

• You can copy and move a drawing only when "○" appears in the following table.

○: Can copy/move, ×: Cannot copy/move

Drawing Item Same Drawing Different Drawing

Ladder Copy single drawing
(parent drawing)

× ○

Copy single drawing
(other than parent
drawing)

○ ○

folder *1Copy × ○

Move single drawing
(parent drawing)

× ○

Move single drawing
(other than parent
drawing)

○ ○

folder *1Move × ○

*1 A folder is the upper level of the drawings. That means a folder is the named folders listed below.

– Ladder program: High-speed, Low-speed, Start, and Function
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4.1.19 Deleting Drawings
Use the following procedure to delete drawings.

1. Open the project file.

2. In the [Ladder] window, right-click the drawing to delete, and then select [Delete].

Information You can also select more than one drawing and delete them all.
•After you click the drawing, if you click another drawing while holding the Ctrl key, you can select multi-
ple drawings in the amount of clicked drawings.
•After you click the drawing, if you click another drawing while holding the Shift key, you can select all of
the drawings between the first and second drawings you clicked.

<If Only One Drawing Is Selected> <If More Than One Drawing Is Selected>

A message dialog box will be displayed.

3. Click the [Yes] button.

<If Only One Drawing Is Selected> <If More Than One Drawing Is Selected>

The drawing will be deleted.

This concludes the procedure.

4.1.20 Compiling Programs
Compiling programs is the process of verifying that the syntax of the created program is correct and creating the
internal data that can be executed by the SERVOPACK.

Information Compiling a program verifies if its syntax is correct, but it does not verify that the program operates as intended.
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(1) Compiling Programs
Use one of the following methods to compile the program.
• Click the [Compile] button on the toolbar.

• Select one of the following items on the [Compile] menu.

Type Description

Compile Compiles the selected program.

Compiles All Programs *1 Compiles all programs in the project that is currently open offline.

Compile Program Being Edited *1 Compiles multiple programs that were edited in the project that is currently open offline.

*1 Cannot be executed when online.

Select [Compile Option] from the [Compile] menu to display the [Compile Option] window. You can set the
following options in this window.

– [Enable to multiple coil check]: This option enables checks for multiple coils when compiling the program.
– [Compile to ver.5 compatible]: Cannot be used.

When the program is finished being compiled, the results will be displayed in the [Output] window.
If there is an error or warning, resolve the issue by referring to the information displayed in the window.

(2) Precautions for Compiling a Program
The precautions for compiling a program are given below.
• The following restrictions apply when you compile programs while connected to the SERVOPACK.
Program is being executed: You cannot compile programs.
Program is being debugged: You can compile a program while single block execution is stopped.

• Awarning message will be displayed if a program is compiled and any of the following instructions does not
receive an output from another instruction on the left side of it.

– On-Delay Timer (TON (1 ms))
– Off-Delay Timer (TOFF (1 ms))
– On-Delay Timer (TON (10 ms))
– Off-Delay Timer (TOFF (10 ms))
– On-Delay Timer (TON (1 s))
– Off-Delay Timer (TOFF (1 s))
– Rising-edge Pulses (ON-PLS)
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– Falling-edge Pulses (OFF-PLS)
– Coil (COIL)
– Reverse Coil (REV-COIL)
– Rising-edge Detection Coil (ON-PLS-COIL)
– Falling-edge Detection Coil (OFF-PLS-COIL)
– Set Coil (S-COIL)
– Reset Coil (R-COIL)

(3) Context Menu for the Compilation Results (I.e., [Output] Window)
The context menu displayed by right-clicking on the [Output] window is described below.

Item Description

[Copy] *1 Clicking this item copies the selected row of text.

[All Clear] Clicking this item clears the display in the [Output] window.

[Go to Error/Tag] Clicking this item displays the target program of the selected row. The program cursor will
be displayed at the target location.

[Output to File] Click this item to display the [Save As] window.
Specify the destination folder and file name for the data and click the [Save] button to output
the [Output] window contents to a file.

[Apply to Register Map] *1 Clicking this item adds the content to [Copy Register Settings] on the [Register Map] win-
dow as a new row.
The row that was automatically added based on the [Output] window results will be high-
lighted. Check the content, correct if necessary, and then click the [Save] button on the
[Register Map] window.

*1 You can select more than one row and perform an operation on those rows as a group.

• To select multiple continuous rows: Select the first row to select, hold down the Shift key, and then select the last row to select.
• To select multiple rows that are not continuous: Hold down the Ctrl key and individually click the rows to select.

4.1.21 Saving Programs While Editing
Use one of the following methods to save programs that are enabled for editing (while a compilation error
exists).

• Select [Save Project] from the [File] menu.
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• Hold down the Ctrl key and press the S key.
The following kinds of icons are displayed for programs that are saved while editing.
<Ladder Program>

Information If the SigmaWin+ AE is online, a program cannot be saved if it is enabled for editing. Make sure to save the programs
after compilation has been completed.
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4.2 Variable
This section provides an overview of variables and describes operations related to variables.

4.2.1 What Are Variables?
Variables are registers with labels (variable names) and comments.
The following tables list the types of variables.
• Variables That Are Automatically Assigned by the System
Users cannot add or delete the following variables.

Type Description

System Variable These variables are prepared by the system to represent the status of the SERVOPACK.

I/O Variable These variables are used as SERVOPACK I/O signals, the SERVOPACK's status, and to control the
SERVOPACK.

• Variables That Can Be Set by Users
Users can add, edit, and delete the following variables.

Type Description

Global Variable These variables can be shared between ladder programs, user functions.

Constant Variable These variables are set with a predetermined value by the user. These variables can be referenced in
programs only. The values cannot be changed.

Local Variable These variables are used within drawings. They cannot be used in other drawings.

You use variables in instructions inside programs and in various windows.
For example, you can use variables for the following types of operations. Refer to the following sections for
details.
• Ladder instruction input

(3) Setting the Variable, Register, and Comment on page 133
• [Search] window input

5.6 Search on page 224
• [Replace] window input

5.7 Replace on page 227
• [Cross Reference] window input

5.8 Cross Reference on page 230
• [Watch] window input

5.2 Watch on page 210

4.2.2 Window Configuration
Variables are displayed in the [Variable] window and the [Local Variable] window.
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No. Item Description

(1) [Local Variable] Window Displayed when the mouse cursor is placed on the [Local Variable] tab that is displayed
when a ladder program is opened.

4.2.3 Variables That Are Automatically Assigned by the System

(1) System Variable
System variables are system registers (S registers) that have been registered as variables. System variables are
preset in the SigmaWin+ AE.
Users cannot change settings related to system variables.

(2) I/O Variable
The I/O variables are variables to which I register and O register addresses have been automatically registered by
the system, and the allocations of these variables are fixed.
You cannot change the registers, but you can change the variable names and comments.

(a) Changing the Variable Name and Comment
Use the following procedure to change the variable name and comment of an I/O variable.

1. Right-click the variable name to edit, and select [Edit]. Or double-click the variable
name.
The [Variable Definition] window will be displayed.
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2. Set the items to change, and then click the [OK] button.

Item Description

Variable

Set the name of the I/O module.
<Setting Conditions>
• 16 alphanumeric characters maximum.
• The first character is an alphabetic character.
• Do not enter a space.

Comment Set a comment. Carriage returns and line feeds cannot be used.

The content in the [Variable] window will be changed. If the changed variable was entered in a pro-
gram, the variable name and comment in that program will also be changed.

This concludes the procedure.

4.2.4 Variables That Can Be Set by Users

(1) Global Variable
Global variables are displayed in the [Variable] window separated into different levels by data type.

(a) Registering a Global Variable
Use the following procedure to register a global variable.

1. In the [Variable] window, right-click [Global Variable] or a data type folder (Bit, Word,
Long, Quad, Float, Double, or Address), and then select [Add].
The [Variable Definition] window will be displayed.
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2. Set the following items, and then click the [OK] button.

Item Description

Variable

Set a variable name.
<Setting Conditions>
• 64 alphanumeric characters maximum.
• The first character is an alphabetic character.
• The following values are not valid:

– The same value as the register

– Avariable name that is already registered

Register

Set the register.
<Setting Conditions>
• The register must be within the range of registers. The list box displays the smallest address
out of the available registers.

• Address if a structure is registered.

Comment
Set a comment. Carriage returns and line feeds cannot be used.
<Setting Conditions>
255 characters maximum.

[Structure] Button

Displays the list of structures.
System structure: Sets of variables prepared in advance.
User structure: Sets of variables that can be registered by the user. Refer to the following sec-
tion for details.

(3) User-Defined Structures on page 172

[Option] Button Displays the [Environment Setting] window.

The [Variable Definition] window will close, and the registered variable will be displayed in the [Varia-
ble] window.
The registered variable name and comment will be displayed in the program that uses the register of
the registered variable.

This concludes the procedure.

(b) Editing a Global Variable
Use the following procedure to edit a global variable.

1. Right-click the global variable to edit in the [Variable] window, and select [Edit]. Or dou-
ble-click the global variable to edit.
The [Variable Definition] window will be displayed.
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2. Set the items to edit, and then click the [OK] button.
The [Variable Definition] window will close, and the changes will be applied to the variable in the [Var-
iable] window.

This concludes the procedure.

(c) Deleting a Global Variable
Use the following procedure to delete a global variable.

1. Right-click the global variable to delete in the [Variable] window, and select [Delete]. Or
select the global variable to delete, and press the Delete key.
A message dialog box will be displayed.

2. Click the [Yes] button.

Information When a comment is set for the variable to delete, the following message dialog box will be displayed. Click
the [Only Variable] button to delete the variable but leave the comment in the comment list.

The selected variable will be deleted from the [Variable] window.
The deleted variable will be replaced with the register when the program that used the deleted variable
is displayed next.

This concludes the procedure.

(2) Constant Variable
Constant variables are C registers that have been registered as variables.
After you register a range of C registers as a constant group, you can name that range of C registers and set the
constant value, unit (pulse, mm, deg, inch, and μm), and comment.

(a) Registering a Constant Group
Use the following procedure to register a constant group.

1. Right-click [Constant Variable] in the [Variable] window, and select [Add].
The [Constant Definition] window will be displayed.
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2. Set the following items, and then click the [OK] button.

Item Description

Variable
Set a variable name. The letters “C_” are automatically displayed at the beginning.
<Setting Conditions>
8 alphanumeric characters maximum.

Size of Use
Enter the number of word registers to use starting from the first address that is set in the [Register] field.
Click the [Search Empty Register] button to search for the number of available registers that is set in the
[Size of Use] box. The ending address will be entered automatically.

Register Enter the first word address of the C registers to register as the group.

Comment
Set a comment. Carriage returns and line feeds cannot be used.
<Setting Conditions>
255 alphanumeric characters maximum.

The [Constant Definition] window will close, and the registered variable group will be displayed in the
[Variable] window.

This concludes the procedure.

(b) Registering a Constant Variable
Use the following procedure to register a constant variable to a constant group.

1. Right-click the constant group to which the variable will be registered in the [Variable]
window, and select [Add].
The [Constant Variable Definition] window will be displayed.
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2. Set the following items, and then click the [OK] button.

Item Description

Variable

Set a variable name.
<Setting Conditions>
• 64 alphanumeric characters maximum.
• The first character is an alphabetic character.
• The following values are not valid:

– The same value as the register

– Avariable name that is already registered in the same group

Numerical Value

Enter the numerical value to store in the register.
<Setting Conditions>
The range of the numerical value that can be set depends on the data type of the register as shown below.
WORD: -32768 to 32767
LONG: -2147483648 to 2147483647
QUAD: -9223372036854775808 to 9223372036854775807
FLOAT: ±(1.175495 to 3.40283), 0
DOUBLE: ±(2.225E-308 to 1.798E+308), 0

Unit Directly enter the unit or select the unit from the list.

Register
Set the C register to register as the variable.
The list box displays the smallest address in the range of registers set in the group for each data type (W, L,
Q, F, and D).

Range
Set the upper and lower limits of the constant as required.
To set the range, click the [Set] button, enter the upper and lower limits of the constant in the window that is
displayed, and click the [OK] button.

Comment
Set a comment. Carriage returns and line feeds cannot be used.
<Setting Conditions>
255 alphanumeric characters maximum.

The [Constant Variable Definition] window will close, and the registered variable will be displayed in
the [Variable] window.

This concludes the procedure.
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(c) Editing a Constant Group or Constant Variable
Use the following procedure to edit a constant group or constant variable.

1. Right-click the constant group or constant variable to edit in the [Variable] window, and
select [Edit]. Or double-click the constant group or constant variable to edit.
The [Constant Definition] window or the [Constant Variable Definition] window will be displayed.

2. Set the items to edit, and then click the [OK] button.

Information If you change the range of registers in the [Constant Definition] window and variables exist outside the
range of registers in that group, the following message dialog box will be displayed. Click the [Yes] button
to delete the relevant variable.

The window will close, and the changes will be applied to the variable in the [Variable] window.

This concludes the procedure.

(d) Deleting a Constant Group or Constant Variable
Use the following procedure to delete a constant group or constant variable.

Information If a constant group is deleted, the variables that belong to that group will also be deleted.

1. Right-click the constant group or constant variable to delete in the [Variable] window,
and select [Delete]. Or select the the constant group or constant variable to delete, and
press the Delete key.
A message dialog box will be displayed.

2. Click the [Yes] button.
The selected constant group or constant variable will be deleted from the [Variable] window.
If the deleted variable was used in a program, the variable name will be replaced with the register when
the program is displayed.

This concludes the procedure.

(3) User-Defined Structures
User-defined structures are multiple variables, registers, and comments that have been registered as a set.
The registers that are registered in a user-defined structure are called "structure members". You can register up to
100 structure members for one user-defined structure.
User-defined structures are used by assigning them to address global variables and local variables.

(a) Registering a User-Defined Structure
Use the following procedure to register a user-defined structure.

1. Right-click [User structure] in the [Variable] window, and select [Add].
The [Structure Definition] window will be displayed.
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2. Enter values for [Structure] and [Comment], and click the [Add] button.

The [Add Structure Member] window will be displayed.

3. Set the following items, and then click the [OK] button.

Item Description

Member Name

Set the member name.
<Setting Conditions>
• 64 alphanumeric characters maximum.
• The first character is an alphabetic character.
• The following values are not valid:

– The same value as the register

– Avariable name that is already registered

Member Type Select the data type (Bit, Word, Long, Quad, Float, Double, or Address) from the list.

Continued on next page.



4.2 Variable

174

Continued from previous page.

Item Description

Offset Address Set the offset address.

Member
Comment

Set a comment. Carriage returns and line feeds cannot be used.
<Setting Conditions>
255 alphanumeric characters maximum.

You will return to the [Structure Definition] window.

4. Repeat steps 1 to 3 to add structure members.
The registered structure members will be displayed in the list.

Note:
If register addresses are duplicated:
If an address is a duplicate of the address of another structure member that is already registered in a single user-defined structure,
the lines of the duplicated structure members will be highlighted in pink.

Click the [OK] button and the following message dialog box will be displayed.

Click the [Yes] button to register the structure to add.



Pr
og

ra
m
m
in
g

4

4.2 Variable

175

Note:
If the same register exists in the structure:
If a member type (data type), address, and bit are duplicates of those of another structure member that is already registered in a
single user-defined structure, the lines of the duplicated structure members will be highlighted in pink.

Click the [OK] button and the following message dialog box will be displayed. Change one of the structure members.

5. Click the [OK] button in the [Structure Definition] window.
The [Structure Definition] window will close, and the registered user-defined structure will be dis-
played in the [Variable] window.

This concludes the procedure.

(b) Editing a User-Defined Structure
Use the following procedure to edit a user-defined structure.

1. Right-click the user-defined structure or structure member to edit in the [Variable] win-
dow, and select [Edit]. Or double-click the user-defined structure or structure member
to edit.
The [Structure Definition] window will be displayed.

2. Set the items to edit, and then click the [OK] button.
The window will close, and the changes will be applied to the user-defined structure in the [Variable]
window.
Note:
If the user-defined structure that was edited is already assigned to a global variable or local variable:
•Name of structure member was changed: Change is also applied to the variable.
•Comment of structure member was changed: Change is not applied to the variable. Apply the change manually.
• Structure member was deleted: Structure member is deleted from the variable.

This concludes the procedure.

(c) Deleting a User-Defined Structure
Use the following procedure to delete a user-defined structure.

1. Right-click the user-defined structure to delete in the [Variable] window, and select
[Delete]. Or select the user-defined structure to delete, and press the Delete key.
A message dialog box will be displayed.

2. Click the [Yes] button.
The selected user-defined structure will be deleted from the [Variable] window.
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Information If the deleted user-defined structure was assigned to a variable, the user-defined structure under that variable
will be inactivated and not deleted.

This concludes the procedure.

(4) Local Variable
Local variables are D registers that have been registered as variables.
Local variables are registered in each individual ladder program, and they can be used in that program only.

(a) Registering a Local Variable
Use the following procedure to register a local variable.

Information Even if you register D registers as variables, you can use only the number of D registers that was set in the [Program
Property] window when the variables are used in a program.
Refer to the following section for how to increase the number of D registers that can be used.

4.1.17 Increasing the Number of Usable D Registers on page 157
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1. With the ladder program open, place the mouse cursor on the [Local Variable] tab to dis-
play the [Local Variable] window.

2. Right-click [Internal Variable], and select [Add].
The [Variable Definition] window will be displayed.

3. Set the following items, and then click the [OK] button.

Item Description

Variable

Set a variable name.
<Setting Conditions>
• 60 alphanumeric characters maximum (64 characters when "VAR_" is added to the begin-
ning of the variable name).

• The following values are not valid:

– Avariable name that is already registered in the same program

Register

Enter the register to register as the variable.
The list box displays the smallest address in the range of available D registers for each data
type.
You can also register the same address if the data type is different (e.g., DB00000 and
DW00000). However, when registering the variable, a message will be displayed warning you
of the risk of malfunction.

Comment
Set a comment. Carriage returns and line feeds cannot be used when entering comments.
<Setting Conditions>
255 alphanumeric characters maximum.

Continued on next page.
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Continued from previous page.

Item Description

[Structure] Button

Displays the list of structures.
System structure: Sets of variables prepared in advance.
User structure: Sets of variables that can be registered by the user. Refer to the following sec-
tion for details.

(3) User-Defined Structures on page 172

[Option] Button Displays the [Environment Setting] window.

The [Variable Definition] window will close, and the registered variable will be displayed in the [Local
Variable] window.

Information "VAR_" will be displayed at the beginning of the variable name to show it is a local variable.

This concludes the procedure.

(b) Editing a Local Variable
Use the following procedure to edit a local variable.

1. Open the ladder program in which the variable to edit was set.

2. Right-click the variable to edit in the [Local Variable] window, and select [Edit]. Or dou-
ble-click the variable.
The [Variable Definition] window will be displayed.

3. Set the items to edit, and then click the [OK] button.
The window will close, and the changes will be applied to the variable in the [Local Variable] window.

This concludes the procedure.

(c) Deleting a Local Variable
Use the following procedure to delete a local variable.

1. Open the ladder program in which the variable to delete was set.

2. Right-click the variable to delete in the [Local Variable] window, and select [Delete]. Or
press the Delete key when the variable is selected.
A message dialog box will be displayed.

3. Click the [Yes] button.
The selected variable will be deleted from the [Local Variable] window.

This concludes the procedure.

4.2.5 Operations on the [Variable] Window

(1) Manipulating Global Variables and Local Variables as Groups
You can group global variables and local variables and name the groups to manipulate them and manage them as
groups. Use the following procedure.
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(a) Creating a Variable Group
1. Right-click any location under [Global Variable], and select [Add to Group].

The [Group registration of variables] window will be displayed.

2. Set the group name and range of registers, and then click the [OK] button.

The variables in the specified range of registers will be grouped and the group will be displayed.
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This concludes the procedure.

(b) Deleting a Variable Group
1. Right-click the global variable group to delete, and select [Delete].

A message dialog box will be displayed.

2. Click the [Yes] button.
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The variables will be ungrouped.

This concludes the procedure.

(2) Manipulating Multiple Variables at the Same Time
You can manipulate more than one system variable or user variable at the same time. Use the following
procedure.

1. Select the variables to manipulate together in the [Variable] window.
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2. Right-click on the [Variable] window, and select the command to use.

<System Variables> <User Variables>

Item Description

Delete
Deletes the selected variable.
This command is disabled when a system variable is selected.

Add to Watch Registers the selected variables for a watch.

Add to Scope Registers the selected variables for a scope.

This concludes the procedure.

(3) Comparing Constant Variable Setting Values with Current Values in C
Registers
Normally, the setting values registered to constant variables are the same as the current values in C registers.
However, these values sometimes differ for some reason. When you use this function, the setting values regis-
tered to constant variables are compared with the current values in C registers, and, if the values do not match,
the current values in C registers are automatically corrected to the same values as the setting values registered to
constant variables.
To compare the setting values of constant variables with the current values in C registers, right-click on [Constant
Variable] in the [Variable] window, and select [Constant Variable Check].
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4.2.6 Comment List

(1) Displaying the Comment List
You can browse and edit the comments registered for registers in the comment list. This section describes the
procedure to display the comment list.

Double-click [Comment List] in the [Variable] window or the [Local Variable] window.
Information The [Local Variable] window is displayed when the mouse cursor is placed on the [Local Variable] tab that is dis-

played when a ladder program is opened.

The [Comment List] tab page will be displayed.

This concludes the procedure.



4.2 Variable

184

(2) [Comment List] Tab Page

No. Item Description

(1) Register List
The list of registers is displayed.
Double-click a register type to apply that register type to the register address (first character) in
[Register].

(2) Register Select the first register of the registers to display in the comment list.

(3) Program Select the program to reference when the selected register type is a local register (D, #, X, Y, Z or
A).

(4) Data Type
The data type buttons are displayed.
Click a button to apply that data type to the register address (second character) in [Register].

(5) [Display/Hide Register
Map] Button When this button is enabled, the cells in the comment list are given colors. *1

(6) Display Mode

Select one of the following items and click the [View] button to update the contents of the comment
list.
• Select the registers to display from "All Register", "Registers used", or "Registers used (Also
displays registers other than first register in color)".

• Select the comments to display from "Standard Comment", "Extended Comment 1", "Extended
Comment 2", "Extended Comment 3", or "All Comments".

(7) [Save] Button Saves the content that was set.

(8) Comment List You can browse and edit the comments.

*1 The color of the cell indicates the status of the register.

Color Meaning

Light
green

Address registers or registers that specify the number of transfer data with constants for specific instructions (SETW,
MOVW, XCHG, and COPYW)

Red Registers that use the same memory address as other registers

Green Registers used in ladder programming

Yel-
low

Registers that are used as the starting addresses for indexing (i or j) or registers that are used for specific instructions
(SETW, MOVW, XCHG, and COPYW) for indirect addressing of the number of words to transfer.
Note:
An unspecified range of registers may be used after these registers.

(3) Editing the Comment List
Double-click a comment in the comment list to edit it.
You can also right-click a comment in the comment list and edit it from the displayed menu.
After you edit the comment, it will be updated in all programs and windows that use the relevant registers.
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Item Description

Cut

Cut, copy, paste, and delete the comments in the selected comment cells.
Copy

Paste

Delete

Comment All Clear Clears all comments that are currently displayed. Use caution because you cannot restore the comments
after they have been cleared.

Search Searches the comments that are currently displayed.

Replace Replaces the comments that are currently displayed.

Cross Reference

A cross reference for the register of the selected comment will be executed, and the results will be dis-
played in the [Cross Reference] window.
Refer to the following section for details on the cross reference.

5.8 Cross Reference on page 230

Add to Watch Add the register of the selected comment to the [Watch] window.

Import Import and export comments.
Refer to the following section for details.

8.3 Export/Import on page 347Export

(4) Saving a Comment
You can save a comment changed in the SigmaWin+ AE by selecting [Save Project] or [Save as a New Project]
from the [File] menu. You can also save variable comments in the same manner.
The following table shows the read source and write destination of comment data according to the connection
status by register.

Important

If there are differences in the registers between the read source project file and the write destination project file + SERVO-
PACK in a project link connection, data may be erased because the read source data will overwrite the write destination
data.
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Connection Status Register Read Source Write Destination

Offline

S/I, O Fixed by system Cannot be written.

M, I, O, G Project file Project file

C Project file Project file

D, #, X, Y, Z, A Programs in project file Programs in project file

Project Link
Connection

S/I, O Fixed by system Cannot be written.

M, I, O, G Project file
Project file
＋
SERVOPACK

C SERVOPACK SERVOPACK

D, #, X, Y, Z, A Programs in SERVOPACK Programs in SERVOPACK

Direct Connection

S/I, O Fixed by system Cannot be written.

M, I, O, G SERVOPACK SERVOPACK

C SERVOPACK SERVOPACK

D, #, X, Y, Z, A Programs in SERVOPACK Programs in SERVOPACK
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4.3 Data Management
This section describes operations related to the various types of data management required in programming.

4.3.1 Cam Tool Data
Cam tool data is data that is used in the Electronic Cam Tool and managed in the SigmaWin+ AE.
This section describes the operations to create, import, edit, and delete cam tool data from the SigmaWin+ AE.
Refer to the following manual for how to use the Electronic Cam Tool.

Machine Controller MP900/MP2000 Series Electronic Cam Data Preparation Tool Operation Manual (Manual No.: SIEP C880700 18)

(1) Creating Cam Tool Data
Use the following procedure to create cam tool data.

1. In the [System] window, right-click [Cam Tool Data] and select [Add new].

The [Add Cam Tool Data] window will be displayed.

2. Enter the cam tool data name, and click the [OK] button.

The Electronic Cam Tool will start, and the [Set Style] window will be displayed.

3. Create and save the cam tool data using the Electronic Cam Tool.
When you return to the SigmaWin+ AE, the [Cam Tool Data - Select Data Type] window will be
displayed.
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4. Select the data type, and then click the [OK] button.

The created cam tool data will be displayed in the [System] window.

This concludes the procedure.

(2) Importing Cam Tool Data
Use the following procedure to import cam tool data that was saved on the PC into the SigmaWin+ AE.

1. Establish an online connection to the SERVOPACK or open a project file.

2. In the [System] window, right-click [Cam Tool Data] and select [Import].

The [Add Cam Tool Data] window will be displayed.

3. Enter the cam tool data name and comment, and click the [OK] button.

The [File Open] window will be displayed.
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4. Select the cam tool data file to import, and then click the [Open] button.

5. Select the data type, and then click the [OK] button.

The imported cam tool data will be displayed in the [System] window.

This concludes the procedure.

(3) Editing Cam Tool Data
Use the following procedure to edit cam tool data.

1. In the [System] window, right-click the cam tool data to edit and select [Edit].
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The Electronic Cam Tool will start, and graph of the data will be displayed.

2. Edit the cam tool data using the Electronic Cam Tool.

This concludes the procedure.

(4) Deleting Cam Tool Data
Use the following procedure to delete cam tool data.

1. In the [System] window, right-click the cam tool data to delete and select [Delete].

A message dialog box will be displayed.

2. Click the [Yes] button.

This concludes the procedure.

4.3.2 Table Data
Table data is data in tabular form (arrays) that is used in the main program of a ladder program.
This section describes the operations to create, edit, delete, export, and import table data using the SigmaWin+
AE.

(1) Creating Table Data
Use the following procedure to create table data.
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1. In the [System] window, right-click [Table Data] and select [New].

The [New] window will be displayed.

2. Set the following items, and then click the [OK] button.

Item Description

Table Data Name

Set the name of the table data.
<Setting Conditions>
• 8 characters maximum.
• The first character is an alphabetic character or "$".
• The second character and subsequent characters are alphabetic characters, numbers, "-", or "_".
• Do not enter a space.
• Do not enter the following characters that correspond to system reserved words in the Engineering
Manager.
COM1, COM2, COM3, COM4, PRN, NUL, LPT1, LPT2, LPT3, LPT4, LPT5, LPT6, LPT7,
LPT8, LPT9, AUX, CLOCK$, CON, USERENV

Note:
If you enter a lowercase character, it will be automatically converted to uppercase.

Table Type

Select the table type.
• Array type (rows and columns type): A table in which all columns have the same column name
and data type.

• Record type (list of columns type): A table in which the column name and data type are set for
each column.

No. of Columns Set the number of columns in the table. The maximum number of columns is 32,767.

No. of Rows Set the number of rows in the table. The maximum number of rows is 65,535.

Store Target Cannot be used.

Table Comment Set a comment related to the table.

The [Table Data] window will be displayed.
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3. Set the following items.

Item Description

Column Name
Set the column name.
<Setting Conditions>
8 characters maximum.

Data Type
Double-click the cell and select one of the following data types.
Integer, double-length integer, quadruple-length integer, real number, double-precision real number,
or text string

Size
The size of the column is displayed.
If the data type is set to text string, you can enter a value between 1 and 80.

Display Type
The display type is displayed according to the data type.
If you selected integer, double-length integer, or quadruple-length integer for the data type, you can
double-click the cell and select binary, decimal, or hexadecimal.

Column Comment Set a comment related to the column.

4. Click the [ ] button.

This concludes the procedure.

(2) Editing Table Data
Two modes are available for editing table data on the [Table Data] window: Edit Column Attributes Mode allows
you to edit the column attributes and Edit Table Data Mode allows you to edit the table data.

(a) Window Description

�� Edit Column Attributes Mode
This mode is used to edit the column attributes.
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No. Item Description

(1) [ ] (Pin) Button

Use this button to lock the display of the column attributes area.

: Not pinned.

: Pinned.
When pinned, you can edit both the column attributes area and the table data area.
The pinned state is canceled when the [Table Data] window is closed.

(2) Column Attributes Area

This area is used to edit the column attributes (column name, data type, size, display type, and col-
umn comment).
If the table type is array type (rows and columns type), all of the column attributes are the same.
If the table type is record type (list of columns type), a different attribute can be set for each column.

(3) Table Data Area This area is used to edit the contents of the table data, as well as to add and delete rows and columns.

�� Edit Table Data Mode
This mode is used to edit the table data.

No. Item Description

(1) Table Data The table data name is displayed.

(2) Data Type The data type is displayed.

(b) Switching the Edit Modes

�� Edit Column Attributes Mode → Edit Table Data Mode
Double-click inside the colored frame on the following window to switch to Edit Table Data Mode.

�� Edit Table Data Mode → Edit Column Attributes Mode
Double-click inside the colored frame on the following window to switch to Edit Column Attributes Mode.
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(c) Editing Column Attributes
Use the following procedure to edit column attributes.

1. In the [System] window, right-click the table data to edit and select [Edit Column
Attributes].

The [Table Data] window will be displayed in Edit Column Attributes Mode.

2. Change the column attributes as required, and then click the [ ] button.

This concludes the procedure.

(d) Editing Table Data
Use the following procedure to edit table data.
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1. In the [System] window, right-click the table data to edit and select [Edit Table Data].

The [Table Data] window will be displayed in Edit Table Data Mode.

2. Change the table data as required, and then click the [ ] button.
Refer to the following section for details on inserting and deleting columns and rows.
� Inserting a Row or Column on page 195
� Deleting a Row or Column on page 196

Information You can also use the following procedure to edit table data.
1. Double-click the table data.
2. Click the pin.
3. Edit the table data in the edit table data area.

This concludes the procedure.

�� Inserting a Row or Column
Use the following procedure to insert a row or column into the table data.

1. Right-click anywhere in the colored box, and select [Insert].

The [Insert] window will be displayed.

2. Select [Insert Row] or [Insert Column], and click the [OK] button.
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This concludes the procedure.

�� Deleting a Row or Column
Use the following procedure to delete a row or column from the table data.

1. Right-click anywhere in the colored box, and select [Delete].

The [Delete] window will be displayed.

2. Select [Delete Row] or [Delete Column], and click the [OK] button.

This concludes the procedure.

(3) Changing the Properties of Table Data
Use the following procedure to change the properties of table data.

1. In the [System] window, right-click the table data to change and select [Properties].

The [Properties] window will be displayed.
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2. Change the properties as required, and then click the [OK] button.
Note:
You cannot change the number of columns or the number of rows.

This concludes the procedure.

(4) Copying Table Data
Use the following procedure to copy existing table data.

1. In the [System] window, right-click the table data to copy and select [Copy Table Data].
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2. In the [System] window, right-click [Table Data] and select [Paste Table Data].

The [Paste Table Data] window will be displayed.

3. Enter the new table data name, and click the [OK] button. The table comment is
optional.

This concludes the procedure.

(5) Deleting Table Data
Use the following procedure to delete table data.

1. In the [System] window, right-click the table data to delete and select [Delete].

A message dialog box will be displayed.

2. Click the [Yes] button.

This concludes the procedure.



Pr
og

ra
m
m
in
g

4

4.3 Data Management

199

(6) Exporting and Importing Table Data
Use the following procedures to export and import table data.

(a) Export

Important

You cannot export table data when in online mode.

Use the following procedure to export table data.

�� Exporting One Set of Table Data
1. Open the project file.

2. In the [System] window, right-click the table data to export and select [Export Table
Data].

3. Set the saving location and file name, and click the [Save] button.

The [Export Status] window will be displayed.
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4. Click the [OK] button.

This concludes the procedure.

�� Exporting Multiple Sets of Table Data
1. In the [System] window, right-click [Table Data] and select [Batch Export Table Data].

The [Browse For Folder] window will be displayed.

2. Select the saving location, and click the [OK] button.

The [Export] window will be displayed.
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3. Select the table data to export, and click the [Export] button.

The data will be exported, and the results will be displayed in the [Output] window.

This concludes the procedure.

(b) Import

Important

•You cannot import table data when in online mode.
•When importing multiple sets of table data, you can import the table data only when there is table data with the same name
as the file name to import inside the project file.

Use the following procedure to import table data.

�� Importing One Set of Table Data
1. Open the project file.
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2. In the [System] window, right-click the destination table data and select [Import Table
Data].

The [Open] window will be displayed.

3. Select the CSV file to import, and click the [Open] button.

The [Confirm Import] window will be displayed.

4. Check the destination table data name and the file name to import, and click the [Yes]
button.
Note:
You can import the table data even if the table data name and file name are different.
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The [Import Status] window will be displayed.

5. Click the [OK] button.

This concludes the procedure.

�� Importing Multiple Sets of Table Data
1. In the [System] window, right-click [Table Data] and select [Batch Import Table Data].

The [Browse For Folder] window will be displayed.
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2. Select the saving location of the files to import, and click the [OK] button.

The [Import] window will be displayed.

3. Select the table data to import, and click the [Import] button.

The data will be imported, and the results will be displayed in the [Output] window.

This concludes the procedure.
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5
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5.1 Register List
Register lists allow you to monitor the current values of the registers in a continuous area (register map). Real-
time monitoring and editing of values is possible if the SERVOPACK is connected.

Information • If you use a project link connection, the displayed results do not always match the project file because the data in the
SERVOPACK is displayed.
If you display the register map when using a project link connection, first always transfer the SERVOPACK data to the
project file.
•The register list can display S, I, O, M, C, D, and G registers. However, C registers are read-only. They cannot be
edited.

5.1.1 [Register List] Window
Information The displayed items and other elements will depend on the connection status.

No. Item Description

(1) Register Enter the address of the register for which to display a register map.

(2) Program Number For a D register, enter the program number.

(3) Number of Registers Displayed in One
Row

Enter the number of registers to display on one row of the register list, or select the
value from the list.
• Bit registers: Fixed to 16.
• Other registers: You can set the number between 1 and 16. If you select [Auto], the
number of displayed registers will be set automatically based on the width of the
[Register List] window.

(4) [Monitor] Button

This button is enabled only in online mode. Click this button to switch between moni-

toring ON ( ) and monitoring OFF ( ).
When monitoring is ON, the displayed register values are updated. When monitoring
is OFF, the displayed register values are not updated.

(5) / Button

Click this button to display ( ) and hide ( ) the register map.
When the register map is displayed, registers that are used in the ladder program are
displayed with a green background, and registers that are used for more than one data
type are displayed with a red background.

(6) Button Refreshes the values in the register map.

(7) / Button

Searches for redundant registers. The [ ] button searches for redundant registers

upward, and the [ ] button searches downward. Redundant registers are displayed
in blue cells.

(8) Balloon Window If you place the cursor over the register map, a balloon will show the register and the
status at the cursor position.
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Information Interpreting the Register List

No. Color Meaning

(1) Light green Address registers or registers that specify the number of transfer data with constants for specific
instructions (SETW, MOVW, XCHG, and COPYW)

(2) Red Registers that use the same memory address as other registers

(3) Green Registers used in ladder programming

(4) Yellow

Registers that are used as the starting addresses for indexing (i or j) or registers that are used for
specific instructions (SETW, MOVW, XCHG, and COPYW) for indirect addressing of the number
of words to transfer.
Note:
An unspecified range of registers may be used after these registers.

5.1.2 Displaying a Register Map
Use the following procedure to display a register map.

1. Select [Monitor] − [Register List] from the launcher.

The [Register List] window will be displayed.
Note:
Up to three [Register List] windows can be displayed. The window displayed with the method above is the [Register List 1] win-
dow. To open the [Register List 2] and [Register List 3] windows, select [Register List] from the [View] menu.
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2. Enter the address of the register for which to display a register map in [Register]. For a
D register, also enter the program number.

Information You can also display the register map by opening the program, selecting a register, and clicking [Debug] -
[Display Register Map] from the menu.

3. Press the Enter key.
The specified register will be displayed in the top row of the register map.

Information Right-click on the register map and select [Decimal], [Hexadecimal], [BIN], [ASCII], or [ON/OFF] to switch
the display format of the register value.
<Decimal View>

<Hexadecimal View>

5.1.3 Editing a Register Map
You can perform the following editing operations by double-clicking cells on the register map or by pressing the
F2 key to display the text cursor.
• Directly entering values
• Deleting values (setting values to 0)
• Copying and pasting data
Press the Enter key to confirm the change. If the SERVOPACK is online, any changes in the values immediately
affect the operation of the SERVOPACK.
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5.2 Watch
The Watch function allows you to monitor the values and comments of the specified registers. Realtime monitor-
ing and editing of values is possible if the SERVOPACK is connected.

Information •When a project link connection is used, the data registered in the [Watch] window and [AutoWatch] window is saved
only to the SERVOPACK. To apply the watch data to the project file, transfer the data from the SERVOPACK.
•The Watch function can display S, I, O, M, C, D, and G registers. However, C registers are read-only. They cannot be
edited.

5.2.1 Displaying Watch Data
There are the following two methods that you can use to display watch data.
• [Watch] window: Allows you to monitor the values in registers with different data types.
• [AutoWatch] window: Allows you to monitor the values of registers just by selecting an instruction in a ladder
program.

The procedures are given below.

(1) Displaying Data with the [Watch] Window
1. Select [Monitor] − [Watch] from the launcher.

The [Watch] window will be displayed.
Note:
Up to three [Watch] windows can be displayed. The window displayed with the method above is the [Watch 1] window. To open
the [Watch 2] and [Watch 3] windows, select [Watch] from the [View] menu.

2. Use one of the following methods to enter a register or variable name to display as
watch data.
• Double-click the [Variable] column or press F2 to display the text cursor, and then enter the register
or variable name.
Note:
For D registers, enter the program number as shown below.
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• Drag and drop a ladder program instruction to the [Watch] window.
• Drag and drop a variable in the [Variable] window to the [Watch] window.

3. Press the Enter key.
The values and comments of the specified registers will be displayed.

Information •Right-click on the [Watch] window and select [Decimal], [Hexadecimal], [BIN], [ASCII], or [ON/OFF] to
switch the display format of the register value.
You can set the display format for each individual register.

•You can change the order of the registers displayed in the [Watch] window by dragging and dropping them.

•You can also lock the [Watch] window so that the position of the displayed registers cannot be changed.
Right-click on the [Watch] window and select [Lock Displayed Positions of Registers]. The positions of the
displayed registers will be locked and "Displayed Positions of Registers Locked" will be displayed in the
title of the [Watch] window.

(2) Displaying Data with the [AutoWatch] Window
1. Use one of the following methods to open the [AutoWatch] window.

• If the window is already open, select the [AutoWatch] tab.
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• If the window is not open, select [AutoWatch] from the [View] menu.
2. Select the instruction that includes the registers to display as watch data.

The values and comments of the registers included in the specified instruction will be displayed.
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Information Right-click on a register and select [Decimal], [Hexadecimal], [BIN], [ASCII], or [ON/OFF] to switch the
display format of the register value.
You can set the display format for each individual register.

5.2.2 Editing Watch Data Values
You can perform the following editing operations by double-clicking a cell in the [Watch] window or the [Auto-
Watch] window or by press the F2 key to display the text cursor.
• Directly entering values
• Deleting values (setting values to 0)
• Copying and pasting
Press the Enter key to confirm the change. If the SERVOPACK is online, any changes in the values immediately
affect the operation of the SERVOPACK.
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5.3 Displaying Current Values
You can display the current values of registers in the Edit Ladder Program Window.

5.3.1 Online Current Values
You can monitor the status of registers in the Edit Ladder Program Window when there is an online connection
to the SERVOPACK. The status of registers is displayed as described below.
• Instruction objects are displayed with the current values of registers in blue.
• Instructions for contacts, coils, and so on are highlighted when the value of the register is 1.
• IF and ELSE instructions are highlighted when the condition is satisfied.

Important

If "!=" is used in the expression for an EXPRESSION instruction, the operand on the right side may display an inverted
value. In this case, be aware that following types of inconsistencies will occur in online current values because 1 will be dis-
played when 0 should be displayed.

5.3.2 Offline Current Values
Select [Monitor Offline Value] from the [View] menu when the SERVOPACK is not connected. The register val-
ues are displayed in blue in the Edit Ladder Program Window.

Information •The current value cannot be displayed when offline for IF, ELSE, WHILE, and EXPRESSION instructions.
•When register data is transferred from the SERVOPACK, the register data that was read will be displayed.
• If you changed a register value in a register list or by another means, the data for the relevant register will be updated,
but the simulation will not be run (e.g., writing will not be performed by programming conditions being satisfied). For
this reason, the data in other registers will not be updated.
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5.4 Tuning Panel
The Tuning Panel allows you to check the operation of a created program by adding registers and displaying and
editing current values.

5.4.1 [Tuning Panel] Tab Page
Click the [Tuning Panel] button in the [My Tool] window to display the [Tuning Panel] tab page.
The items displayed in the [Tuning Panel] tab page are described below.

Item Description

Variable The variable names or registers are displayed.

Comment

The comment registered for the registers is displayed.
If a comment is edited in the [Tuning Panel] tab page, the change will be applied to the variable in the [Variable]
window and the comment list.
<Setting Conditions>
255 alphanumeric characters maximum.

Name *1
Set a name, for example, when you want to identify the purpose of the variable.
<Setting Conditions>
48 alphanumeric characters maximum.

View definition *1

Set the display format of the value.
• "X" indicates the number of digits to display.
• "." indicates the position of the decimal point.
• "U" at the beginning indicates an unsigned decimal number.
• "X" at the beginning indicates a hexadecimal number.
Note:
If the upper/lower limits must be changed because this setting was changed, the following message dialog box will
be displayed.

Current value
The current value of the register is displayed.
The current value is updated at fixed intervals.
The current value can be edited by double-clicking this column to display the [Edit] window.

Unit
The unit is displayed.
The unit can be specified by double-clicking this column to display the [Edit] window.

Continued on next page.
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Continued from previous page.

Item Description

Lower limit/Upper
limit

The lower limit and upper limit of the normal range is displayed.
The value can be set by double-clicking this column to display the [Visual Monitor Setting] window.

Visual monitor *1

The current value of the register is displayed in a visual manner.
The visual monitor checks the current value against the upper and lower limits, and highlights the values in different
colors to indicate whether they are within the range.
When the current value is within the upper and lower limits: Displayed in green
When the current value is outside the upper and lower limits: Displayed in red

*1 These items are not displayed by default. Right-click on the [Tuning Panel] tab page and select the item from [View] to add the
column.

5.4.2 Adding a Register
Use the following procedure to add a register to the Tuning Panel.

1. In the [Tuning Panel] tab page, select the program type.

Information Programs that you have created will be listed as options in the box.

2. Enter the register to display in the [Variable] column.

3. Press the Enter key.
Information will be displayed in the [Comment], [Current value], [Unit], and [Visual monitor]
columns.

This concludes the procedure.
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5.4.3 Editing a Current Value
Double-click the [Current value] column for a register that was added or directly enter a value to display the
[Edit] window.
• Bit Register
Edit the current value by selecting the value from the [Value] list or by clicking the [ON] and [OFF] buttons.

• All Other Registers
Edit the current value by directly entering the value in [Value], by entering the value with the keyboard, or by
using the keypad in the window.

5.4.4 Editing a Unit
Double-click the [Unit] column for a register that was added or directly enter a value to display the [Edit]
window.

No. Item Description

(1) Register The register that was added is displayed.

(2) Only monitor Select this check box to disable editing of the current value.

Continued on next page.
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Continued from previous page.

No. Item Description

(3) Unit
Select the unit from the options below.
pulse, mm, deg, inch, and μm

(4) Data Type
Select the display format from the options below.
Signed decimal, Unsigned decimal, and Hexadecimal

(5) Number of digits below decimal
point Select the number of digits after the decimal point.

5.4.5 Editing the Visual Monitor
Double-click the [Visual monitor] column for a register that was added or directly enter a value to display the
[Visual Monitor Setting] window.
• Bit Register

Item Description

Displays by ON/OFF or 1/0 Indicates the ON/OFF or 1/0 status of the register with a lit or not lit button.

Displays normal/error
Indicates the ON/OFF or 1/0 status of the register with green (normal) and red (error).
Select whether 1 or 0 is normal.

• All Other Registers

Item Description

The normal range of the current value will
be set and checked Select this check box to enable the normal range settings.

Normal Range Setting Set the upper and lower limits.

5.4.6 Saving Tuning Panel Data
You can save the data edited in the Tuning Panel to the registered program. Use the following procedure.
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Information If you delete a ladder program, the Tuning Panel data is also deleted.

1. Select [Save Project] from the [File] menu.
A message dialog box will be displayed.

2. Click the [Yes] button.

The [Save] window will be displayed.

3. Select the ladder programs to save, and click the [Save] button.

The Tuning Panel data will be saved.

This concludes the procedure.
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5.5 Forcing Coils ON and OFF
You can specify a coil in a ladder program and force it ON or OFF.
The coil will output ON or OFF regardless of the output of the instruction to the left of the coil.
In the following ladder program example, you can simulate turning ON the switch (IB00000) by forcing the
DB000001 relay ON even though the physical switch does not exist.

5.5.1 Operations on the [Force Coil List] Window
Select [Force Coil List] from the [Debug] menu to display the [Force Coil List] window.
The [Force Coil List] window lists the ON/OFF status of the forced coils in the ladder program.
You can select a coil in the window and change or delete the forced ON/OFF status.
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No. Item Description

(1)

[Force Coil Condition Setting]

Displays the [Force Coil Condition Setting] window. Select the program and search for coils.

[Search Again]

Searches for coils again after you change the condition setting and so on.

[Disable Force]

Cancels the forced status of the selected coils.

[Force ON]

Forces ON the selected coils.

[Force OFF]

Forces OFF the selected coils.

[Switch Variable]

Switches the display of the register that is used by the coil between a register or a variable.

(2) Forcing State The forced ON or OFF status of the coils that were found are displayed.

(3) Coil The coils that were found are displayed. The display will depend on the type of coil.
• Coil: "−/ (ON)−" and "−/ (OFF)−"
• Set Coil: "−/ (S ON)−" and "−/ (S OFF)−"
• Reset Coil: "−/ (R ON)−" and "−/ (R OFF)−"

(4) Program The names of the programs that use the found coils are displayed.

(5) Variable The variables or registers that are set for the found coils are displayed.

(6) Comment The comments of the variables are displayed.

(7) Execution Step The execution step numbers of the found coils are displayed.

(8) Context Menu Right-click on the [Force Coil List] window to display the context menu.
The displayed menu depends on whether the Edit Ladder Program window is displayed.

[Force ON] Refer to item (1) in this table.

[Force OFF]

[Disable Force]

[All Disable Force] Cancels the forced status of all coils displayed in the current window, regardless of the check
box selections.

[Check All] Click this item to select all check boxes in the (2) [Forcing State] column of this table.

[Uncheck All] Click this item to clear all check boxes in the (2) [Forcing State] column of this table.

[Go to] The target location in the program will be displayed.

[Cross Reference]
[Write search]
[Read search]

A cross reference, write search, or read search for the row of registers that was right-clicked
will be executed, and the results will be displayed in the [Cross Reference] window. Refer to
the following section for details on the cross reference.

5.8 Cross Reference on page 230

[Search Again] Refer to item (1) in this table.
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5.5.2 Operations on the Edit Ladder Program Window
Use the following procedure in the Edit Ladder Program Window to force the specified coil ON or OFF.

1. Right-click the coil to control, and select [Force ON] or [Force OFF].

2. Confirm that the coil is forced ON or OFF.

• Forced ON state:

• Forced OFF state:

Information To release a coil, right-click the coil, and select [Disable Force].

This concludes the procedure.
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5.6 Search
You can search for variables, instructions, and comments used in a program. There are the following two meth-
ods that you can use for searching.
• Searching within a program (searching within the displayed program)
• Searching within a project (searching within programs in the open project file)
The procedures are given below.

5.6.1 Searching within a Program
When a ladder program is displayed, select [Find] from the [Edit] menu to display the [Search] window.

• [Variable] tab page: Allows you to search for variables or registers. You can also enter the variable by copying
it from the [Variable] window.

• [Instruction] tab page: Allows you to search for instructions or instruction keys.
• [Comment/Bookmark] tab page: Allows you to search for object comments, rung comments, program com-
ments, expression comments, and bookmark names.
Information •The search results are output to the [Search 1] window by default. Select the [Output log at Search 2] check box to dis-

play the search results in the [Search 2] window without changing the contents of the [Search 1] window.
•The detailed setting items on the [Comment/Bookmark] tab page are described below.

Item Description

Use wild cards Select this check box to use wildcard characters (* and ?) in the search string.

Find whole items only Select this check box to search for comments where the string in the comment
box is exactly the same as the search string.

Match case Select this check box to search by differentiating between uppercase and low-
ercase characters.

Register compensation Select this check box to search by converting search strings that are recog-
nized as registers into register notation.
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5.6.2 Search in Project
You can search in a project only when offline.

1. Click [Edit] - [Search in Project] from the menu.

The [Search in project] window will be displayed.

2. Enter the search conditions and click [Search All].

• [Variable] tab page: Allows you to search for variables or registers. You can also enter the variable
by copying it from the [Variable] window.

• [Instruction] tab page: Allows you to search for instructions or instruction keys.
• [Address] tab page: Allows you to search for addresses.
• [Comment Text] tab page: Allows you to search for rung comments, program comments, and book-
mark names.

• [Line comment] tab page: Lists rung comments, program comments, and bookmark names in the
specified range in the [Search] window. If you select the [Display First Line of Line Comment Only]
check box, only the first line will be displayed when there are multiple lines of comments.



5.6 Search

226

Information •The search results are output to the [Search 1] window by default. Select the [Output log at Search 2] check
box to display the search results in the [Search 2] window without changing the contents of the [Search 1]
window.
• Insert commas and spaces to specify more than one program in [Text] under [Target Program]. The follow-
ing wildcard (*) combinations can also be used:

Examples of [Text] Input Description

Ex. 1 ∗ Performs the search in all programs in the project.

Ex. 2
H∗,L∗

Performs the search in all H drawings and L drawings in the project.
H∗ L∗

Add the wildcard after the project type. Other uses, such as “H01.*”, are not allowed.
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5.7 Replace
You can replace variables, comments, and other items used in a program. There are the following two methods
that you can use for replacing.
• Replacing within a program (replacing within the displayed program)
• Replacing within a project (replacing within programs in the open project file)
The procedures are given below.

5.7.1 Replacing within a Program
When a ladder program is displayed, select [Replace] from the [Edit] menu to display the [Replace] window.

• [Variable] tab page: Allows you to replace variables or registers. You can also enter the variable by copying it
from the [Variable] window.

• [Comment/Bookmark] tab page: Allows you to replace object comments, rung comments, program comments,
expression comments, and bookmark names.
Information The detailed setting items on the [Comment/Bookmark] tab page are described below.

Item Description

Use wild cards
Select this check box to use wildcard characters (* and ?) in the search string.
If you enter an * or a ? character in [Replace Variable] or [Replace Object],
they will not be handled as wildcards, but as regular characters.

Find whole items only Select this check box to search for comments where the string in the comment
box is exactly the same as the search string.

Match case Select this check box to search by differentiating between uppercase and lower-
case characters.

Register compensation Select this check box to search by converting search strings that are recognized
as registers into register notation.
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5.7.2 Replacing within a Project

1. Create a backup of the project file before replacement as necessary.
Refer to the following section for details on backups.

2.2.4 Saving a New Project File on page 82

Important

After you perform a replace operation in a project, the project file will be compiled and saved, and there will be
no way to return to the previous version. Always create a backup before performing replacements on important
files.

2. If a CP ladder program is already open in Engineering Builder, close it.

Information If a CP ladder program is already open in the Engineering Builder before the replacement is executed, the
program will not be automatically updated. Close the CP ladder program before executing the replacement
operation.

3. Click [Edit] - [Replace in Project] from the menu.

The [Replace in the project] window will be displayed.

4. Enter the replacement conditions and click [Replace All].
• [Register] Tab Page
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Information Insert commas and spaces to specify more than one program in [Text] under [Target Program]. The fol-
lowing wildcard (*) combinations can also be used:

Examples of [Text] Input Description

Ex. 1 ∗ Performs the replacement in all programs in the project.

Ex. 2
H∗,L∗ Performs the replacement in all H drawings and L drawings in the

project.H∗ L∗

Add the wildcard after the project type. Other uses, such as “H01.*”, are not allowed.

• [Address] Tab Page

Information If you click the [Import] button, the previously exported replacement settings can be imported.
If you click the [Export] button, the current replacement settings can be exported.
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5.8 Cross Reference
Cross referencing allows you to check whether a register is used in a program, and where it is used.
If the value of a register is changes from its set value, it means that the value of the register may have been over-
written somewhere in the program. In this case, you can search for the registers using cross references and locate
the program that is overwriting them.

5.8.1 Cross Referencing
Use the following procedure to search for registers using cross referencing.

Information Click the register to search for in the Edit Ladder Program Window, and then hold down the Ctrl key and press the R
key. This allows you to search the register in a single operation.

1. Select [Cross Reference] from the [Debug] menu.
The [Cross Reference] window will be displayed.

2. Click the [Setting] button.

The [Cross Reference Setting] window will be displayed.

3. Set the following items, and then click the [Setting] button.

Item Description

Variable Enter the variable or register to search.

Search Program Enter the programs to search.

The project file is searched Select this check box to search for the register from the project file when using a
project link connection.
Clear this check box to search for the register from the SERVOPACK.

Continued on next page.
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Continued from previous page.

Item Description

The local register is searched in the
opened program

Select this check box to search local registers (D registers) in the one drawing that is
currently active.
Clear this check box to search local registers (D registers) in the specified drawing.

The global register is searched in all pro-
grams (when using the shortcut menu or
keys).

Select this check box to set all programs to be the search target when executing a
cross reference for global registers using a shortcut.

The same register is searched Select this check box to search for the same register as the specified register. For
example, the same register will be displayed in a list when you search the following
instruction for MW00000.
Clear this check box if it is not necessary to search for the same register.

The same memory address is searched Select this check box to search for the same memory address. For example, registers
with the same memory address will be displayed in a list when you search the fol-
lowing instruction for a different data type, such as ML00000.
Clear this check box not to search for the same memory address.

The result of the search is displayed in
the next Cross Reference 2 window

Select this check box to display the search results in a separate cross reference win-
dow when you perform cross referencing. Cross reference results can be displayed
in up to 3 windows.
Clear this check box to display the search results by updating the same cross refer-
ence window.

The program is marked when displayed Select this check box to add a check mark to the left of the register when a program
that displayed in the search results is open.

The [Cross Reference Setting] window will close, and the set conditions will be displayed in the [Cross
Reference] window.

4. Click the [Search] button.

The search will be executed, and the search results will be displayed in the [Cross Reference] window.
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No. Item Description

(1) Same Register Information is displayed on locations in the searched program where the same register is used as
the search variable (search register).
• [Write/Read] column
Read (blue text): The register is used in reading (reference).
Write (blue text): The register is used in writing.

(2) Same Memory
Address

Information is displayed on locations in the searched program where the used memory overlaps
with the search variable (search register).
<Example>
For example, MW00001 and ML00000 are different registers, but they used the same memory
address because ML00000 used two words of memory (MW00000 and MW00001). A search is
made for registers like these.
The details on the columns are the same as (1) in this table.

(3) History Button Displays a cross reference history. Select an entry in the displayed history list to display the pre-
vious reference results and the drawing for the reference. Up to 20 records are saved in the history.

(4) Next Button Every time you click this button, the next item in the cross reference history will be displayed.

(5) Previous Button Every time you click this button, the previous item in the cross reference history will be displayed.

Information Double-click on a row to go to the line with the instruction in the program where the search target register is
used. However, you cannot go to a line from the registers listed in [Reference setting].

This concludes the procedure.

5.8.2 Write Searches and Read Searches
To search only for registers that are used to write data (i.e., output registers), perform a write search.
To search only for registers that are used to read data (i.e., input registers), perform a read search.

1. Click the register to search for in the Edit Ladder Program Window.

2. Select [Cross Reference] - [Write search] or [Read search] from the [Debug] menu.
The search results will be displayed in the [Cross Reference] window and the drawing in which the
selected register is written or read will be displayed.

This concludes the procedure.
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5.9 Check for Multiple Coils
Checking for multiple coils allows you to check for multiple coils (different coils that use the same register) in
an entire ladder program and display the search results.
Select [Check for Multiple Coils] from the [Debug] menu to start searching for multiple coil and display the
results in the [Check for Multiple Coils] window.
Double-click a row in the [Check for Multiple Coils] window or right-click and click [Go to] to display the target
location in the program.

Information •When you use a project link connection, the data in the project file is used. Sometimes the displayed results do not
match the data in the linked SERVOPACK.
If you check for multiple coils when using a project link connection, first always transfer the SERVOPACK data to the
project file.
• If [Enable to multiple coil check] is enabled in the compile options, a search for multiple coils will be performed during
compilation and the results will be displayed in the [Output] window.
•Right-click a row in the [Check for Multiple Coils] window and click [Cross Reference] to execute a cross reference for
the target row of registers. The results will be displayed in the [Cross Reference] window. Refer to the following section
for details on the cross reference.

5.8 Cross Reference on page 230
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6
Monitor

This chapter describes the methods to monitor the status of the connected SERVOPACK and the status of
registers.
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6.1 System Monitor
Use the System Monitor to monitor the status of SERVOPACK after establishing an online connection between
the SigmaWin+ AE and SERVOPACK.
You can monitor the following items.
• Operating status of the SERVOPACK
• Scan time
• Errors that occur on the SERVOPACK
• Alarm history

6.1.1 [System Monitor] Window
Click the [System Monitor] button in the [My Tool] window to display the [System Monitor] window.
The [System Monitor] window will be automatically displayed if an error occurs on the SERVOPACK.

No. Item Description

(1) Operating Status The operating status of the SERVOPACK is displayed.

(2) CPU Performance
Refer to the following section for details.

(1) CPU Performance on page 237

(3) Alarms
Refer to the following section for details.

(2) Alarms on page 237

(4) Alarm History
Refer to the following section for details.

(3) Alarm History on page 240

(5) CPU Control You can RUN and STOP the CPU and execute error reset and save to flash memory.
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(1) CPU Performance
Click the [Check CPU performance] button to display the scan time values and graph.

No. Item Description

(1) Scan Time The set values, current values, and maximum values of the scan times are displayed.

(2) [Setting] Button Displays the [Environment Setting] window. You can change the set values for the scan
times.

(3) [Clear] Button Clears the maximum values of the scan times.

(4) Scan Time Monitor
The current value of the high-speed scan time is displayed as a green waveform.
You can drag the cursor position of the threshold value to change it.

(5) Threshold Value
Set the threshold value for the high-speed scan time.
If the current value or maximum value of the high-speed scan time exceeds the threshold
value, the [System Monitor] window will become active and a warning will be displayed.

(6) [Reset Warning] Button Resets the warning.

(2) Alarms
Click the [Check alarms] button to display detailed information on alarms. The content that is displayed depends
on the type of alarm that occurred.

(a) Operation Errors
Operation errors are errors related to operations in ladder programs.
How to interpret and analyze the displayed information is shown below.
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1. Click the alarm on which to access information.

The cause and correction method will be displayed.
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2. Click the [Analyze] button.

A message dialog box will be displayed.

3. Click the [Yes] button.

The location where the alarm occurred will be displayed.
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4. Click the [Jump] button.
The drawing where the operation error occurred will be displayed.

5. Resolve the operation error.
Refer to the following manual for details on how to resolve operation errors.

YRM1000/MPX1000 Series Ladder Program Programming Manual (Manual No.: SIEP C890101 10)

6. Make the Edit Ladder Program Tab Page the active view and press the F4 key.
The program will be compiled.

7. Confirm that the alarm is no longer displayed in the [System Monitor] window.

This concludes the procedure.

(3) Alarm History
Click the [Check alarm history] button to display the history of alarms that occurred. The alarm history retains
up to 100 records.
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No. Item Description

(1) Alarm Category The category of the alarm that occurred is displayed.

(2) Alarm Code The code of the alarm that occurred is displayed.

(3) Alarm Name The name of the alarm that occurred is displayed.

(4) Time when alarm occurred The date and time when the alarm occurred is displayed.

(5) Cause/Correction The cause and correction method is displayed when an alarm is selected in the list.

(6) Detailed Information Detailed information is displayed when an alarm is selected in the list.

(7) [Update] Button Click this button to update to the most recent information.

(8) [Clear] Button Click this button to delete the alarm history that is displayed.
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6.2 Trace

6.2.1 Overview
Tracing allows you to obtain and display the specified data from a SERVOPACK.
The SigmaWin+ AE has the following three trace functions.

Function Name Description

Real-Time Trace You can monitor specified registers. This allows
you to analyze register data to debug ladder
programs.

You can monitor registers in real time. A maximum of
64 trace data can be monitored.

Trace Manager *1 You can monitor registers only during a specified time
period. A maximum of 16 trace data can be monitored.

XY Trace This trace function acquires the position data (target position, feedback position) of the X axis and Y axis
every scan, and displays the data in a 2-dimensional graph. The 2-axis paths can be visually checked.

*1 There are restrictions when using Trace Manager. Refer to the following section for details.

(1) Restrictions in Use of Trace Manager on page 242

(1) Restrictions in Use of Trace Manager
The Trace Manager cannot be used for some register types and data types for tracing. Refer to the following
table for details. Use a Real-Time Trace when the Trace Manager cannot be used.
• Register Types

Type Applicable Range
Support

Trace Manager Real-Time Trace

S Register
SW00000 to SW08191 ○ ○

SW08192 to SW65534 × ○

M Registers
MW00000 to MW65534 ○ ○

MW65535 to MW1048575 × ○

G Registers GW0000000 to GW2097151 × ○

I Registers
IW00000 to IW0FFFF ○ ○

IW10000 to IW27FFF × ○

O Registers
OW00000 to OW0FFFF ○ ○

OW10000 to OW27FFF × ○

D register DW00000 to DW16383 ○ ○

• Data Types

Symbol Data Type
Support

Trace Manager Real-Time Trace

B Bit ○ ○

W Integer ○ ○

L Double-length integer ○ ○

Q Quadruple-length integer × ○

F Real number ○ ○

D Double-precision real number × ○

A Address × ×
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(2) Trace Buffer Size
The maximum applicable trace buffer size that can be used for the trace function as follows.

Maximum Applicable Trace Buffer Size

Real-Time Trace/XY Trace Trace Manager

128 kwords 128 kwords

(3) External Files
Trace data can be saved as an external file or read from an external file. However, supported file formats differ
according to the trace function as follows.

Tracing Command to Use on the [File] Menu
Supported File Formats

csv dat/trd

Real-Time Trace

[Open Trace File] ○ ○

[Open External File] ○ ○

[Save in External File] ○ ○ *1

Trace Manager
[Import] ○ ○/-

[Export] ○ –

XY Trace
[Open External File] ○ ○

[Save in External File] ○ ○ *1

*1 For MP2000-series machine controllers, trace data can be saved to only dat files, and for machine controllers other than the MP2000
series, trace data can be saved to only trd files.

6.2.2 Startup
Use the following procedure to start tracing.

1. Use one of the following methods to display the [Trace Type] window.

Information There are four buttons for tracing, Scope1 to Scope4. The settings when tracing is executed are stored to the
[Scope1] to [Scope4] buttons. This means that you can store up to four trace settings.
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Screen Used for
Startup Operation

[System] Window

Double-click one of [Scope1] to [Scope4].

The same operation is also possible by right-clicking one of [Scope1] to [Scope4] and selecting [Open
Real-Time Trace], [Open Trace Manager], or [Open XY Trace]. When this operation is performed,
tracing will be started without displaying the [Trace Type] window.

[My Tool] Window

Click either [Scope1] or [Scope2].

The [Scope3] and [Scope4] are not displayed in the [My tool] window.

Launcher

Click [Monitor] – [Scope].

Edit Ladder Program
Window
(Only the Real-Time
Trace window can be
started up.)

Right-click on the register used by the ladder instruction, and select [Add to Scope□].

• If you right-click on the operand, that register will be targeted for tracing.
• If you right-click on the instruction, the registers included in that instruction will be targeted for
tracing.

• If you right-click on the rung, all registers included on that rung will be targeted for tracing.
• If you right-click with multiple instructions or multiple rungs selected, all registers included in the
selected range will be targeted for tracing.

Continued on next page.
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Continued from previous page.

Screen Used for
Startup Operation

[Register List] Window
(Only the Real-Time
Trace window and
Trace Manager window
can be started up.)

Right-click on the register address, and select [Add to Scope] – register address.

[Watch] window
(Only the Real-Time
Trace window and
Trace Manager window
can be started up.)

Right-click on the variable, and select [Add to Scope].

Information [Add to Scope] is disabled when the variable register is outside the range of CPU
registers in the project. Reselect the variable and execute the operation again.

[Variable] Window
(Only the Real-Time
Trace window and
Trace Manager window
can be started up.)

Right-click on a registered variable, and select [Add to Scope].

2. When Scope1 to Scope4 are not selected in Step 1, select [Scope No.].
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3. Click the trace type, and click the [Open] button.

The selected trace tab page will be displayed.

This concludes the procedure.

6.2.3 [Real-Time Trace] Tab Page
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No. Item Description Reference

(1)

Trace Data Setting Set the trace target. (1) Trace Data Setting on
page 247

Sampling and Trigger Settings Set the trace conditions. (2) Sampling and Trigger Set-
tings on page 249

Start Trace/Stop Trace

Starts and stops the trace.
When the trace is started, the trace data is acquired and
displayed in real time.
When the trace is stopped, the buffer data of all traces is
acquired and displayed.

-

Read Again

Re-reads the trace data in the SERVOPACK.
By executing re-reading, the content of the trace data accu-
mulated at that point can be checked. When re-reading is
executed during execution of a trace, the real time display
mode automatically turns OFF.

-

Monitor Data No.

The number of trace data to acquire from the SERVO-
PACK can be set.
The actual number of acquired trace data is displayed at
the bottom right of the trend graph.

-

Real Time Display

When this check box is selected, the display shows the
data moving during tracing in real time.
When multiple trace tab pages are open, only one tab page
is displayed.

-

(2) Graph Toolbar Groups together the buttons used for analyzing trace data. (3) Graph Toolbar on page
253

(3) Trend Graph
The trace data is displayed. The graph toolbar, sliders and
cursors can be used to analyze trace data in the Real-Time
Trace Window.

(4) Trend Graph on page 254

(4) [Trace List] Window A list of the registers that can be selected for tracing is
displayed.

(5) [Trace List] Window on
page 255

(1) Trace Data Setting
This is for setting the trace target.
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No. Item Description

(1) Trace Target List Cannot be used.

(2) Add Cannot be used.

(3) Delete Deletes the entered register.

(4) Trace Target Used to directly enter the register to trace.
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(2) Sampling and Trigger Settings

No. Item Description

(1) Trace Name
Set the trace name.
<Setting Conditions>
32 characters maximum.

(2) Tracing Mode Setting
Set the tracing mode. Refer to the following section for details.

(a) Details of Tracing Mode Setting on page 249
Clicking [?] displays a detailed description of trace mode.

(3) Sampling Setting
Set the data sampling rate.
Setting a value for [Sampling Period] will display an approximate maximum measuring time.

(4) Trigger Setting
Specify the condition at which trace is executed. Refer to the following section for details.

(b) Details of Trigger Setting on page 250

(a) Details of Tracing Mode Setting
The following describes the differences between trace operation according to individual tracing mode.
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Status
Tracing Mode

Standard Mode MP2000 Compatible

Trace definitions have been written to the
SERVOPACK

Tracing is started by clicking the [Start
Trace] button.

There is no need to click the [Start Trace]
button. Tracing is performed automatically.

Trace start trigger turns ON after the trace
stop trigger condition is satisfied Tracing is not performed. Tracing is performed automatically.

Both the trace stop trigger and trace start trig-
ger turn ON simultaneously Tracing is not performed. Tracing is performed automatically for one

scan.

(b) Details of Trigger Setting
Specify the condition at which trace is executed. There are five setting options.

�� [No trigger]
Start/stop of tracing can be performed manually.

�� [Edge ON] [Edge OFF]
When a specific bit changes state from OFF to ON or from ON to OFF, the preceding and subsequent data is
acquired.
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Edge ON: Edge OFF:

No. Item Description

(1) Trigger Condition

Enter the register to be used as the trigger condition.
Only bit registers (data type (B)) can be entered. Data types integer (W), double-length integer (L),
quadruple-length integer (Q), real number (F), double-precision real number (D), and address (A) can-
not be entered.

(2) No. of Delays Specify how many times sampling is performed before the trace is stopped after the stop conditions
are satisfied.

(3) Drag to move this button and set the trigger position.

(4) [%] Select the numerical values, and set the trigger position.

(5) Unit Selection Set the unit for the maximum trace measuring time after a trigger condition is satisfied.

�� [Level]
When a specific register matches the trigger condition, the preceding and subsequent data is acquired.
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No. Item Description

(1) Trigger Condition

Set the trigger condition for the trace.
Only registers having the data type integer (W), double-length integer (L), quadruple-length integer (Q), real
number (F), and double-precision real number (D) can be entered. Registers having the data type bit (B) and
address (A) cannot be entered.

(2) No. of Delays Specify how many times sampling is performed before the trace is stopped after the stop conditions are
satisfied.

(3) Drag to move this button and set the trigger position.

(4) [%] Select the numerical values, and set the trigger position.

(5) Unit Selection Set the unit for the maximum trace measuring time after a trigger condition is satisfied.

�� [Details]
Any register set as the trigger can be traced. Tracing can be performed by freely combining the start and stop
triggers.
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No. Item Description

(1) Trigger Condition

Set the start trigger condition and stop trigger condition for the trace.
Only registers having the data type bit (B), integer (W), real number (F), and double-length integer (L) can
be entered. Data types quadruple-length integer (Q), double-precision real number (D), and address (A) can-
not be entered.
If the start trigger is not specified, the trace is started at the same time as start of sampling.
If the stop trigger is not specified, the trace is executed until stop of sampling.

(2) No. of Delays Specify how many times sampling is performed before the trace is stopped after the stop conditions are
satisfied.

(3) Graph Toolbar
The functions of each button are as follows.

Button Function

Double-clicking this allows you to zoom the graph.

Dragging this allows you to scroll the graph. Double-clicking this also allows you to zoom the graph.

Dragging or double-clicking this allows you to zoom the graph.

Restores an enlarged graph to its original size.

Displays the graph split into sections.

Displays cursor A and the value at the intersecting point on the graph.

Displays cursor B and the value at the intersecting point on the graph.

Displays cursor C and the value at the intersecting point on the graph.

Displays cursor D and the value at the intersecting point on the graph.

Continued on next page.
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Continued from previous page.

Button Function

Causes cursors A and B to move at a fixed width interlocked with each other.

Causes cursors C and D to move at a fixed width interlocked with each other.

Displays the list.

Copies an image of the graph to the clipboard.

(4) Trend Graph
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No. Item Description

(1) Cursor Position The value on the cursor position is displayed.

(2) Cursor A-B Difference The difference in values between the A and B cursor positions is displayed.

(3) Cursor C-D Difference The difference in values between the C and D cursor positions is displayed.

(4) Graph Unit

The unit of the parameter selected in the [Trace Target List] of the [Trace Data Setting] win-
dow is displayed.
When the currently displayed trace data includes two or more unit systems, you can switch the
unit displayed on the vertical axis of the graph. The scale of the vertical axis is changed and
the waveform is displayed to match the information (unit and number of digits after the deci-
mal point) held by each axis. When the unit is switched, trace targets other than the selected
unit are displayed by a line in the lighter color of the current color.

(5) Scale

Moving the sliders horizontally and vertically allows you to rescale the graph.
The scalable amounts in the horizontal and vertical directions are as follows:
Vertical scale: 0.085x to 64x
Horizontal scale:1x to 48.5x

(a) Graph Split View

Click the [ ] button on the graph toolbar to group the trace data and display it in split views.
Trace targets are categorized by groups on the [Trace Target List] tabs of the [Trace Data Setting] window and
by other groups of registers.

(5) [Trace List] Window
A list of the registers that can be selected for tracing is displayed.
Waveforms on the graphs can be displayed or hidden by selecting or deselecting respective check boxes.
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No. Item Description

(1) Trace Name The trace name is displayed.

(2) Trace Group Name Registers are displayed categorized by groups on the [Trace Target List] tabs of the [Trace
Data Setting] window (example: position, speed) and by other “Data” groups.

(3) Register Registers are displayed in the same color as the graph.

6.2.4 Overview of Real-Time Trace Operations
The flow for using real-time trace is given below.

1. Display the [Real-Time Trace] tab page.

2. Set [Trace Data Setting] and [Sampling & Trigger Setting] in that order, and then click
the [Start Trace] button.
Refer to the following section for details on the setting items displayed in the window.

6.2.3 [Real-Time Trace] Tab Page on page 246

The trace will start, and the graph will be displayed in real-time.
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3. To stop the trace, click the [Stop Trace] button.

Tracing will stop.

This concludes the basic procedure.
The following table lists the other operations available in Real-Time Trace and the reference information.

Operation Reference

Reading Trace Definition Files 6.2.9 Reading Trace Definition Files on
page 280

Checking Sampling and Trigger Settings 6.2.10 Checking Sampling and Trigger
Settings on page 281

Deleting Trace Definitions and Trace Data 6.2.11 Deleting Trace Definitions and
Trace Data on page 282

Changing the Enabled/Disabled Setting of the Trace Definition Settings
6.2.12 Changing the Enabled/Disabled
Setting of the Trace Definition Settings
on page 283

Scaling the Trace Data Waveform 6.2.13 Scaling the Trace Data Wave-
form on page 284

Comparing I/O Registers and M Registers (1) Comparing I/O Registers and M
Registers on page 286

Comparing with Past Acquired Data 6.2.15 Comparing with Past Acquired
Data on page 288

Checking the Trace Status 6.2.18 Checking the Trace Status on
page 292

Saving Trace Data 6.2.19 Saving Trace Data on page 292

Reading Trace Data 6.2.20 Reading Trace Data on page 294

Switching Between Graph View and List View 6.2.21 Switching Between Graph View
and List View on page 295

Copying an Image of the Graph 6.2.22 Copying an Image of the Graph
on page 296
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6.2.5 [Trace Manager] Tab Page

No. Item Description Reference

(1) Control Panel Area

Used for starting/stopping traces, setting triggers, etc., and for
executing general operations relating to tracing.
This area is displayed at all times regardless of the graph or list
view mode.

(1) Control Panel on page 258

(2) Graph Area

The trace data graph is displayed. Graphs are displayed in either
of the following formats:
• Trend graph
• X-Y graph
When in the maximum view mode of the list, the graph area is
not displayed.

(2) Graph Area on page 260

(3) List Area

Used for the operation of registering and clearing monitor varia-
bles. Monitor variables are displayed in list format.
When in the maximum view mode of the graph, the list area is
not displayed.

(3) List Area on page 264

Term

Monitor Variables :
Avariable (register) that is targeted for graph plotting and monitoring is called a “monitor variable.” A monitor variable
must be registered so that a variable (register) is treated as a monitor variable. Refer to the following sections for details on
registration of monitor variables.
� How to Register Monitor Variables on page 266

(1) Control Panel
The functions of each button are as follows.
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Button Function

Starts and stops the trace.

: Trace is executing (or waiting for trigger condition).

: Trace is stopped.
This button is enabled only in the online mode.
If a trace definition file has been loaded, the trace is started at the same time that the trace tab page is started up.
So, the [Stop] button is ON at first.

Clicking this button acquires and displays the content of the trace data memory for one scan.
This button is enabled only in the online mode.

The maximum value of the trace data that is acquired when the [Stop] button or the [Snap] button is clicked can be
set. You can either select from the available options or click inside the cell and directly enter the value. The maxi-
mum value that can be entered directly is “32158”.

Clicking this displays the [Trigger & Configuration Setting] window. Refer to the following section for details.
(a) [Trigger and Configuration Setting] Window on page 259

Clicking this displays the trend graph. The trend graph displays the values of registered monitor variables in time
series as a graph.
Refer to the following section for details.

(2) Graph Area on page 260

Clicking this displays the X-Y graph. The X-Y graph displays the relation between variable X and variable Y at a
certain time as a graph with two specified monitor variables (variable X and variable Y) taken for the horizontal
axis and vertical axis.
Refer to the following section for details.

(2) Graph Area on page 260

Clicking this displays the [Open] window, and the trace data and data definitions can be read from the selected file.

Clicking this opens the [Save As] window, and you can save trace data and trace definitions as a file.

Clicking this displays the [Print] window, and you can print the [Trace Manager] window.

(a) [Trigger and Configuration Setting] Window
This window is displayed by clicking the [ ] button on the control panel.
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Item Description

Scope Name
Set the trace condition name.
<Setting Conditions>
32 characters maximum.

Sampling

Sampling Conditions Set the data sampling rate.

Sampling Interval

Set the data sampling interval.
When “0” is set, trace is executed at every scan.
<Setting Range>
0 to 32767

Scope Interval of Program

Specify the time in ms units. The value specified here is used for the time axis.
This setting is enabled only when sampling conditions are set to "Program designation".
<Setting Range>
0.1 to 999.9

Scope No. of Times
Specify the number of points of data to acquire.
When [Auto] is selected, the trace is executed until the stop trigger condition is satisfied or
when the [Stop] button is clicked.

Initiate
Set the register, operator and numerical value that are used as the trigger for starting the trace.
If the start trigger is not specified, the trace is started at the same time as start of sampling.

Terminate 1/2
Set the register, operator and numerical value that are used as the trigger for stopping the
trace. Up to two stop triggers can be set.
If the stop trigger is not specified, the trace is executed until stop of sampling.

Delay

Specify how many times sampling is performed before the trace is stopped after the stop con-
ditions are satisfied.
<Setting Range>
0 to 65534

(2) Graph Area
Two graph view modes provided for the graph area are trend graph view and X-Y graph view. The view can be

switched by clicking the [ ] button and the [ ] button.
<Trend Graph>

<X-Y Graph>
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No. Item Description

(1) Graph Area Operation Buttons

The graph area operation buttons are common to both the trend graph view mode and the X-Y
graph view mode. The pointer and cursors can be set and switched, and the graph display can
be switched, for example.
Refer to the following section for details.

(a) Graph Area Operation Buttons on page 262

(2) Monitor Variable Selection

Different variable names and maximum values (units) can be set to the left and right vertical
axes of trend graphs.
Clicking the [V] button displays all variables as a list whose display setting is currently ON in
the list area. Select the variables to set to the left and right vertical axes.

Different variable names can be set to the vertical and horizontal axes of X-Y graphs.
Clicking the [V] button displays all variables as a list whose display setting is currently ON in
the list area. Select the variables to set to the vertical axis and the horizontal axis.

(3) Maximum Value Selection

The maximum values of different monitor variables can be set to the left and right vertical axes
of trend graphs.
Double-clicking a cell allows you to enter directly. When [Auto] is selected, the maximum val-
ues are adjusted so that all of the acquired trace data is displayed in the graph area.

The maximum values of different monitor variables can be set to the vertical axis and the hori-
zontal axis of X-Y graphs.
Double-clicking a cell allows you to enter directly. When [Auto] is selected, the maximum val-
ues are adjusted so that all of the acquired trace data is displayed in the graph area.

(4) Unit Selection The display unit of the horizontal axis (time axis) can be selected from [ms], [sec], [min] or
[Data].

(5)

When the [ ] button is clicked, the list area is hidden so that the graph area becomes the

maximum size, and the [ ] button is displayed.

When the [ ] button is clicked, the graph area returns to its original size, and the list area is
displayed.

(6) X-Y Graph View Setting Opera-
tion Buttons

The view settings of the X-Y graph can be modified. Refer to the following section for details.
(b) X-Y Graph View Setting Operation Buttons on page 264

(7) Playback Related Operation
Buttons

The playback function plays back and displays data acquired until the trace is stopped or data
acquired by snapshot. Operations possible by this function include playback, stop, fast forward/
rewind, and frame advance/return.
Playback can be executed when in the X-Y graph view mode. As the X-Y graph does not
include time information, this function is provided for displaying changes in data that are
caused by the lapse of time.
Refer to the following section for details.

(c) Playback Related Operation Buttons on page 264
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(a) Graph Area Operation Buttons

Button Description

Dragging this allows you to vertically scroll the graph.
Graph areas for which “Auto” is selected as the maximum vertical axis value on the list cannot be moved.

Dragging this allows you to horizontally scroll the graph.

Dragging this enlarges the selected area.

Clicking this when the graph is displayed enlarged makes the graph one step smaller.
This is enabled when the graph is displayed enlarged.

Restores an enlarged graph to its original size.
This is enabled when the graph is displayed enlarged.

Toggles between displaying and hiding the grid.

Toggles between displaying and hiding cursor A. Refer to the following section for
details.
� Details of Cursor A, Cursor B,
Cursor A/B with Same Interval on
page 262

Toggles between displaying and hiding cursor B.

Causes cursors A and B to move at a fixed width interlocked with each other.
This is enabled when both cursors A and B are displayed.

Displays the [Cursor Setting] window. Refer to the following section for details.
� [Cursor Setting] Window on page 262

Displays the [Scale Offset Adjust] window. Refer to the following section for details.
� [Scale Offset Adjust] Window on page 263

Copies the graph to the clipboard.
The copied graph image can also be pasted to other Windows applications.

Hides the list area and maximizes the graph.
This is enabled in the normal list view.

Displays the list area and restores the graph to its normal view.
This is enabled in the maximum graph view.

�� Details of Cursor A, Cursor B, Cursor A/B with Same Interval
Two mouse cursors, cursor A and B, are provided for the graph area. You can use either one or both of these.
The cursor moves as described below according to the status of the graph area by left-clicking inside the graph.

Status Cursor Movement

When only cursor A (or B) is displayed Cursor A (B) moves to the place you clicked.

When both cursors A and B are displayed and movement of cursors
A and B is interlocked

Cursor A moves to the place you clicked with cursors A and B inter-
locked with each other at a fixed width.

When both cursors A and B
are displayed and movement
of cursors A and B is not
interlocked

When the cursor mode in the list
area is either Normal or Cursor A

Cursor A moves to the place you clicked. At this time, cursor B does
not move.

When the cursor mode in the list
area is Cursor B

Cursor B moves to the place you clicked. At this time, cursor A does
not move.

�� [Cursor Setting] Window

The [Cursor Setting] window is displayed by clicking the [ ] button in the graph area operation buttons.
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Item Description

Type

Select the cursor shape.
A vertical cursor (|) or cross cursor (+) can be selected.
The cross cursor is displayed when a monitor variable is selected in the [Select] field in the list area. At
this time, the center of the cross moves to on the selected monitor variable.

Color
Clicking this button displays the [Color Setting] window.
The color of the cursor is selected of cursors A and B individually.

Display The cursor of the selected check box is displayed.

Position
Set the display position of the cursor.
Either enter directly or set by clicking the spin buttons.
When the numerical value is entered directly, the display position is adjusted to the nearest grid position.

�� [Scale Offset Adjust] Window

The [Scale Offset Adjust] window is displayed by clicking the [ ] button in the graph area operation buttons.
In this window, the scale (maximum value) of each axis and offset (shift from center) can be adjusted.

Information Offset adjustment is enabled when a variable for offset adjustment is selected in the [Select] field in the list area.

No. Item Description

(1) Vertical Scale Setting
Set the vertical scale either by entering directly or clicking the spin buttons.
<Setting Range>
100 to 1000

(2) Vertical Scale Adjustment Bar Drag this vertically to set the vertical scale.

(3) Horizontal Scale Setting
Set the horizontal scale either by entering directly or clicking the spin buttons.
<Setting Range>
10 to 1000

(4) Horizontal Scale Adjustment Bar Drag this horizontally to set the horizontal scale.

(5) Variable Targeted for Offset
adjustment The name of the variable targeted for offset adjustment is displayed.

Continued on next page.
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Continued from previous page.

No. Item Description

(6) Vertical Offset Setting
Set the vertical offset either by entering directly or clicking the spin buttons.
<Setting Range>
-100.00 to 100.00

(7) Vertical Offset Adjustment Bar Drag this vertically to set the vertical offset.

(8) Horizontal Offset Setting

Set the horizontal offset either by entering directly or clicking the spin buttons.
<Setting Range>
• When the target (sampling time) is selected on the [Monitor] tab page or the [File] tab
page: -99 to 99

• When the target (variable) is selected on the [XY Graph] tab page: -100.00 to 100.00

(9) Horizontal Offset Adjustment Bar Drag this horizontally to set the horizontal offset.

(10) Default

Restores the scale or offsets to their defaults.
Vertical scale: 100
Horizontal scale: 100
Vertical offset: 0.00
Horizontal offset: 0
The horizontal offset default is 0.00 when the target on the [XY Graph] tab page is
selected.

(b) X-Y Graph View Setting Operation Buttons

Button Item Description

Point Display Displays each coordinate as a point.

Line Display Displays each coordinate connected by a line.

Model Display
Displays each coordinate connected by a line according to the information of the connection
point. Refer to the following section for details on connection points.

(b) [XY Graph] Tab Page on page 266

Leave Trace
Select whether or not to leave a trace.
This is enabled only for point display.

(c) Playback Related Operation Buttons

Button Item Description

Playback Plays back the X-Y graph from the beginning of the traced data.

Stop Stops the X-Y graph during playback.

/ Fast Forward/Rewind
Fast forwards and rewinds by a specified magnification.
Playback is automatically continued when this operation is canceled.
This operation is possible only during playback.

/ Frame Advance/Return Advances and returns playback one frame at a time.

Magnification Setting Set the magnification of fast forward/rewind.

Run Time
The run time of the playback display is displayed.
The unit can be selected from [ms], [sec], [min] or [Data].

(3) List Area
Three types of tab pages are displayed in the list area: [Monitor], [XY Graph], and [File].
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(a) [Monitor] Tab Page
In the [Monitor] tab page, monitor variables can be displayed, registered, deleted, and edited.
Refer to the following section for details on registration and editing of monitor variables.
� How to Register Monitor Variables on page 266

Item Description

Select

Clicking this button selects the variable.
Switching of data view, find, calculation, offset adjustment, and cross cursor display will be possible for the
selected variable.
The following describes the display items:
• M:y : No.y of monitor
• Fx:y: No.y of file x
• SUB : Difference between 2 variables
• ADD: Sum of 2 variables
• REF : Reference variable

Display Selecting this check box displays the variable graph.

Color Double-clicking this button displays the [Color] window on which you can set the graph color.

Variable Enter the name of the variable or the register to be traced.

Program When entering a D register, enter the name of the program that is currently using the D register.

Comment The comment is displayed.

Y axis scale

Select the scale of the Y-axis from "Auto", "Y1 axis" and "Y2 axis".
When "Auto" is set, the scale is automatically adjusted and displayed for each individual monitor variable.
When "Y1 axis" is selected, data is displayed according to the scale on the left edge of the graph, and when "Y2
axis" is selected, data is displayed according to the scale on the right edge of the graph

Maximum value This is displayed by selecting [Minimum/Maximum Value] from the [List] menu. The maximum value of the
trace data is displayed.

Minimum value This is displayed by selecting [Minimum/Maximum Value] from the [List] menu. The minimum value of the
trace data is displayed.

Cursor A This is displayed by selecting [Cursor Position Value] from the [List] menu. The value of cursor A is displayed.

Cursor B This is displayed by selecting [Cursor Position Value] from the [List] menu. The value of cursor B is displayed.

Continued on next page.
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Item Description

Difference (A – B) This is displayed by selecting [Cursor Position Value] from the [List] menu. The difference (A – B) between the
values for cursors A and B is displayed.

Conversion unit (x N)
This is displayed by selecting [Unit Conversion] from the [List] menu. The value for the convert unit is displayed
as a multiplying factor. Data is displayed by variable value x multiplying factor.
Set this value, for example, when swapping over to the machine coordinate system.

�� How to Register Monitor Variables
Traces can be used by registering the variables that are to be monitored (monitor variables) in the list area. Up to
16 monitor variables can be registered.
Note:
Up to 64 (16 x 4) monitor variables can be registered by setting the monitor in the [Select Monitor Setting] window. Up to 16 monitor varia-
bles, however, can be displayed at one time. Refer to the following section for details.
� [Select Monitor Setting] Window on page 268

The following methods can be used to register monitor variables.
• Registering Variables on the [Monitor] Tab Page
You can enter the variable by double-clicking the [Variable] cell. The variable name (register) can either be
directly entered or it can be entered by dragging and dropping the variable from the [Variable] window.

• Registering Variables from the Edit Ladder Program Window
Right-click an object in the Edit Ladder Program Window and select [Add to Scope] from the pop-up menu.

(b) [XY Graph] Tab Page
In the [XY Graph] tab page, the monitor variables to display on the X-Y graph can be registered, deleted, edited,
and displayed.

Item Description

Select
Clicking this button selects the variable.
Offset adjustment and the cross cursor can be displayed for the selected variable.

Display

Select how the graph is displayed.
• Hide: Data is not displayed on a graph.
• Fixed display: Data is displayed on a graph when trace is executed.
• Playback: Data is displayed on a graph when playback is executed.

Color Double-clicking this button displays the [Color] window on which you can set the graph color.

Variable (X axis)
Specify the name of a variable to be traced on the X-axis (horizontal axis).
The variable name can be selected from the variables set on the [Monitor] tab page.

Continued on next page.
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Continued from previous page.

Item Description

Variable (Y axis)
Specify the name of a variable to be traced on the Y-axis (vertical axis).
The variable name can be selected from the variables set on the [Monitor] tab page.

Connection point
Set the No. in the model display to connect to.
Select from none or the [Select] numbers of this tab page.

Cursor A This is displayed by selecting [Cursor Position Value] from the [List] menu. The value of cursor A is displayed.

Cursor B This is displayed by selecting [Cursor Position Value] from the [List] menu. The value of cursor B is displayed.

Difference (A – B) This is displayed by selecting [Cursor Position Value] from the [List] menu. The difference (A – B) between the
values for cursors A and B is displayed.

(c) [File] Tab Page
Monitor variable data imported from specified files (CSV files) can be displayed in the [File] tab page.
Use the following procedure to import the data.

1. Display the [File] tab page in the list area.

2. Select [Import] from the [File] menu.
The [Open] window will be displayed.

3. Select the file (.csv) from which to import data, and click the [Open] button.
The data in the selected file will be displayed.

The items displayed on a [File] tab page are the same as those on a [Monitor] tab page. Variables, programs, and
comments depend on data imported from files, so they cannot be edited.

Information •Variables displayed on a [File] tab page are registered as monitor variables to be monitored on a [Monitor] tab page.
Refer to the following section for details.
� [Object Variable Setting] Window on page 268

•The default setting for the number of [File] tab page displayed is two, but the number can be set for a maximum of
eight. Refer to the following section for how to set the number of tab pages displayed.

(d) [List] Tab Page on page 273

(d) List Operation Buttons

Button Description

Clicking this button displays the [Select Monitor Setting] window. You can add [Monitor] tab pages that
are displayed to expand the targets for monitoring. Refer to the following section for details.
� [Select Monitor Setting] Window on page 268

Clicking this button displays the [Object Variable Setting] window. You can register the variables in the
imported file as monitor variables. Refer to the following section for details.
� [Object Variable Setting] Window on page 268

Select the display format for variables selected in the list.

Continued on next page.
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Button Description

Select the cursor linked to the display positions.
When Cursor A, Cursor B, or Cursor A/B is selected, the cursor position on the graph is linked with the
data displayed on the [Monitor] tab page and [File] tab page of the list area.
When cursor A (or cursor B) is not displayed, [Cursor A] (or [Cursor (B)]) cannot be selected.
When [Cursor A/B with Same Interval] is not set in the graph area, [Cursor A/B] cannot be selected.
The status will not change if unexecutable selections are selected.

Toggles the display orientation of the list.
When ON, all variable data is displayed in the vertical direction.
When OFF, all variable data is displayed in the horizontal direction.
<Vertical List Display Example>

Clicking this button with a monitor variable in the list selected displays the [Find] window, and the maxi-
mum value, minimum value, local maximum value, local minimum value, and time axis of the graph can
be found. Refer to the following section for details.
� [Find] Window on page 269

Clicking this button with a monitor variable in the list selected displays the [Calculate] window, and the
area, average, and absolute average calculation results for the selected variable can be referenced. Refer to
the following section for details.
� [Calculate] Window on page 270

Hides the graph and maximizes the list.
This is enabled in the normal list view.

Clears the maximum list view and restores the list to its normal view (graph and list).
This is enabled in the maximum list view.

�� [Select Monitor Setting] Window

Click the [ ] button to display the [Select Monitor Setting] window. The [Monitor] tab pages displayed in the
window can be selected from [Monitor 1] to [Monitor 4].
The default setting is for only [Monitor 1] tab page to be displayed. For example, selecting [Monitor 3] and click-
ing the [OK] button will display the [Monitor 3] tab page.
A maximum of 16 monitor variables can be registered on a single [Monitor] tab page. The number of targets to
be monitored can be expanded by using multiple tab pages.

�� [Object Variable Setting] Window

Click the [ ] button to display the [Object Variable Setting] window. Variables displayed on a [File] tab page
can be registered to a [Monitor] tab page as monitor variables.
Use the following procedure to register a monitor variable.
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1. Select the variable to register in the list on the [File] tab page, and then click the [(1)
Object Variable Setting] button in the [Object Variable Setting] window.

The selected variable name will be displayed in [Set value].

2. Select the [Variable] field on the [Monitor] tab page, and then click the [Setting] button
in the [Object Variable Setting] window.
The variable will be added to the selected [Variable] field.

Information If you select [Difference between reference variables] or [Sum of reference variables] in the [Type] list box,
you can register the difference or sum of register values.

�� [Find] Window

Click the [ ] button with a monitor variable selected in the list to display the [Find] window. The maxi-
mum value, minimum value, local maximum value, local minimum value, and time axis of the of the selected
variable can be found.
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No. Item Description

(1) Target Variable The selected variable name is displayed.

(2) Find Target Select one of the following as the find target: “Maximum value”, “Minimum value”,
“Local maximum value”, “Local minimum value”, and “Time axis”.

(3) Find Area
Select the search range.
“Between A and B” cannot be selected when cursors A and B are hidden.

(4) Find from Top Searches from the top of the find area.

(5) Find to Backward Searches backward from the current position.

(6) Find to Forward Searches forward from the current position.

(7) Time Setting Set the destination time to jump to in units of ms.

(8) Go to Jumps to the data for the set time (proximity).

�� [Calculate] Window

Click [ ] with a monitor variable selected in the list to display the [Calculate] window. The area, aver-
age, and absolute average calculation results for the selected variable can be referenced.

No. Item Description

(1) Target Variable The selected variable name is displayed.

(2) Calculate Select one of the following as the calculation type: [Area], [Average], or [Absolute
average].

(3) Find Data
Select the search range.
“Between A and B” cannot be selected when cursors A and B are hidden.

Continued on next page.
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No. Item Description

(4) Results Area The calculation result is displayed.

(5) Calculate Executes the calculation.

(4) Optional Settings
Select [Option] from the [View] menu to display the [Option] window. There are five tab pages: [Set], [Graph],
[XY graph], [List], and [Print].

(a) [Set] Tab Page
This tab page is used to set the default directory for when trace data is imported or exported.

Selection Description

CPU The directory to which the SigmaWin+ AE is installed is set.

User setting Click the [Detail] button and set the directory with the [Browse Folder] window.

(b) [Graph] Tab Page
General graph settings can be made on this tab page. Select the item to be set from [Type], and then set the
detailed items.



6.2 Trace

272

The detailed items that are displayed depend on the item that was selected for [Type].

Item Description

Default Unit Set the default value for the X-axis unit (No. of data, ms, sec, mm).

Mark Width
Set the size of one X-axis mark.
<Example>
When the default unit is ms and the mark width is 50: one mark will be 50 ms.

Mark Value Span Set the span of values (step) displayed for marks.

Line Type Select a line type from solid line, wavy line, broken line, etc.

Line Width Select a line width from 1 pt. to 6 pt.

Color Clicking this button displays the [Color] window.

Font Select the font for characters.

Size Select a font size from 8 to 72 points. You can also input values directly. A decimal point cannot be
entered.

Continued on next page.
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Default Unit Set the default value for the X-axis unit (No. of data, ms, sec, mm).

Style

Set the font style as required. You can select more than one.
• B: Bold
• I: Italic
• U: Underline

Sample A sample will be displayed here when you set the font, size, and style.

(c) [XY Graph] Tab Page
Settings related to X-Y graph playback can be made on this tab page.

(d) [List] Tab Page
Settings related to the list area display can be made on this tab page.

Item Description

Number of File Page Select the default number of [File] tab page in the list area, from 1 to 8.

Monitor Data No.
Set the number of data items to be displayed in the list area while tracing is being executed.
All data is displayed when stopped or when a snapshot is taken.

(e) [Print] Tab Page
Settings related to the print object can be made on this tab page.
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Information Select [Print Setting] from the [File] menu to display the [Print Object Setting] window.
The content set on the [Option] window will be applied to the display items on the [Print Object Setting] window.
<Example>
When [List] is set to [Do not print] in the [Option] window, [List] is disabled in the [Print Object Setting] window.

6.2.6 Overview of Trace Manager Operations
The flow for using Trace Manager is given below.

1. Display the [Trace Manager] tab page.

2. Double-click the [Variable] field in the list area to display the text cursor, enter the regis-
ter or variable name to monitor, and press the [Enter] key. When entering a D register,
enter the name of the program to monitor in the [Program] field.
Refer to the following section for details on the setting items displayed in the window.

6.2.5 [Trace Manager] Tab Page on page 258

The background of the edited fields will change to blue.
3. Select [Save & Write] from the [File] menu.

A message dialog box will be displayed.

4. Click the [Yes] button.

This saves the setting, and the background color of the [Variable] field in the list returns to white.
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5. Click the [Start] button on the control panel.
A message indicating that data is being acquired will be displayed, and then a graph of the acquired
data will be displayed in the graph area.

6. Click the [Stop] button to stop tracing. Also, to upload the current information in trace
memory, click the [Snap] button.

This concludes the basic procedure.
The following table lists the other operations available in Trace Manager and the reference information.

Operation Reference

Deleting Trace Definitions and Trace Data 6.2.11 Deleting Trace Definitions and
Trace Data on page 282

Changing the Enabled/Disabled Setting of the Trace Definition Settings
6.2.12 Changing the Enabled/Disabled
Setting of the Trace Definition Settings
on page 283

Checking the Trace Status 6.2.18 Checking the Trace Status on
page 292

6.2.7 [XY Trace] Tab Page
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No. Item Description Reference

(1)

Trace Data Setting Select the axis and then set the trace target. (1) Trace Data Setting on page
276

Sampling and Trigger Settings Set the trace conditions.

Settings are the same as those in Real-
Time Trace.

(2) Sampling and Trigger Settings
on page 249

Start Trace/Stop Trace

Starts and stops the trace.
When the trace is started, the trace data is acquired and
displayed in real time.
When the trace is stopped, the buffer data of all traces is
acquired and displayed.

-

Read Again

Re-reads the trace data in the controller.
By executing re-reading, the content of the trace data
accumulated at that point can be checked. When re-read-
ing is executed during execution of a trace, the real time
display mode automatically turns OFF.

-

Monitor Data No.

The number of trace data to acquire from the controller
can be set.
The actual number of acquired trace data is displayed at
the bottom right of the graph.

-

Real Time Display When this check box is selected, the display shows the
data moving during tracing in real time. -

(2) Graph Toolbar Groups together the buttons used for analyzing trace
data. (2) Graph Toolbar on page 276

(3) XY Graph
The trace data is displayed. The graph toolbar, sliders
and cursors can be used to analyze trace data in the XY
Trace Window.

(3) XY Graph on page 277

(1) Trace Data Setting
Select the axis and then set the trace target.

No. Item Description

(1) X-YAxis Specification Select the X- and Y-axes.

(2) Trace Target
Set the trace target. There are two motion parameters as follows:
• IL□□10: Calculated position in machine coordinate system
• IL□□16: Machine coordinate system feedback position

(2) Graph Toolbar
The functions of each button are as follows.
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Button Function

Double-clicking this allows you to zoom the graph.

Dragging this allows you to scroll the graph. Double-clicking this also allows you to zoom the graph.

Dragging or double-clicking this allows you to zoom the graph.

Restores an enlarged graph to its original size.

Displays cursor A and the value at the intersecting point on the graph.

Displays cursor B and the value at the intersecting point on the graph.

Causes cursors A and B to move at a fixed width interlocked with each other.

Displays the [Open] window, and the trace data can be read.

The [Save As] window will be displayed.

Displays the list.

Copies an image of the graph to the clipboard.

(3) XY Graph
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No. Item Description

(1) Parameter Name The parameters selected for the trace target are displayed.

(2) X-axis, Y-axis The X-axis, Y-axis, and unit will be displayed.

(3) Difference The difference in values between the A and B cursor positions is displayed.

(4) The X and Yvalues at the intersecting point of cursor A and the graph, and the intersecting
point of cursor B and the graph are displayed.

(5)
Set the trace target.
• IL□□10: Calculated position in machine coordinate system
• IL□□16: Machine coordinate system feedback position

(6)
Moving the sliders horizontally and vertically allows you to rescale the graph.
Scaling can be set within 0.01x to 64x.

(7) Dragging these to the left and right moves cursors A and B.

(8) Clicking these arrow buttons makes the sliders move along the time axis by each individual
marked scan interval.
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6.2.8 Overview of XY Trace Operations
The flow for using XY trace is given below.

1. Display the [XY Trace] tab page.

2. Set [Trace Data Setting] and [Sampling & Trigger Setting] in that order, and then click
the [Start Trace] button.
Refer to the following section for details on the setting items displayed in the window.

6.2.7 [XY Trace] Tab Page on page 275

The trace will start, and the graph will be displayed in real-time.

3. To stop the trace, click the [Stop Trace] button.

Tracing will stop.

This concludes the basic procedure.
The following table lists the other operations available in XY Trace and the reference information.

Operation Reference

Deleting Trace Definitions and Trace Data 6.2.11 Deleting Trace Definitions and
Trace Data on page 282

Changing the Enabled/Disabled Setting of the Trace Definition Settings
6.2.12 Changing the Enabled/Disabled
Setting of the Trace Definition Settings
on page 283

Comparing Target Position and Feedback Position (2) Comparing Target Position and
Feedback Position on page 286

Measuring the Travel Time of the Axis 6.2.16 Measuring the Travel Time of the
Axis on page 289

Replaying the Axis Path 6.2.17 Replaying the Axis Path on page
290

Checking the Trace Status 6.2.18 Checking the Trace Status on
page 292

Saving Trace Data 6.2.19 Saving Trace Data on page 292

Reading Trace Data 6.2.20 Reading Trace Data on page 294

Continued on next page.
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Continued from previous page.

Operation Reference

Switching Between Graph View and List View 6.2.21 Switching Between Graph View
and List View on page 295

Copying an Image of the Graph 6.2.22 Copying an Image of the Graph
on page 296

6.2.9 Reading Trace Definition Files
This operation is possible only with Real-Time Trace.
By reading a file that was saved in the past, existing trace definitions (trace settings and sampling & trigger set-
tings) can be easily reused. Use the following procedure.

1. Select [Open Trace File] from the [File] menu.

The [Open] window will be displayed.

2. Select the file containing the trace definitions you want to reuse, and click the [Open]
button.
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The [Read trace data] window will be displayed.

3. Select the check box of trace settings you want to read and click the [Read] button.

This reads the sampling & trigger settings and trace settings that you selected.

This concludes the procedure.

6.2.10 Checking Sampling and Trigger Settings
This operation is possible only with Real-Time Trace.
You can check the sampling and trigger settings for a trace when you read an existing trace definition file and in
other situations. Use the following procedure.
Use one of the following methods to display the [Sampling & Trigger Setting] window.
• Select [Sampling & Trigger Setting Information] from the [Trace Data] menu.
• Right-click on the [Trace List] window, and select [Sampling & Trigger Setting Information] from the dis-
played menu.

The [Sampling & Trigger Setting] window will be displayed. Check the settings in the window.
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6.2.11 Deleting Trace Definitions and Trace Data
Use the following procedure to delete trace definitions and trace data acquired by the SERVOPACK.

1. Expand the [Scope] tree in the [System] window.
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2. Right-click on the trace group you want to delete, and select [Delete Trace Data].

A message dialog box will be displayed.

3. Read the message, and then click the [Yes] button.

This concludes the procedure.

6.2.12 Changing the Enabled/Disabled Setting of the Trace Definition
Settings
The trace definition settings can be switched between enabled and disabled.
Examples of use of this function are shown below.
Tracing is no longer possible when the trace buffer size set to Scope 1 to Scope 4 exceeds the maximum applica-
ble trace buffer size. Without this function, some trace groups must be deleted to reduce the total trace buffer
size. When a trace group is deleted, trace definitions must be set again. However, if trace definitions are disabled,
the total trace buffer size will be reduced temporarily and tracing can be performed without deleting a trace
group.
Use the following procedure.
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1. Expand the [Scope] tree in the [System] window.

2. Right-click on the trace group whose settings you want to change, and select [Enable/
Disable Trace Settings].

A message dialog box will be displayed.

3. Read the message, and then click the [Yes] button.

This concludes the procedure.

6.2.13 Scaling the Trace Data Waveform
This operation is possible only with Real-Time Trace.
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You can scale the waveform of the trace data and move the position of the waveform. By editing the size and
position of the waveform, you can compare the waveform with other waveforms to analyze it.
Edit trace data in the [Offset/Scale Edit of Waveform] window. Use one of the following methods to display the
[Offset/Scale Edit of Waveform] window.
• Select [Offset/Scale Edit of Waveform] Enable [Trace Data] menu.
• Right-click a register on the [Trace List] window, and select [Offset/Scale Edit of Waveform] from the dis-
played menu.
Information •When monitor data is updated, changes will be reset.

•When a trace group name is selected, all of the waveforms in the group can be edited collectively.

The [Offset/Scale Edit of Waveform] window will be displayed.

No. Display Function

(1) Trace Name The trace name and file name are displayed.

(2) Offset Move Buttons Moves the waveform of the specified trace target register up, down, left, and right.

(3) Scale Adjustment Slider Scales the data amplitude of the specified trace target register.

(4) [Default] Button Restores the edited settings to the default settings.
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6.2.14 Analyzing Differences Between Target Values and Actual Values
You can analyze the trace data by using the [Offset/Scale Edit of Waveform] window and toolbar buttons.

(1) Comparing I/O Registers and M Registers
This operation is possible only with Real-Time Trace.

1. Display the trace data to analyze on the graph.

2. Select [Offset/Scale Edit of Waveform] from the [Trace Data] menu bar. Or, right-click on
[File & History Data] on the [Trace List] window, and select [Offset/Scale Edit of Wave-
form] from the displayed menu.

3. Using the arrow keys in the [Offset/Scale Edit of Waveform] window, move the wave-
form to the location you want to compare.

4. Click cursors A and B or cursors C and D in the graph toolbar to display the cursor, and
align the cursor with the register to analyze.

5. Analyze the difference between the waveform of the preset register and the waveform
of the actually output register.

This concludes the procedure.

(2) Comparing Target Position and Feedback Position
This operation is possible only with XY Trace.
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1. Click cursors A and B in the graph toolbar to display the cursor.

2. Select the target position and feedback position for [Cursor A] and [Cursor B].

3. Align the sliders with the time to analyze.

4. Compare the difference value between the target position and feedback position.

Information The target location can be scaled by using the graph toolbar.
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This concludes the procedure.

6.2.15 Comparing with Past Acquired Data
Compare trace data read from the SERVOPACK with trace data acquired in the past.
This operation is possible only with Real-Time Trace.

1. Read trace data acquired in the past.
Refer to the following section for operating details.

6.2.20 Reading Trace Data on page 294
Awaveform of the trace data will be displayed.

2. Using the arrow keys in the window, move the data start position to the desired
location.

3. Select [Offset/Scale Edit of Waveform] from the [Trace Data] menu. Or, right-click on
[File & History Data] on the [Trace List] window, and select [Offset/Scale Edit of Wave-
form] from the displayed menu.
The [Offset/Scale Edit of Waveform] window will be displayed.
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4. Use the [Offset/Scale Edit of Waveform] window to compare the data with the previous
trace data.
Refer to the following section for details on the [Offset/Scale Edit of Waveform] window.

6.2.13 Scaling the Trace Data Waveform on page 284

This concludes the procedure.

6.2.16 Measuring the Travel Time of the Axis
This operation is possible only with XY Trace.

1. Click cursors A and B in the graph toolbar to display the cursor.
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2. Set [Cursor A] and [Cursor B] to the same data.

3. Select the two points to measure.

4. Measure the time difference between the two points using the sliders.

Information The target location can be scaled by using the graph toolbar.

This concludes the procedure.

6.2.17 Replaying the Axis Path
This operation is possible only with XY Trace.
Use the following procedure to replay the axis path.
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1. Click cursors A and B in the graph toolbar to display the cursor.

2. Select [Cursor A] and [Cursor B].

3. Move the sliders and analyze the axis path.

This concludes the procedure.
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6.2.18 Checking the Trace Status
The trace status can be checked when the [Scope] tree is expanded in the [System] window.

The details of the trace status display are as follows.

Connection
Status Status Description

Online

Running State while trace data is being acquired

Waiting for start trigger State when waiting for start trigger

Stopped State while trace is stopped

Trace definition does not exist State when trace definition is not set

Trace settings disabled State when trace definition setting is disabled

Unconfirmed trace definition
exists State when trace definition during editing is present

Offline

Trace definition exists State when trace definition is set

Trace definition does not exist State when trace definition is not set

Trace settings disabled State when trace definition setting is disabled

6.2.19 Saving Trace Data
This operation is possible only with Real-Time Trace and XY Trace.
Use the following procedure to save trace data.

1. With the trace data to save already displayed, select [Save in External File] from the
[File] menu.
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Information With XY Trace, save operations are also possible using the [Save in External File] button on the toolbar.

The [Save As] window will be displayed.

2. Set [Save in], [File name], and [Save as type], and then click the [Save] button.



6.2 Trace

294

3. Select the ladder programs to save, and click the [Save] button.

The selected trace data will be saved with the content set in step 2.

This concludes the procedure.

6.2.20 Reading Trace Data
This operation is possible only with Real-Time Trace and XY Trace.
Use the following procedure to read trace data that was saved.

1. Select [Open External File] from the [File] menu.

Information When trace data has already been read, that trace data will be read when the trace definition check box at
[File & History Data] on the [Trace List] window is selected.

The [Open] window will be displayed.
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2. Click the trace data file to read, and click the [Open] button.

3. Select the check box of trace data you want to read and click the [Read] button.

The selected trace data will be read.

This concludes the procedure.

6.2.21 Switching Between Graph View and List View
This operation is possible only with Real-Time Trace and XY Trace.
The monitor and history data currently displayed as a graph can be displayed in list format.
Select [List View] from the [Trace Data] menu or select the [List View] button to switch between the graph view
and list view. You can also switch the view during tracing.

Information The trace data displayed in the list can be pasted to an Excel file.
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6.2.22 Copying an Image of the Graph
This operation is possible only with Real-Time Trace and XY Trace.
Select [Copy Graph] from the [Graph] menu or click the [Copy Graph] button on the toolbar to copy the graph
image to the clipboard.
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7
Security

This chapter describes the security functions available in the SigmaWin+ AE for users, SERVOPACK,
projects, and programs.
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7.1 User Management
You can register and modify the users that can open project files.
This function can be set only when a project file is open or a SERVOPACK is connected. Access and write privi-
leges to the data in the SERVOPACK's RAM are set when using a direct connection to the SERVOPACK or a
project link connection.

7.1.1 Adding a New User

1. Select [Environment Setting] from the [File] menu.

2. Select [Security] - [User Registration].
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3. Click the [New] button.

The [User Registration] window will be displayed.

4. Set the following items, and then click the [OK] button.
Refer to text at the bottom of the window for the setting conditions of the item and other information.
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Information The higher the numbers of the user privilege the higher the privilege levels.
The read privilege and write privilege levels are items created to maintain program security.
To open a program, a user must have a user privilege level that is greater than or equal to the read privilege
level of that program. In the same manner, to edit and save a program, a user must have a user privilege level
that is greater than or equal to the write privilege level of that program.

This concludes the procedure.

Important

There is no way to recover a password if the user forgets it, so the user will no longer be able to open the project file. Be
careful so that passwords are not forgotten.

7.1.2 Changing Registered Information

1. Select [Environment Setting] from the [File] menu.

2. Select [Security] - [User Registration].
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3. When the user with information to change is selected, click the [Modified] button.

The [User Registration] window will be displayed.

4. Change the required items.

5. Click the [OK] button.

This concludes the procedure.

Information If the selected user is the default user, you can change only the default and FTP privileges.

7.1.3 Deleting a Registered User

1. Select [Environment Setting] from the [File] menu.
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2. Select [Security] - [User Registration].

3. When the user to delete is selected, click the [Delete] button.

A message dialog box will be displayed.
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4. Click the [OK] button.

This concludes the procedure.

7.1.4 Checking and Switching the User

1. Select [Environment Setting] from the [File] menu.

2. Select [Security] - [User Registration].
The current user is displayed in bold text.
To switch the user, you will need the [User Name] and [Password] for the user to switch to when you
next log in. Once you have this information, proceed to the next step.
If you do not need to switch the user, skip the rest of this procedure. Click the [Cancel] button.
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3. Select [Security] - [Default User Setting].

4. Clear the [Select the default user] check box, and then click the [OK] button.

5. Close the project file or disconnect communications with the SERVOPACK.

6. Open the project file or connect to the SERVOPACK.
The [Security] dialog box will be displayed.
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7. Enter [User Name] and [Password] for the user to switch to, and then click the [OK]
button.

The project file will be opened or the connection to the SERVOPACK will be started with the user
information you entered.

This concludes the procedure.
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7.2 Security Settings for the SERVOPACK
You can protect programs from being read from the SERVOPACK by changing the SERVOPACK’s security set-
tings. (This is called online security.) Use the following procedure to enable security on the SERVOPACK.

1. Confirm that the user privileges are R7W7.

Information You can confirm the user privileges by clicking [File] - [Environment Setting] to display the [Environment
Setting] window, and then clicking [Security] - [User Registration] in that window.

2. Select [Security Setting] from the [Online] menu.

The [Security Setting] window will be displayed.

3. Set the following items, and then click the [Set] button.

Item Description

Apply File Reading Restric-
tion (Ladder/Motion/C
Language)

Select the check box.

Restriction Privilege

Set the restriction privilege. (Setting range: 0 to 7)
Only users with a privilege level at least as high as this setting can open SERVOPACK pro-
grams and read programs from SERVOPACK.
You can confirm user privileges in the [Environment Setting] window that is displayed by
selecting [Environment Setting] from the [File] menu.

Continued on next page.
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Continued from previous page.

Item Description

Security Key
Set a password.
<Setting Conditions>
Between 5 and 8 alphanumeric characters. The password is case sensitive.

Security Key Confirmation Enter the password again that was set in [Security Key].

A message dialog box will be displayed.

4. Click the [OK] button.

A message dialog box will close.

5. Click the [Close] button.

The [Security Setting] window will be closed.
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6. Select [Save to Flash] from the [Online] menu.

The [Transfer Program - Save to Flash] window will be displayed.

7. Click the [Start] button.

A message dialog box will be displayed.

8. Read the message, and click the [Yes] button or the [No] button.

Save to flash will start, and the following window will be displayed.
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Information If the SERVOPACK is in RUN mode, the following message will be displayed. The data transfer to the SER-
VOPACK starts when you click the [Yes] button or the [No] button.

When save to flash is completed, a message dialog box will be displayed.

9. Click the [OK] button.

A message dialog box will close.

Information If you clicked the [No] button in step 8, the following message will be displayed.
Click the [Yes] button to put the CPU unit in the RUN status.

This concludes the procedure.

Important

When online security is enabled, any attempt to open a program with a higher privilege level will cause the following mes-
sage to appear, and reading the program will be denied.

Important

To permanently or temporarily disable online security, or to change the security key or the restriction privilege, enter the
security key.
If security is temporarily disabled, it will become enabled again after the power is turned OFF and ON again.
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7.3 Security Settings for Project Files
This section gives the procedures for managing security settings for project files.

7.3.1 Protecting Project Files with a Password
To protect project files with a password, you must first set the password. Use the following procedure.

1. Open the project file for which to enable password protection.

2. Select [Environment Setting] from the [File] menu.

Displays the [Environment Setting] window.

3. Select [Security] − [Project Password].



Se
cu
rit
y

7

7.3 Security Settings for Project Files

313

4. Select the [When the project is opened, the password is input] check box, and then
click the [Modified project password] button.

The [Modified the project password] window will be displayed.

5. Set the following items, and then click the [OK] button.

Item Description

Password
Set a password.
Refer to text at the bottom of the window for the setting conditions.

Password (confirm) Enter the password that was set in [Password].

The [Modified the project password] window will be closed.
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6. Click the [OK] button.

The [Environment Setting] window will be displayed.

7. Select [Close Project] from the [File] menu.

A message dialog box will be displayed.

8. Click the [Yes] button.

A message dialog box will be displayed.
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9. Click the [Yes] button.

The project file will close, and password protection will be enabled for the project file.

This concludes the procedure.

7.3.2 Opening a Password-protected Project File

1. Open the project file.
The [Security] window will be displayed.

2. Enter the password that was set previously, and click the [OK] button.

The project file will be opened.

Information If the password is incorrect, the following dialog box will be displayed.

Click the [Retry] button and enter the password again.

This concludes the procedure.

7.3.3 Changing the Project File Password
To change the password of a project file, perform the same procedure that you used to protect the project file
with a password. Refer to the following section for details.

7.3.1 Protecting Project Files with a Password on page 312
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7.3.4 Disabling Password Protection of a Project File
Use the following procedure to disable password protection of a project file.

1. Open the project file for which to disable password protection.

2. Select [Environment Setting] from the [File] menu.

The [Environment Setting] window will be displayed.

3. Select [Security] − [Project Password].
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4. Clear the [When the project is opened, the password is input] check box, and then click
the [OK] button.

This concludes the procedure.
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7.4 Security Settings for Programs
This section gives the procedures for managing security settings for programs.

7.4.1 Protecting Programs with a Password
To protect programs with a password, you must first set a password. Use the following procedure.

1. Establish an online connection or open a project file.

2. In the [Ladder] window, right-click the program for which to set the password, and then
select [Set the Password].
Note:
You can select more than one drawing.
•To open a number of consecutive drawings: Select the first drawing in the group of drawings to open, hold down the Shift key,
and then select the last drawing in the group of drawings to open.
•To open a number of drawings that are not consecutive: Hold down the Ctrl key and click the drawings to open.

<If Only One Drawing Is Selected> <If More Than One Drawing Is Selected>

The [Program Password] window will be displayed.

3. Set the following items, and then click the [OK] button.

Information • If you can enter a password into [Current Password], security is already active. Refer to the following
section.

7.4.3 Changing Program Passwords on page 319
• If more than one drawing is selected and a password was previously set for one of the drawings, an error
will occur.
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Item Description

Password
Set a password.
Refer to text at the bottom of the window for the setting conditions.

Password (Confirm) Enter the password that was set in [New Password].

The password-locked icon will be displayed next to the icon of the program set with the password.

This concludes the procedure.

7.4.2 Opening a Password-protected Program
If you attempt to open a password-protected program, the [Program Password] window will be displayed.

Information You can open more than one drawing at the same time.
•To open a number of consecutive drawings: Select the first drawing in the group of drawings to open, hold down the
Shift key, and then select the last drawing in the group of drawings to open.
•To open a number of drawings that are not consecutive: Hold down the Ctrl key and click the drawings to open.

Enter the password in the [Program Password], and then click the [OK] button to open the program. If more than
one drawing is selected, you can open only the drawings that have the password that was entered.

7.4.3 Changing Program Passwords
Use the following procedure to change the password of a program.

Information You cannot change the password for more than one drawing at the same time. Change the passwords one drawing at a
time.
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1. Establish an online connection or open a project file.

2. In the [Ladder] window, right-click the program for which to change the password, and
then select [Set the Password].

The [Program Password] window will be displayed.

3. Set the following items, and then click the [OK] button.

Item Description

Current Password Enter the old password. If you enter the wrong password, an error will be displayed after you
click the [OK] button.

New Password
Set the new password.
Refer to text at the bottom of the window for the setting conditions.

Password (Confirm) Enter the password that was set in [New Password].

This concludes the procedure.

7.4.4 Disabling Password Protection of a Program
Use the following procedure to disable password protection of a program.

1. Establish an online connection or open a project file.
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2. In the [Ladder] window, right-click the program for which to disable the password, and
then select [Cancel the Password].

The [Program Password] window will be displayed.

3. Enter the password in the [Program Password] box, and then click the [OK] button.

The password-locked icon will disappear from the program that was selected in step 2.

This concludes the procedure.
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8
Convenient Functions

This chapter describes convenient functions in the SigmaWin+ AE, such as the environment settings, print-
ing, and importing and exporting data.
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8.1 Environment Setting
Select [File] - [Environment Setting] from the menu bar to display the [Environment Setting] window. You can
configure the various settings related to the SigmaWin+ AE and project files on this window.
This section describes setting items on the [Environment Setting] window in the order the setting items are dis-
played in the tree.

8.1.1 [System] - [General]

Item Description

The delimiter display of the
integer

If set to [Yes], a comma will be inserted into numeric values and current values every third digit.
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8.1.2 [System] - [Communication Setting]

Item Description

Logon Timeout Set the duration of the timeout when connecting to the SERVOPACK. An error will be displayed if the
connection to the SERVOPACK is not completed within the set time.

Communication Timeout Set the duration of the communications timeout with the SERVOPACK. An error will be displayed if
communications with the SERVOPACK are not restarted within the set time when communications are
lost.

Number of retry Set the number of retries when communications with the SERVOPACK are lost.

8.1.3 [System] - [Controller Type]

Item Description

List of Target Controller Type The SERVOPACK models are displayed that can be selected when creating a project file.

8.1.4 [System] - [Slave Type]
These settings cannot be used.
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Item Description

List of Target Slave Type The slave models are displayed that can be allocated in module configuration definitions.

8.1.5 [System] - [Language]

Item Description

Language Select the language displayed in the SigmaWin+ AE from English, Japanese, Chinese (simplified), or
Chinese (traditional). The change is applied after the SigmaWin+ AE is restarted.

8.1.6 [System] - [Development environment]
These settings cannot be used.

8.1.7 [Security] - [User Registration]
Refer to the following section for details on the settings.

7.1 User Management on page 300
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8.1.8 [Security] - [Project Password]
Refer to the following section for details on the settings.

7.3 Security Settings for Project Files on page 312

8.1.9 [Security] - [Default User Setting]
The user name and password set here will be required when opening a project file or connecting to the
SERVOPACK.
A project file can be opened without logging in if the user with the same settings is registered in the project file.

8.1.10 [Security] - [Online Security]
The setting items are the same as the setting items for online security described in the following section.

7.2 Security Settings for the SERVOPACK on page 308



C
on

ve
ni
en

tF
un

ct
io
ns

8

8.1 Environment Setting

329

8.1.11 [Setup] - [System Setting]

Item Description

Write Protect Select whether to permit writing program data to the SERVOPACK.
If set to [Write Protect], data cannot be transfered to the SERVOPACK and program editing and compil-
ing cannot be performed when online.

8.1.12 [Setup] - [Scan Time Setting]

Item Description

Use an MP2000 option module Cannot be used.

Setting Value Set the scan processing time.

Current Value The actual scan processing time is displayed in real-time when online.

Maximum Value The maximum value of the actual scan processing time is displayed.
The maximum value can be edited. If the actual scan processing time exceeds the edited value, the value
is updated.
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8.1.13 [Ladder] - [General]

Item Description

Create new CP ladder If set to [Use], [New CP Ladder] will be displayed in the menu that is displayed when you right-click a
program in the [Ladder] window.

Multiple coil check If set to [Enable], a check will be performed for registers that are used multiple times in coil instructions
when the ladder program is compiled. If multiple registers are being used, an error message will be dis-
played in the [Output] window.

Compile to ver.5 compatible If set to [Enable], the ladder program will be compiled in a data format that can also be used in the
MPE720 Ver. 5.

Allocation of function keys The function keys are allocated differently in the MPE720 Ver. 7 and Ver. 6.
If set to [Ver. 6 Compatible], the function keys will be allocated the same as in the MPE720 Ver. 6.

Easy register input If set to [Enable], suggestions will be displayed when entering a register.

Automatically register address
registers

If set to [Enable], address registers will be automatically registered as variables when you use instruc-
tions for which address registers are specified. Refer to the following section for details.

4.1.8 Automatically Registering Address Registers as Variables on page 142

Provide notification of possible
overflows

Awarning will be displayed in the [Output] window if there is the possibility that an overflow may
occur during CP ladder conversion.

Use robot control instructions If set to [Disable], the operational performance of the SigmaWin+ AE will be improved.
Note:
MLx function structures will be simplified, so there will be an impact on the functionality and operations
related to MLx functions. To use robot control instructions, set this item to [Enable].

Automatically assign D registers
to Param operand

If set to [Enable], the D registers that are not used in the drawing are automatically assigned to the
[Param] operand when an MLx instruction is inserted into the drawing.

8.1.14 [Ladder] - [Tab]



C
on

ve
ni
en

tF
un

ct
io
ns

8

8.1 Environment Setting

331

Item Description

Tab size Set the size of the tab (white space) that is inserted when the Tab key is pressed in the editor on the
[Expression Editor] window and other windows.

8.1.15 [Ladder] - [Color]
You can change the colors of the various elements displayed in the Edit Ladder Program Window.

8.1.16 [Ladder] - [Font]
You can set the fonts of the various elements displayed in the Edit Ladder Program Window.
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8.1.17 [Ladder] - [Display]
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Item Description

Display Item Program Comment Set whether to show or hide program comments and the maximum number of lines to
use for those comments.

Rung Comment Set whether to show or hide rung comments and the maximum number of lines to use
for those comments.

Variable/Register Set whether to show or hide variables or registers and the maximum number of lines to
use for those comments.

Comment Set whether to show or hide register comments, the maximum number of lines to use for
those comments, and the maximum number of characters to use for comments in the
Expression instruction.
If a comment exceeds the maximum number of characters that is set, "-" will be
displayed.

Display Option Variable wrapping Wraps the variable if the variable is long.

Variable reduce Shortens the variable using "~" if the variable is long.

Variable address Displays the address of the register in the variable.

Rung wrapping Displays one rung using two lines if the window is narrow.

Show nesting Uses shading for the nested structure of IF, FOR, and WHILE instructions.

"VAR_" reduce Omits the "VAR_" prefix of variables registered for local registers.

Grid Border If this check box is selected, the grid lines are displayed.

Rows Set the number of rows to display in the Edit Ladder Program window.
If set to [AUTO], the number of rows changes according to the width of the window.

Width Set the width of the rows using the slider.

8.1.18 [Ladder] - [Edit]
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Item Description

Rung A rung is automatically
inserted when a new dia-
gram is created.

If this check box is selected, a drawing with one rung already inserted will be opened
when creating a new drawing.

Multiple rungs are inserted
at the same time.

If this check box is selected and the number of rungs is set, that many rungs can be
inserted at one time.

Cursor The cursor moves to the
next after inserting Rung or
Rung comment.

If this check box is selected, the cursor is displayed on the rung after the rung is inserted.

An instruction is inserted
before the cursor.

If this check box is selected, an instruction is inserted before the object selected by the
cursor.

Cursor Moving Mode The cursor can be moved when you press the Enter key in a program. You can change
the order of the movement with this item.

8.1.19 [Ladder] - [KeyAssign]
The list of keys to use when entering instructions is displayed.
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8.1.20 [Variable] - [General]

Item Description

variable/comment Select the reading source of the global register variables/comments to display in the SigmaWin+ AE
from [Read from controller] or [Read from project]. The setting is enabled the next time the SERVO-
PACK is connected.

Display comments allocated to
the user-defined structure

If set to [Enable], user-defined structure comments are displayed when user-defined structures are allo-
cated to variables. However, register comments are excluded if registered to variables.

Current Comment Select the type of comments that are displayed and updated from [Standard Comment], [Extended Com-
ment 1], [Extended Comment 2], and [Extended Comment 3].

Display the Autocomplete list for
variables and registers

Displays a list of possible variables and registers.

8.1.21 [Variable] - [Variable]

Item Description

Variable Display Format Set the display format of variables, registers, and comments.
If [Display Register] or [Display data type of structures] are selected, the "ex.)" label will change accord-
ing to the settings.

Data Processing of Copy/ Drag Select the data to store in the clipboard when copying or dragging a variable.



C
on

ve
ni
en

tF
un

ct
io
ns

8

8.1 Environment Setting

337

8.1.22 [Variable] - [Automatic Allocation]

Item Description

Register Address of Automatic
Allocating

Set whether to automatically allocate the range of registers to use.

8.1.23 [Monitor] - [System monitor]

Item Description

Automatically notified when the
alarm occurs

If set to [Notify], the [System Monitor] window is automatically started and the alarm information is dis-
played when an alarm occurs.

Automatically notified when the
battery alarm occurs

If set to [Notify], the [System Monitor] window is automatically started and the alarm information is dis-
played when a battery alarm occurs.
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8.1.24 [Transfer] - [Transfer]

Item Description

Check before write into
controller.

If set to [Yes], a message asking for confirmation to stop the CPU will be displayed before writing data
into the SERVOPACK.

Display when the transfer/com-
pare ended.

If set to [Enable], a message will be displayed when the transfer or comparison has completed.

Disable main program processing If set to [Enable], the main program will be disabled after a write error occurs.

Display a warning about over-
writing drawing

If set to [Enable], a warning message will be displayed when overwriting the program with the same
drawing number in the destination.

8.1.25 [Transfer] - [Compare]
You can change the colors of locations with differences that are displayed in the comparison window.
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8.1.26 [Transfer] - [MPLoader]

Item Description

Transfer Setting Select the MPLoader version.

Transfer File Settings Click the [Set] button and select the data to transfer in the displayed window.

Clear the memory of Controller Select whether to clear the memory of the SERVOPACK after the transfer.

Backup the controller's data
before transfer

If this check box is selected, the SERVOPACK data is backed up before the transfer.

The flash saving is executed after
transfer

If this check box is selected, save to flash memory is executed after the transfer.

Stop the controller's CPU when
transfer

If this check box is selected, the SERVOPACK's CPU is stopped during the transfer.

8.1.27 [Print] - [Ladder]

Item Description

Circuit auto-reduction print If set to [Print], the drawing is reduced to fit the width of one page when printing.

Print the cross reference
information

If set to [Print], the drawing is printed with the cross reference information displayed to the right of the
ladder program.

Closed Scope is opened and
prints

If set to [Print], the drawing is printed with all instruction objects displayed that were reduced.
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8.1.28 [Message] - [General]

Item Description

Display the message before the
connecting, disconnecting or
closing

If set to [Yes], a confirmation message is displayed when connecting/disconnecting the SERVOPACK
and when closing the project file.

Display confirmation message to
overwrite the project

If set to [Enable], an overwrite confirmation message is displayed when closing the project file.
If set the [Disable], the project file is automatically overwritten.

Display a confirmation message
to ask if you want to continue the
search

If set to [Yes], a confirmation message is displayed when the search reaches the beginning or end of the
program.

Display a warning if there are
compatibility problems with units

If set to [Yes], a warning message is displayed if there is a risk that units in the module configuration
definition cannot be displayed in older versions of MPE720.
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8.2 Printing
The SigmaWin+ AE has the following printing functions.
• Printing ladder program
• Printing program information, register information, and definition information
The printing procedures are given below.

8.2.1 Printing Drawings
This section describes the settings and operations for printing ladder program.

(1) Page Setup
Select [Page Setup] from the [File] menu to display the [Page Setup] window.
You can set the paper size, orientation, and margins here.

(2) Print Preview
Select [Print Preview] from the [File] menu to display the print preview tab page in the center window.
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Item Description

[Print] Button Displays the [Print] window. You can set up the page and print the drawing.

/
Moves between pages when the print preview has multiple pages.

Changes the number of pages that are displayed when the print preview has multiple pages. Click this
button to switch between displaying one page and two pages.

/ Changes the magnification in three steps.

[Close] Button Exits the print preview.

(3) Printing
There are the following two methods that you can use to print a program drawing.
• Printing from the [File] menu
• Printing from the [Ladder] window
The procedures are given below.

(a) Printing from the [File] Menu
Use the following procedure to print a drawing from the [File] menu.

1. Open the drawing to print.

2. Select [Print] from the [File] menu.
The [Print] window will be displayed.
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3. Set the necessary items, and then click the [OK] button.

This concludes the procedure.

(b) Printing from the [Ladder] Window
Use the following procedure to print a drawing from the [Ladder] window.

1. Right-click the drawing to print in the [Ladder] window, and select [Print].

Information If there are drawings on the level under the selected drawing, the following message dialog box will be
displayed.
To print only the selected drawing, click the [Print] button. To also print the program under the selected
drawing, click the [Select] button.

The [Print Setup] window will be displayed.

2. Set the necessary items, and then click the [OK] button.

This concludes the procedure.

(4) Printing Cross Reference Information
If you set the following items in the [Environment Setting] window, you can print the cross reference information
displayed to the right of the ladder program. The cross reference information can be printed only when the proj-
ect file is opened offline.



8.2 Printing

344

The cross reference information is displayed in the following format: program number/step number + additional
information.

Item Description Display Example

Program Number
The program numbers are displayed in the following order.
High-speed → low-speed → start → function
Level 1 → level 2

H
H01.01
FUNC01

Step Number The step number is displayed as a four digit number.
0001
1000

Additional Information
An index is displayed as "i" or "j".

H01/0010i
H01/0010j

An output register is displayed as "w". H01/0010w

8.2.2 Printing Program Information, Register Information, and
Definition Information
In the Print Manager, you can print program information, register information, and definition information. Use
the following procedure.

1. Select [Utility] - [Print builder] from the launcher.
The [Print Manager] window will be displayed.

Information When you open the [Print Manager] window, the [List Manager] window will open at the same time and
show the printing status.
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2. Select the items to print.

3. Select [Print] from the [Print] menu.

The [Execute print] window will be displayed.
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4. Set the printing targets and margins, and click the [Execute] button.

The [Print Setup] window will be displayed.

5. Set the necessary items, and then click the [OK] button.

This concludes the procedure.
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8.3 Export/Import
This section describes the procedures to export and import data in the SigmaWin+ AE.

8.3.1 Ladder Program

(1) Exporting Data
Use the following procedure to export ladder program.

Important

You cannot export a program when in online mode.

1. Open the project file.

2. Perform one of the following operations depending on the SERVOPACK model and the
program to export.

Program to Export Operation

Ladder program In the [Ladder] window, right-click on [Ladder program], and select [Export] - [Export Ladder
Program].

The [Export] window will be displayed.
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3. Select the check box of the programs to export, and click the [Export] button.

The [Browse For Folder] window will be displayed.

4. Select the destination folder, and click the [OK] button.

The data will be exported, and the results will be displayed in the [Output] window.
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5. Confirm that the exported files have been stored in the selected folder.
The file that will be exported is a YPI file.

This concludes the procedure.

(2) Importing Data
Use the following procedure to import a ladder program.

Important

You cannot import a program when in online mode.

1. Open the project file.

2. Perform one of the following operations depending on the SERVOPACK model and the
program to import.

Program to Import Operation

Ladder program In the [Ladder] window, right-click on [Ladder program], and select [Import] - [Import Ladder
Program].

The [Browse For Folder] window will be displayed.
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3. Select the folder where the program to import is stored, and click the [OK] button.

4. Select the check box of the programs to import, and click the [Import] button.

The data will be imported, and the results will be displayed in the [Output] window.
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5. Select [Compile Program Being Edited] from the [Compile] menu.

This concludes the procedure.

8.3.2 Ladder Program Line Comments

(1) Exporting Data
Use the following procedure to export ladder program line comments.

Important

You cannot export ladder program line comments when in online mode.

1. Open the project file.

2. In the [Ladder] window, right-click on [Ladder program], and select [Export] - [Export
Ladder Program Line Comments].

The [Save As] window will be displayed.
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3. Select the destination folder for the file, enter the file name, and click the [Save] button.

The data will be exported, and the results will be displayed in the [Output] window.

4. Confirm that the exported files have been stored in the selected folder.

This concludes the procedure.

(2) Importing Data
Use the following procedure to import ladder program line comments.

Important

•You cannot import ladder program line comments when in online mode.
•You can import a ladder program only when there is a program with the same name as the file name to import in the proj-
ect file.

1. Open the project file.
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2. In the [Ladder] window, right-click on [Ladder program], and select [Import] - [Import
Ladder Program Line Comments].

The [Open] window will be displayed.

3. Select the folder where the program to import is stored, and click the [Open] button.

The data will be imported, and the results will be displayed in the [Output] window.

This concludes the procedure.



8.3 Export/Import

354

8.3.3 Program Properties
Use the following procedures to export the properties information of a ladder program to a CSV file.

Use the following procedure to export the properties information of a ladder program.

1. Establish an online connection or open a project file.

2. In the [Ladder] window, right-click on [Ladder program], and select [Export] - [Export
Ladder Program Properties].

The [Ladder Display Property] window will be displayed.

3. Select the properties to export, and click the [OK] button.

The [Save As] window will be displayed.
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4. Set the file name, and click the [Save] button.

The data will be exported, and the results will be displayed in the [Output] window.

This concludes the procedure.

8.3.4 Watch Data

(1) Exporting Data
Use the following procedure to export watch data (variables or registers) registered to the [Watch] window.

1. Establish an online connection or open a project file.

2. Register the watch data to export to the [Watch] window.
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3. Right-click on the [Watch] window, and select [Export].

The [Save As] window will be displayed.

4. Specify the destination folder and file name, and click the [Save] button.

The data will be exported, and the results will be displayed in the [Output] window.

This concludes the procedure.

(2) Importing Data
Use the following procedure to import watch data (variables or registers).



C
on

ve
ni
en

tF
un

ct
io
ns

8

8.3 Export/Import

357

1. Establish an online connection or open a project file.

2. Right-click on the [Watch] window, and select [Import].

The [Open] window will be displayed.

3. Specify the CSV file to import, and click the [Open] button.

4. Select the import method, and click the [OK] button.
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Important

If the SigmaWin+ AE is connected to a SERVOPACK, the following message will be displayed. Make sure that
the application that is currently in execution will not be adversely affected before you execute the import.

The data will be imported, and the results will be displayed in the [Output] window.

This concludes the procedure.

8.3.5 Register Data
You can export register data to or import register data from CSV files to easily back up or change the register
data. Users may also create the data that is imported.

(1) Exporting Data
Use the following procedure to export register data.

1. Establish an online connection or open a project file.

2. Select [Export] from the [File] menu.

The [Export] window will be displayed.
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3. Click the [Register data] button.

The [Save As] window will be displayed.

4. Specify the destination folder and file name, and click the [Save] button.

The [Register data export] window will be displayed.
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5. Enter the following items, and click the [Export] button.

(1) The first address of the registers to export
(2) The program name (for local registers only)
(3) The number of registers from the first address of the registers to export

The data will be exported, and the results will be displayed in the [Output] window.

6. Confirm that the exported data has been stored in the selected folder.

Important

If a warning dialog box appears, the specified register address may be outside the register range, or the format
may be incorrect. Change the value and try again.

This concludes the procedure.

(2) Importing Data
Use the following procedure to import register data.
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1. Select [Import] from the [File] menu.

The [Import] window will be displayed.

2. Click the [Register data] button.

The [Open] window will be displayed.

3. Select the CSV file to import, and click the [Open] button.

The [Register data import] window will be displayed.
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4. Select the check box of the registers to import, and click the [Import] button.

The data will be imported.

Important

If the SigmaWin+ AE is connected to a SERVOPACK, the following message will be displayed. Make sure that
the application that is currently in execution will not be adversely affected before you execute the import.

This concludes the procedure.

8.3.6 Global Variables and Comments

(1) Exporting Data
Use the following procedure to export global variables and comments.

1. Establish an online connection or open a project file.

2. Select [Export] from the [File] menu.

Information You can also right-click on the [Comment List] tab page and select [Export] - [Export the global variable and
comment].
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The [Export] window will be displayed.

3. Click the [Variable and comment] button and select [Export the global variable and
comment].

A message dialog box will be displayed.

4. Select [Yes] or [No].

The [Save As] window will be displayed.

5. Specify the destination folder and file name for the export data, and click the [Save]
button.

The [Export] window will be displayed.
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6. Select the check box of the variables and comments to export, and click the [Export]
button.

The data will be exported.

This concludes the procedure.

(2) Importing Data
Use the following procedure to import global variables and comments.

1. Establish an online connection or open a project file.

2. Select [Import] from the [File] menu.

The [Import] window will be displayed.
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3. Click the [Variable and comment] button and select [Import the global variable and com-
ment] or [Import Variables and Comments].

A message dialog box will be displayed.

4. Select [Yes] or [No].

The [Open] window will be displayed.

5. Specify the file to import, and click the [Open] button.

The [Import] window will be displayed.



8.3 Export/Import

366

6. Select the check box of the variables and comments to import, and click the [Import]
button.

A message dialog box will be displayed.

7. Click the [Yes] button.

The data will be imported.

This concludes the procedure.

8.3.7 Local Variables and Comments

(1) Exporting Data
Use the following procedure to export local variables and comments.

1. Establish an online connection or open a project file.
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2. Select [Export] from the [File] menu.

The [Export] window will be displayed.

3. Click the [Variable and comment] button and select [Export the local variable and
comment].

A message dialog box will be displayed.

4. Select [Yes] or [No].

The [Browse For Folder] window will be displayed.
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5. Specify the folder to which the data will be exported, and click the [OK] button.

The [Export] window will be displayed.

6. Select the check box of the programs to export, and click the [Export] button.

Information Select the check box under [Option] as necessary.

The data will be exported.

This concludes the procedure.

(2) Importing Data
Use the following procedure to import local variables and comments.

1. Establish an online connection or open a project file.
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2. Select [Import] from the [File] menu.

The [Import] window will be displayed.

3. Click the [Variable and comment] button and select [Import the local variable and
comment].

A message dialog box will be displayed.

4. Select [Yes] or [No].

The [Browse For Folder] window will be displayed.
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5. Specify the folder from which the data will be imported, and click the [OK] button.

The [Import] window will be displayed.

6. Select the check box of the programs to import, and click the [Import] button.

A message dialog box will be displayed.
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7. Click the [Yes] button.

The data will be imported.

This concludes the procedure.

8.3.8 Specified Register Variables and Comments
Use the following procedure to export the specified range of register variables and comments.

1. Establish an online connection or open a project file.

2. Select [Export] from the [File] menu.

The [Export] window will be displayed.

3. Click the [Variable and comment] button and select [Export the variable and comment
of the specified register].

A message dialog box will be displayed.
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4. Select [Yes] or [No].

The [Export Setting] window will be displayed.

5. Set the following items, and then click the [OK] button.

The [Save As] window will be displayed.

6. Specify the destination folder and file name, and click the [Save] button.

The data will be exported.

This concludes the procedure.
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8.3.9 Constant Variable

(1) Exporting Data
Use the following procedure to export constant variables.

1. Establish an online connection or open a project file.

2. Select [Export] from the [File] menu.

The [Export] window will be displayed.

3. Click the [Variable and comment] button and select [Export the constant variable].

The [Browse For Folder] window will be displayed.
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4. Specify the folder to which the data will be exported, and click the [OK] button.

The [Export] window will be displayed.

5. Select the format of the file to export.
• CTF file: Binary file format
• CSV file: CSV file format
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6. Select the check box of the constant variables to export, and click the [Export] button.

The data will be exported.

This concludes the procedure.

(2) Importing Data
Use the following procedure to import constant variables.

1. Establish an online connection or open a project file.

2. Select [Import] from the [File] menu.

The [Import] window will be displayed.
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3. Click the [Variable and comment] button and select [Import the constant variable].

The [Browse For Folder] window will be displayed.

4. Select the folder from which the data will be imported, and click the [OK] button.

The [Import] window will be displayed.

5. Select the format of the file to import.
• CTF file: Binary file format
• CSV file: CSV file format
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6. Select the check box of the variables to import, and click the [Import] button.

Information The import may fail if the number of constant variables to import exceeds 200 variables.
You can import more than 200 constant variables, but splitting those constant variables into smaller groups is
recommended.

A message dialog box will be displayed.

7. Click the [Yes] button.

Information If there are more than 200 constant variables to import, the following message dialog box will be displayed.
Click the [OK] button to execute the import.

The data will be imported.

This concludes the procedure.
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8.3.10 User-Defined Structures

(1) Exporting Data
Use the following procedure to export user-defined structures.

1. Establish an online connection or open a project file.

2. Select [Export] from the [File] menu.

The [Export] window will be displayed.

3. Click the [Variable and comment] button and select [Export the user structure].

The [Save As] window will be displayed.
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4. Specify the destination folder and file name, and click the [Save] button.

The [Export] window will be displayed.

5. Select the check box of the user-defined structures to export, and click the [Export]
button.

The data will be exported.

This concludes the procedure.

(2) Importing Data
Use the following procedure to import user-defined structures.

1. Establish an online connection or open a project file.
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2. Select [Import] from the [File] menu.

The [Import] window will be displayed.

3. Click the [Variable and comment] button and select [Import the user structure].

The [Open] window will be displayed.

4. Specify the file to import, and click the [Open] button.

The [Import] window will be displayed.
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5. Select the check box of the user-defined structures to import, and click the [Import]
button.

A message dialog box will be displayed.

6. Click the [Yes] button.

The data will be imported.

This concludes the procedure.

8.3.11 Data Formats for Exporting and Importing
This section gives an overview of the data formats for exporting and importing.
To create your own import data, use the following format.

Important

Observe the following items when creating the import data.
•Operation is not guaranteed (including the import operation itself) if a value is set outside the appropriate range.
•Use the same character encoding as the export data.

Information Exported constant variable data cannot be edited.

(1) Ladder Program
"ProgramName.ypi" is the data name and extension of the export/import data for a ladder program.
An example of the ladder program (function) and import/export data is shown below.
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The details of the import/export data for ladder programs are shown below.

Item Description Value

Header information

VERSION_NUMBER File version number Fixed as "10"

PROGRAM_MD5 Not used –

Program comment information

PROGRAM_COMMENT A comma (,) is used to separate the following content.

Program comment length Any number

Program comment Any text string

Properties information

CONFIG_PROGRAM_TITLE Program name Text string 48 characters maximum

CONFIG_READ_PRIVILEGE Read privilege 0 to 7

CONFIG_WRITE_PRIVILEGE Write privilege 0 to 7

CONFIG_DREGISTER_COUNT Number of D registers 0 to 16384

CONFIG_#REGISTER_COUNT # Number of registers 0 to 16384

CONFIG_CAST_ACTION Setting the operation when real number 0: Truncate
1: Round

CONFIG_IJ_LIMIT_CHECK Subscript register limit check 0: Enabled
1: Disabled

Properties information: I/O definitions (function only)

Continued on next page.
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Continued from previous page.

Item Description Value

FUNCIO_INPUT_TYPE Function input definition
The file contains 1 to 16 items. When there are two or
more inputs, "FUNCIO_INPUT_COMMENT" below is
added to the file in the amount of inputs.

1: BIT (B-VAL)
16: WORD (I-REG)
32: LONG (L-REG)
48: FLOAT (F-REG)
64: QUAD (Q-REG)
80: DOUBLE (D-REG)

FUNCIO_INPUT_COMMENT A comment for the function input definition Text string 8 characters maximum

FUNCIO_ADDRESS_TYPE Function address definition
The file contains 0 or 1 item.

Fixed as "128: ADDRESS"

FUNCIO_ADDRESS_COMMENT A comment for the function address definition Text string 8 characters maximum

FUNCIO_OUTPUT_TYPE Function output definition
The file contains 1 to 16 items. When there are two or
more outputs, "FUNCIO_OUTPUT_COMMENT" below
is added to the file in the amount of outputs.

Same as "FUNCIO_INPUT_TYPE"
above

FUNCIO_OUTPUT_COMMENT A comment for the function output definition Text string 8 characters maximum

Program information *1

RUNG_SIZE Number of rungs –

RUNG Rung information –

RUNG_COMMENT Rung comment –

MATRIX Program information in rung –

*1 If you will edit export data and import that data, do not correct the program information. Correct the program information on the Edit
Ladder Program window after you import it.

(2) Ladder Program Line Comments
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(3) Ladder Program Properties

(4) Register Data

(5) Global Variables and Comments

*1 There are restrictions to the information that can be entered. Refer to the following section for details.
(a) Registering a Global Variable on page 167
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(6) Local Variables and Comments

*1 There are restrictions to the information that can be entered. Refer to the following section for details.
(a) Registering a Local Variable on page 176

(7) User-Defined Structures
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9
Appendices

This chapter describes error messages and the corrective action to perform when an error is displayed.

9.1 Error Messages and Reference Sections for Corrective Action ................388

9.2 Corrective Action When an Error Message Is Displayed .............................389
9.2.1 Tracing Could Not Be Started. ................................................................... 389
9.2.2 An Error Occurred during the Transfer to the Controller. ...................... 390
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9.1 Error Messages and Reference Sections for
Corrective Action

Error Message Error No. Reference

An error occurred during the transfer to
the controller. – 9.2.2 An Error Occurred during the Transfer to the

Controller. on page 390

The selected trace could not be started. 0xA0A10C0B 6.2.12 Changing the Enabled/Disabled Setting of the
Trace Definition Settings on page 283

Tracing could not be started.

0xA0A005B4

9.2.1 Tracing Could Not Be Started. on page 3890xA0A10C0A

0xA0A10C0C
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9.2 Corrective Action When an Error Message Is
Displayed

9.2.1 Tracing Could Not Be Started.

(1) Error Message Dialog Box

(2) Corrective Action
1. Stop tracing of other groups.

2. Display the trace window again.

3. In the [Sampling & Trigger Setting] window, check the trace buffer size, and check that
the total value of the trace buffers of all groups is at or below the maximum applicable
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trace buffer size. When there are two or more trace groups, check the trace buffer size
of all trace groups.
Refer to the following section for details on the maximum applicable trace buffer size.

(2) Trace Buffer Size on page 243
When the trace buffer size is greater than the maximum applicable trace buffer size, change the settings
in the [Sampling & Trigger Setting] window.

4. Start tracing again by clicking the [Start Trace] button.

If no error messages are displayed, this concludes the procedure.

9.2.2 An Error Occurred during the Transfer to the Controller.

(1) Corrective Action
1. If the SigmaWin+ AE is online, click the [Connection/Disconnection] button on the [My

Tool] window of the [Start] tab page to set the SigmaWin+ AE to offline.
2. Select [Programs] − [YE_Applications] − [Communication Platform] from the Windows

Start Menu.
The [Communication Platform] icon will be displayed at the bottom right of the PC screen.

3. Double-click the [Communication Platform] icon.

The [Communication Platform] window will be displayed.

4. Select a communication port that is in use, then click [File] − [Set Communication Port].

The [Port Setting] window will be displayed.
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5. Select the [Set a max. communication size.] check box, set [Max. communication size]
to “1500”, and click the [OK] button.

The settings will be applied and the [Port Setting] window will close.

6. Click the [Save] icon.

This concludes the procedure.
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